# Table of Contents

## Chapter 1  Introduction .................................................. 9
  1.1 Community and Commercial Editions ........................................... 9
  1.2 About this Guide ............................................................ 10
    1.2.1 Technical Business Analyst ........................................... 10
    1.2.2 Report Developer ....................................................... 10
    1.2.3 System Developer ....................................................... 10
    1.2.4 System Administrator and Database Administrator ..................... 10
  1.3 Other Resources ............................................................. 11
    1.3.1 Standard Documentation ............................................... 11
    1.3.2 Premium Documentation ............................................... 11
    1.3.3 Jaspersoft Community Site ............................................ 11
  1.4 Getting Started ............................................................. 12

## Chapter 2  Ad Hoc Views and Data Exploration ................................. 13
  2.1 About the Ad Hoc Editor ................................................... 14
    2.1.1 User Interface Components ........................................... 14
    2.1.2 Context Menus ......................................................... 21
  2.2 Working with Ad Hoc Views ................................................ 21
    2.2.1 Summaries ............................................................... 21
    2.2.2 Setting the Data Format .............................................. 22
    2.2.3 Custom Fields ......................................................... 23
  2.3 Administering Ad Hoc Views ................................................ 24
    2.3.1 Administering Topics ................................................. 24
    2.3.2 Administering Domains ............................................... 24
    2.3.3 Scalability ............................................................ 24

## Chapter 3  The Report Viewer and Conditional Text .............................. 27

## Chapter 4  Dashboards .......................................................... 31
  4.1 User Interface Components ................................................ 32
  4.2 Context Menus ............................................................... 33
Chapter 11 Customizing the User Interface ................................................................. 133

11.1 Changing the UI With Themes .......................................................................... 134
  11.1.1 Working with Themes .............................................................................. 134
  11.1.2 Changing the Logo .................................................................................. 134
  11.1.3 Hiding UI Elements .................................................................................. 136
  11.1.4 Changing Colors and Fonts ..................................................................... 136
  11.1.5 Changing the Spacing in the UI ................................................................ 137
  11.1.6 Using Themes to Remove Branding ......................................................... 138
  11.1.7 Replacing the Default Theme ................................................................. 140
11.2 Working With Web App Files ........................................................................... 140
  11.2.1 File Locations ............................................................................................. 141
  11.2.2 JavaScript and JSP Folders ...................................................................... 141
  11.2.3 Unzipping WAR Files .............................................................................. 141
  11.2.4 Upgrading With UI Customizations ....................................................... 142
11.3 Customizing the Branding with SiteMesh ......................................................... 142
  11.3.1 web.xml ..................................................................................................... 143
  11.3.2 sitemesh.xml and decorators.xml .......................................................... 143
  11.3.3 main.jsp and decorator.jsp ..................................................................... 143
  11.3.4 Editing decorators.jsp for Rebranding .................................................. 145
11.4 Customizing JSP and JavaScript for the Login Page ........................................ 146
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.4.1 Reloading the JasperReports Server Web App</td>
<td>148</td>
</tr>
<tr>
<td>11.5 Setting the Home Page</td>
<td>149</td>
</tr>
<tr>
<td>11.6 Customizing the Report Rendering Page</td>
<td>149</td>
</tr>
<tr>
<td>11.6.1 Customizing the Input Controls Form</td>
<td>149</td>
</tr>
<tr>
<td>11.6.2 Customizing the Report Viewer</td>
<td>152</td>
</tr>
<tr>
<td>11.7 Customizing Menus</td>
<td>153</td>
</tr>
<tr>
<td>11.7.1 Removing a Menu Item</td>
<td>153</td>
</tr>
<tr>
<td>11.7.2 Restricting Access by Role</td>
<td>155</td>
</tr>
<tr>
<td>11.7.3 Adding an Item to the Main Menu</td>
<td>158</td>
</tr>
<tr>
<td>11.7.4 Adding a New Main Menu</td>
<td>160</td>
</tr>
<tr>
<td>11.7.5 Changing Other Menus</td>
<td>162</td>
</tr>
<tr>
<td>11.7.6 Action Model Reference</td>
<td>162</td>
</tr>
<tr>
<td>11.8 Working With Source Code Files</td>
<td>167</td>
</tr>
<tr>
<td>11.9 Adding a Custom JSP Page in a Spring Web Flow</td>
<td>168</td>
</tr>
<tr>
<td>11.10 Adding Custom Export Channels</td>
<td>173</td>
</tr>
<tr>
<td>11.10.1 About Export Parameters</td>
<td>173</td>
</tr>
<tr>
<td>11.10.2 Adding the Exporter to the Report Viewer</td>
<td>174</td>
</tr>
<tr>
<td>11.10.3 Adding the Export Format to the Scheduler</td>
<td>175</td>
</tr>
<tr>
<td><strong>Chapter 12 Designing a Cluster</strong></td>
<td>177</td>
</tr>
<tr>
<td>12.1 Sample Cluster Architecture</td>
<td>177</td>
</tr>
<tr>
<td>12.1.1 JasperReports Server Clients</td>
<td>179</td>
</tr>
<tr>
<td>12.1.2 Load Balancer</td>
<td>179</td>
</tr>
<tr>
<td>12.1.3 JasperReports Server Instances</td>
<td>179</td>
</tr>
<tr>
<td>12.1.4 Shared Repository Database</td>
<td>180</td>
</tr>
<tr>
<td>12.1.5 Job Schedulers</td>
<td>181</td>
</tr>
<tr>
<td>12.1.6 Other Shared Resources</td>
<td>181</td>
</tr>
<tr>
<td>12.2 Jaspersoft OLAP in a Cluster</td>
<td>182</td>
</tr>
<tr>
<td>12.3 Session Management and Failover</td>
<td>182</td>
</tr>
<tr>
<td>12.3.1 Impact on Browser Users</td>
<td>183</td>
</tr>
<tr>
<td>12.3.2 Impact on Web Services Clients</td>
<td>183</td>
</tr>
<tr>
<td>12.4 Cluster Design Process</td>
<td>183</td>
</tr>
<tr>
<td>12.5 Performance Requirements</td>
<td>184</td>
</tr>
<tr>
<td>12.6 Availability Requirements</td>
<td>185</td>
</tr>
<tr>
<td>12.7 Scalability Requirements</td>
<td>185</td>
</tr>
<tr>
<td>12.8 Sizing a Cluster</td>
<td>185</td>
</tr>
<tr>
<td>12.8.1 Load Balancer</td>
<td>186</td>
</tr>
<tr>
<td>12.8.2 Cluster Nodes</td>
<td>186</td>
</tr>
<tr>
<td>12.8.3 Software Configuration</td>
<td>186</td>
</tr>
<tr>
<td>12.8.4 Databases</td>
<td>187</td>
</tr>
<tr>
<td>12.8.5 Network</td>
<td>187</td>
</tr>
<tr>
<td>12.8.6 Policies and Procedures</td>
<td>187</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td>189</td>
</tr>
</tbody>
</table>
CHAPTER 1 INTRODUCTION

JasperReports Server builds on JasperReports Library as a comprehensive family of Business Intelligence (BI) products, providing robust static and interactive reporting, report server, and data analysis capabilities. These capabilities are available as either stand-alone products or as part of an integrated end-to-end BI suite utilizing common metadata and providing shared services, such as a repository, security, and scheduling.

The heart of the Jaspersoft BI Suite is the server, which provides the ability to:
- Easily create new reports based on views designed in an intuitive, web-based, drag and drop Ad Hoc Editor.
- Efficiently and securely manage many reports.
- Interact with reports, including sorting, changing formatting, entering parameters, and drilling on data.
- Schedule reports for distribution through email and storage in the repository.
- Arrange reports and web content to create appealing, data-rich Jaspersoft Dashboards that quickly convey business trends.

For business intelligence users, Jaspersoft offers Jaspersoft OLAP, which runs on the server.

While the Ad Hoc Editor lets users create simple reports, more complex reports can be created outside of the server. You can either use iReport Designer or manually write JRXML code to create a report that can be run in the server. Jaspersoft recommends that you use iReport unless you have a thorough understanding of the JasperReports file structure. See The JasperReports Server User Guide for more information.

Jaspersoft provides several other sources of information to help extend your knowledge of JasperReports Server:
- Our free Business Intelligence Tutorials let you learn at your own pace, and cover topics for developers, system administrators, business users, and data integration users. The tutorials are available online from Professional Services section of our website.
- Our free samples, which are installed with JasperReports Library, iReport, and JasperReports Server, are documented online. The samples documentation can be found on our community website.

This chapter contains the following sections:
- Community and Commercial Editions
- About this Guide
- Other Resources
- Getting Started

1.1 Community and Commercial Editions

JasperReports Server is a component of both a community project and commercial offerings. Each integrates the standard features such as security, scheduling, a web services interface, and much more for running and sharing reports. Commercial
editions provide additional features, including Ad Hoc charts, flash charts, dashboards, Domains, auditing, and a multi-organization architecture for hosting large BI deployments.

Both community and commercial editions use the same Spring framework for easy integration into your applications, as well as an interface based on CSS for easy customization.

This guide discusses all editions. Sections of the guide that apply only to the commercial editions are indicated with a special note.

1.2 About this Guide

Because this Ultimate Guide is a comprehensive resource for users with many different needs, it includes information that may not be relevant to you. The following user descriptions and document maps can help you find the information that pertains to you.

1.2.1 Technical Business Analyst

Technical business analysts know their business, data, and processes. They are power users who generate business intelligence for others.

If you are a technical business analyst, refer to the following sections of this document:

- Chapter 4, “Dashboards,” on page 31
- Chapter 7, “Access Control,” on page 65
- Chapter 6, “Securing Data in a Domain,” on page 47
- Chapter 9, “JasperReports Server Plug-in for iReport,” on page 91
- Section 10.3, “Ad Hoc Launcher Java API,” on page 121
- Section 11.1, “Changing the UI With Themes,” on page 134
- Section 11.7, “Customizing Menus,” on page 153
- Section 11.8, “Working With Source Code Files,” on page 167

1.2.2 Report Developer

Report developers understand their business and its data and create reports for other users.

If you are a report developer, refer to the following sections:

- Chapter 2, “Ad Hoc Views and Data Exploration,” on page 13
- Chapter 5, “Custom Data Sources,” on page 37
- Chapter 9, “JasperReports Server Plug-in for iReport,” on page 91

1.2.3 System Developer

System developers leverage JasperReports Server functionality in their own product. They extend and change the source code, system configurations, and other low-level options.

If you are a system developer, refer to the following sections:

- Chapter 8, “Application Security,” on page 81
- Chapter 10, “JasperReports Server APIs,” on page 105
- Chapter 11, “Customizing the User Interface,” on page 133

1.2.4 System Administrator and Database Administrator

System administrators install, deploy, maintain, and troubleshoot JasperReports Server, along with other systems in their environment. They also administrate security, including the creation and maintenance of users, roles, organizations, the assignment of permissions, and configure authorization and authorization in general. Database administrators (DBAs)
administer database management systems (DBMS), and are familiar with both relational and Online Analytical Processing
databases. They plan, configure, tune, and maintain the schemas that store business data.

If you are a system or database administrator, refer to the following sections:
- Chapter 2, “Ad Hoc Views and Data Exploration,” on page 13
- Chapter 5, “Custom Data Sources,” on page 37
- Chapter 7, “Access Control,” on page 65
- Chapter 6, “Securing Data in a Domain,” on page 47
- Chapter 8, “Application Security,” on page 81
- Section 11.7.2, “Restricting Access by Role,” on page 155
- Section 11.8, “Working With Source Code Files,” on page 167

1.3 Other Resources

The following sections list other sources of documentation and information to help you work with JasperReports Server.

1.3.1 Standard Documentation

JasperReports Server includes standard documentation that is often referenced in this guide:
- JasperReports Server Installation Guide
- JasperReports Server User Guide
- Jaspersoft OLAP User Guide
- JasperReports Server Administrator Guide (commercial editions only)
- JasperReports Server Web Services Guide
- JasperReports Server Source Build Guide

The documentation is found in the <js-install>/docs directory when you install JasperReports Server, except for the
JasperReports Server Source Build Guide, which is found in the source code distribution package. The documentation is also

1.3.2 Premium Documentation

This guide also references other Jaspersoft premium guides:
- Jaspersoft OLAP Ultimate Guide
- JasperReports Server External Authentication Cookbook
- JasperReports Ultimate Guide
- iReport Ultimate Guide

Users of the JasperReports Server commercial editions can access these documents from the Support Portal. For JasperReports
Server community project users, these documents are available for purchase, separately or in documentation packs, at http://

1.3.3 Jaspersoft Community Site

The Jaspersoft community site at http://community.jaspersoft.com is the new place to do everything Jaspersoft. Whether you
are a developer using our community edition tools or a Product Manager guiding the integration of BI into your solutions
using our commercial products, this site provides you with the information and resources you need to be successful. The
community site offers answers, documentation, wiki articles, and tracker items for all products. This is the resource for all of
our community members regardless of the edition you use or the needs you address.
1.4 Getting Started

JasperReports Server must be installed and configured before you can use it. For information, refer to the installation guide for your product edition.

The directory where JasperReports Server is installed is referred to as <js-install> in this guide. The default installation directory is:

- **Windows:** C:\Program Files\jasperreports-server-5.0
- **Linux:** <USER_HOME>/jasperreports-server-5.0
- **Mac:** /Applications/jasperreports-server-5.0

To connect to JasperReports Server, make sure your database and application server are running, then enter the corresponding URL in a supported browser:

For example, if you installed the Jaspersoft BI Suite evaluation software, the default URL is:

http://localhost:8080/jasperserver-pro/login.html

If JasperReports Server is secured using SSL (Secure Socket Layer) encryption, both the protocol and the port differ. For example, a typical SSL-secured URL for JasperReports Server Professional follows this format:

https://localhost:443/jasperserver-pro/login.html

On the JasperReports Server Login page, enter a user ID and password and click Login. The following table lists the credentials for the evaluation server:

<table>
<thead>
<tr>
<th>User ID</th>
<th>Password</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>superuser</td>
<td>superuser</td>
<td>System-wide administrator (commercial editions only)</td>
</tr>
<tr>
<td>jasperadmin</td>
<td>jasperadmin</td>
<td>Administrator for the default organization (commercial editions) System-wide administrator (community project)</td>
</tr>
<tr>
<td>joeuser</td>
<td>joeuser</td>
<td>Sample end-user</td>
</tr>
<tr>
<td>demo</td>
<td>demo</td>
<td>Sample end-user for the SuperMart Dashboard demonstration</td>
</tr>
</tbody>
</table>

Depending on the configuration of your system, the Login page may also enable you to change your password. If there is a **Change password** link, click the link to enter a new password. If there is no link, only your system administrator can change the password.
CHAPTER 2  AD HOC VIEWS AND DATA EXPLORATION

This section describes functionality that can be restricted by the software license for JasperReports Server. If you don’t see some of the options described in this section, your license may prohibit you from using them. To find out what you’re licensed to use, or to upgrade your license, contact Jaspersoft.

JasperReports Server’s Ad Hoc Editor is a browser-based, interactive tool for designing views and exploring your data:

- As a designer, the Ad Hoc Editor lets you easily create and edit views and then use them to create reports. To create a view, select a Topic, Domain, or OLAP client connection, each of which defines a query and data source, and a view type. Then select the fields in your data source that should appear in your view. The Ad Hoc Editor’s interactive display of your results lets you evaluate your design without having to run the entire data set first. Finally, you can save the view, create one or more reports from it, and export it to several file formats.

- As a data explorer, the Ad Hoc Editor provides analysis options (such as slice, pivot, and filter) to help you recognize trends and outliers in your data. You can drill into specific details or analyze your data at a very high level. For example, you might create a crosstab that shows the kinds of products a customer purchases together. Though your intention in creating the crosstab was to rank the popularity of certain items, the crosstab might also reveal correlation between customers’ purchases. These correlations, which you weren’t aware of before, may give you insight into how you can improve your business. For example, you might run a promotion to encourage the correlation, or change your store layout to expose customers to more options. Understanding your data can help you make better decisions.

The interesting trends and anomalies revealed by data exploration can lead you to create a view or report highlighting your findings. Conversely, while creating an Ad Hoc view, you may identify a trend that warrants further investigation. You can move seamlessly between the two activities—view creation and data exploration.

This chapter contains the following sections:

- About the Ad Hoc Editor
- Working with Ad Hoc Views
- Administering Ad Hoc Views
2.1 About the Ad Hoc Editor

The Ad Hoc Editor is an interactive tool that displays the data fields retrieved from your data sources. The effects of your changes are evident immediately, and you can adjust the display to highlight the most relevant and compelling aspects of your data.

2.1.1 User Interface Components

Figure 2-1 below illustrates the main components of the Ad Hoc Editor when working with data from a Topic or Domain:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Selection panel</td>
<td>The Data Selection panel shows the list of available fields, which can be added to any bar in the Layout Band, and measures, which are summarized values that cannot be added as groups. Typically, measures are created from numeric fields in the Topic or Domain, but in some circumstances, it makes sense to use string fields when summarized as a count. For example, you might want to display the number of unique customers that made purchases in a given quarter. Use the icon beside the set name to expand or collapse a set of fields or measures. To hide this panel, click the icon in the top left corner; click the same icon on the minimized panel to expand it.</td>
</tr>
<tr>
<td>Change source/Select fields</td>
<td>This menu lets you select a different Topic or Domain for your view. All data and formatting are lost when you select a different Topic or Domain. When creating a view from a Domain, you can also select different fields to change the list that appears in this panel.</td>
</tr>
<tr>
<td>Tool bar</td>
<td>The tool bar at the top of the canvas provides access to many of the Ad Hoc Editor’s functions, such as saving the view or creating a report from the view, undoing and redoing changes, and changing the view’s sort order. For more information, refer to the JasperReports Server User Guide.</td>
</tr>
</tbody>
</table>
The following figure illustrates the canvas when working on Ad Hoc tables with Details and Totals selected:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data mode menu</td>
<td>Click to select the amount of data displayed from the menu. Use Sample Data to design a view more quickly, or use Full Data to see all your data used in the same view. When you choose display mode, full data is displayed regardless of the selection shown in the editor.</td>
</tr>
<tr>
<td>View type menu</td>
<td>Click Chart, Table, or Crosstab to see your data in that type of view. Changes made in one type of view apply to the data displayed on another.</td>
</tr>
<tr>
<td>Title bar</td>
<td>The top portion of the canvas; click to add or edit the title of the view. To remove the title, point to the Properties menu and select Toggle the Title Bar.</td>
</tr>
<tr>
<td>Layout band</td>
<td>The layout band immediately below the tool bar has two boxes where you can drag and drop fields and measures from the Data Selection panel to add them to the canvas. You can change the order of the selected fields canvas by dragging them to a different location in the layout band. The boxes have different labels and functions, depending on the type of view; see the section for the individual view types for more information. To hide the layout band, point to the Properties menu and select Hide Layout Band.</td>
</tr>
<tr>
<td>Canvas</td>
<td>Occupying the middle of the editor, the canvas shows your data subject to the constraints you have created. This is also a sample of how your data will appear in any report you create from the view. To see the view without interface components, click for design mode.</td>
</tr>
<tr>
<td>Filters panel</td>
<td>This panel displays any filters defined for the view. You can set the filter values and see the resulting change in the canvas. To hide the filters panel, click the icon in the top left corner of the panel. Click the same icon on the minimized panel to expand it again.</td>
</tr>
<tr>
<td>Filter controls</td>
<td>These menus let you change the display of filters, either collectively or individually. The menu on the filter panel lets you collapse all filters or remove all filters. The menu on each filter lets you view the filter operation, for example “is one of,” or delete the filter. To minimize the view of an individual filter, click the icon beside its name.</td>
</tr>
</tbody>
</table>

The following figure illustrates the canvas when working on Ad Hoc tables with Details and Totals selected:
Common tasks when working with Ad Hoc tables include:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns area</td>
<td>Drag fields and measures from the Data Selection panel to this area to create columns.</td>
</tr>
<tr>
<td>Groups area</td>
<td>Drag fields from the Data Selection panel to this area to create groups. Measures cannot be added to the Groups area.</td>
</tr>
<tr>
<td>Canvas Options</td>
<td>Click to select Detailed Data (default), Totals Data, or Details and Totals.</td>
</tr>
<tr>
<td>Column labels</td>
<td>Displays the label for each column above the table in a header row. Highlight the column and right-click to change or remove the label. When you remove a column label, its database name is shown in the editor, but the label does not appear in reports created from the view.</td>
</tr>
<tr>
<td>Group header</td>
<td>Displays the label of the group and its current value. Groups and sub-groups can be nested, and their first occurrence headers are all found at the top of the view. Right-click the first occurrence of a group to access group options such as removing the group from the table, changing the label, or creating a filter on that field. You can reorder the first headers to change the group nesting order.</td>
</tr>
<tr>
<td>Group summary</td>
<td>If Totals Data or Details and Totals is selected, shows the group value and group total, if any. To select a different summary function, modify the column summary.</td>
</tr>
<tr>
<td>Column Summary</td>
<td>Gives a total value for all the rows in the column. To see all summaries, select Totals Data or Details and Totals from the Canvas Options menu. To add or remove a summary, right-click on the column and select Add Summary or Remove Summary. To select a different summary function, right-click on the column and select Change Function; for more information, see section 2.2.1, “Summaries,” on page 21.</td>
</tr>
<tr>
<td>Column of Values</td>
<td>A vertical region in the canvas representing data from a single field. Right click on a column to access column options such as sorting on that column, adding or removing a column summary, changing the column’s data format or label, and creating a custom field or filter based on the column’s field.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize a column</td>
<td>Click the right-hand border of the column header and drag it horizontally. For more precision, click the column to highlight its borders before dragging them.</td>
</tr>
<tr>
<td></td>
<td>The minimum width of a column is determined by its longest visible member (be it a row or the label itself). When the data doesn’t fit the column width, it wraps (in Excel and HTML formats) or is truncated (in PDF format). By default, the canvas only displays the first 15 rows of data. To verify that the column widths are sufficient, click Full Data to display the full set of data.</td>
</tr>
<tr>
<td>Add blank columns</td>
<td>To add white space between columns, drag the Spacer from the list of available measures and drop it in the Columns area. Drag the spacer’s edges to widen or narrow it. You can add any number of spacers to a view.</td>
</tr>
<tr>
<td></td>
<td>To create space between the leftmost column and the group labels in a table, drag a spacer to the leftmost position; the margin provides a buffer between the first column and the groups summaries.</td>
</tr>
<tr>
<td>Sort a column</td>
<td>Click or right click on a column in the Canvas and select Use for Sorting. You can add fields and change the sort direction from ascending to descending. You can sort by multiple fields, including those not displayed in the view.</td>
</tr>
<tr>
<td>Filter a column</td>
<td>Right-click a field or a column in the layout band or the Canvas and select Create Filter to filter your results by the values in that field. To select a filter operation other than the default, click the filter’s icon and select Toggle Operation.</td>
</tr>
<tr>
<td>Show all groups</td>
<td>When a table is grouped by multiple fields, you may only see a few groups or even a single, partial group. Click Full Data to view the full dataset; click Sample Data to return to the smaller subset.</td>
</tr>
</tbody>
</table>
The following figure illustrates the canvas when creating a chart in the Ad Hoc Editor; sliders in the Filters pane are also shown:

Figure 2-3  Ad Hoc Editor’s Chart Layout

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rows area</td>
<td>Drag fields and measures to the Rows area to define the grouping along the horizontal axis. Measures must all be in the same area; you cannot have measures in the Columns and Row areas at the same time. Right click a measure to change its summary function.</td>
</tr>
<tr>
<td>Columns area</td>
<td>Drag fields and measures into the Columns area to add series. Measures must all be in the same area; you cannot have measures in the Columns and Row areas at the same time. Right click a measure to change its summary function.</td>
</tr>
<tr>
<td>Sliders</td>
<td>Drag to set the level of aggregation to use for viewing the data.</td>
</tr>
<tr>
<td>Canvas Options</td>
<td>Click to select the Select Chart Type window.</td>
</tr>
<tr>
<td>Select Chart Type window</td>
<td>Modeless dialog box; to open, use Canvas Options. Click to select a chart type; a blue border indicates the current selection. Click and drag to move the window; click x to close it.</td>
</tr>
<tr>
<td>Chart area</td>
<td>A chart’s appearance is determined by the type of chart, the fields selected as measures, and the fields that group the data.</td>
</tr>
<tr>
<td>Scale</td>
<td>All measures are plotted against the same scale, which is sometimes confusing. You can use a calculated field to multiply or divide one measure so that its values are closer to those in the other measures in your chart.</td>
</tr>
<tr>
<td>Legends</td>
<td>The legend is created when measures are added to the chart. Click one or more legends to hide the associated measures; click again to show them.</td>
</tr>
<tr>
<td>Labels</td>
<td>The labels on the horizontal scale indicate the values by which the chart is grouped. If there are too many values in the chart, zoom in or use filters to reduce your data.</td>
</tr>
</tbody>
</table>
Because the nature of a chart is to display summarized data, the data mode menu is not available. Charts always present the full data set, not a sample. This may impact performance when working with large data sets.

Common tasks when working with Ad Hoc charts include:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Click and drag or swipe to zoom. Only labels used in the zoom area are displayed, so you can use zoom to simplify your view. The zoom level is not saved when you save a view or report; it is always reset to the full view of the chart.</td>
</tr>
<tr>
<td>Filter a chart</td>
<td>Right-click a field in the Data Selection panel or the layout band and select <strong>Create Filter</strong>.</td>
</tr>
<tr>
<td>Select a measure’s summary function</td>
<td>Right-click the measure’s name in the layout band and select a function from the context menu. For more information on summary functions, see section 2.2.1, “Summaries,” on page 21.</td>
</tr>
<tr>
<td>Set the granularity of groups</td>
<td>Use the slider to specify the granularity of groups.</td>
</tr>
</tbody>
</table>

The following figure illustrates the canvas when displaying a standard **Crosstab** in the Ad Hoc Editor:

By default, a crosstab displays a subset of the data its query retrieves. Click **Full Data** to view the full dataset. This can be helpful in showing a more accurate view of the final view (by showing more data). Click **Sample Data** to return to the smaller subset and improve performance if you find the editor has slowed down.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns area</td>
<td>Drag dimensions and measures from the Data Selection panel to this area to create column groups. Drag fields to change the order of the groups. Measures must all be in the same area; you cannot have measures in the Columns and Row areas at the same time.</td>
</tr>
<tr>
<td>Rows area</td>
<td>Drag dimensions and measures from the Data Selection panel to this area to create row groups. Drag fields to change the order of the groups. Measures must all be in the same area; you cannot have measures in the Columns and Row areas at the same time.</td>
</tr>
</tbody>
</table>
## Ad Hoc Views and Data Exploration

### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row and column group labels</td>
<td>Displays the name of each field used for grouping. Right-click the group labels to use the context menu. When no row groups are defined, the words Row Group indicate this vertical region.</td>
</tr>
<tr>
<td>Row and column group values</td>
<td>Heading cells that show the group values. When there is more than one level of grouping, use the icons on the outer groups to expand or collapse the inner groups. Right-click a group value to exclude it or to keep only that value from among all group values of the same level.</td>
</tr>
<tr>
<td>Sorting controls</td>
<td>An icon beside a label shows the current sorting. Right-click a label to apply or change sorting. You can sort on multiple groups, but only one measure; sorting on a measure will reset all other measure columns to Don’t Sort.</td>
</tr>
<tr>
<td>Measure labels</td>
<td>Display the name of each measure in the crosstab. Right-click the measure label to change the summary function or data format of the measure.</td>
</tr>
<tr>
<td>Measures</td>
<td>Measures show an aggregated value in each cell of the crosstab, as well as row and column totals for each level of grouping. Click on a measure value to open an Ad Hoc table view in a new window showing the individual values that make up the aggregated value.</td>
</tr>
<tr>
<td>Set the granularity of date groups</td>
<td>When you select a date field as a group, you can specify the granularity of the group values. Right-click the group label, select Change Grouping and select Year, Quarter, Month, or Day.</td>
</tr>
<tr>
<td>Pivot a single group</td>
<td>To pivot any group from row to column or vice-versa, select the group by clicking its label, then drag it to the other area. You can also right-click the group label and select Move to Column Group for row groups or Move to Row Group for column groups.</td>
</tr>
<tr>
<td>Pivot entire crosstab</td>
<td>To pivot all row groups to column groups and vice-versa at the same time, click.</td>
</tr>
<tr>
<td>Filtering</td>
<td>Right-click a group label and select Create Filter to filter your data by the members in that group. Note that creating a filter from a group is very similar to slicing (Keep Only).</td>
</tr>
<tr>
<td>Keep Only</td>
<td>Slice out a single group by right-clicking its group value and selecting Keep Only. Use Ctrl-click to select multiple members to keep.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Remove a group value from any group by right-clicking it and selecting Exclude. Use Ctrl-click to select multiple members to exclude.</td>
</tr>
<tr>
<td>Summaries (Totals)</td>
<td>By default, the crosstab includes grand totals of all row groups, shown in a Totals row at the bottom, and of all column groups, shown in a Totals column to the right. To toggle the row totals, right-click the left-most row group and select Delete Row Summary or Add Row Summary. To toggle the column totals, right-click the top-most column group and select Delete Column Summary or Add Column Summary. You cannot hide the inner totals of an expanded row or column group.</td>
</tr>
<tr>
<td>Change Summary Functions</td>
<td>Right-click a measure label and click Change Summary Function to select a summary function. For example, you may want to display an average rather than a total. For more information, see section 2.2.1, “Summaries,” on page 21.</td>
</tr>
<tr>
<td>Column group limits</td>
<td>In some cases, the editor prompts you to confirm that you want it to return large amounts of data. When the number of column groups exceeds a configurable limit, the editor displays an ellipsis (...); its ToolTip indicates the number of remaining groups. Click the ellipsis to display them. For more information on configuration, see the JasperReports Server Administrator Guide.</td>
</tr>
</tbody>
</table>

Common tasks when working with Ad Hoc crosstabs include:

- **Set the granularity of date groups**: When you select a date field as a group, you can specify the granularity of the group values. Right-click the group label, select Change Grouping and select Year, Quarter, Month, or Day.
- **Pivot a single group**: To pivot any group from row to column or vice-versa, select the group by clicking its label, then drag it to the other area. You can also right-click the group label and select Move to Column Group for row groups or Move to Row Group for column groups.
- **Pivot entire crosstab**: To pivot all row groups to column groups and vice-versa at the same time, click.
- **Filtering**: Right-click a group label and select Create Filter to filter your data by the members in that group. Note that creating a filter from a group is very similar to slicing (Keep Only).
- **Keep Only**: Slice out a single group by right-clicking its group value and selecting Keep Only. Use Ctrl-click to select multiple members to keep.
- **Exclude**: Remove a group value from any group by right-clicking it and selecting Exclude. Use Ctrl-click to select multiple members to exclude.
- **Summaries (Totals)**: By default, the crosstab includes grand totals of all row groups, shown in a Totals row at the bottom, and of all column groups, shown in a Totals column to the right. To toggle the row totals, right-click the left-most row group and select Delete Row Summary or Add Row Summary. To toggle the column totals, right-click the top-most column group and select Delete Column Summary or Add Column Summary. You cannot hide the inner totals of an expanded row or column group.
- **Change Summary Functions**: Right-click a measure label and click Change Summary Function to select a summary function. For example, you may want to display an average rather than a total. For more information, see section 2.2.1, “Summaries,” on page 21.
- **Column group limits**: In some cases, the editor prompts you to confirm that you want it to return large amounts of data. When the number of column groups exceeds a configurable limit, the editor displays an ellipsis (...); its ToolTip indicates the number of remaining groups. Click the ellipsis to display them. For more information on configuration, see the JasperReports Server Administrator Guide.
The Ad Hoc Editor shows some minor differences when working with OLAP-based views. For example, only Chart and Crosstab are available in the view type menu, and you can only use full data. The Data Selection panel shows a special icon for dimensions. Some options are different: for example, you can add levels to a dimension using the context menu. For information about OLAP-based crosstabs, see the Jaspersoft OLAP User Guide and Jaspersoft OLAP Ultimate Guide.

The following figure illustrates the canvas when displaying an OLAP-based crosstab in the Ad Hoc Editor:

---

**Figure 2-5  Ad Hoc Editor's OLAP-based Crosstab Layout**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Groups</td>
<td>Drag dimensions and measures from the Data Selection panel to this area to create column groups.</td>
</tr>
<tr>
<td>Row Groups</td>
<td>Drag dimensions and measures from the Data Selection panel to this area to create row groups.</td>
</tr>
<tr>
<td>Available Dimensions</td>
<td>Displays all the dimensions defined in the current OLAP cube. Drag them to the Columns and Rows areas to add them to the crosstab.</td>
</tr>
<tr>
<td>Available Measures</td>
<td>Displays all the measures defined in the current OLAP cube. Drag them to the Columns or Rows areas to add them to the crosstab.</td>
</tr>
</tbody>
</table>
2.1.2 Context Menus

Context menus appear when you right-click elements in the Ad Hoc Editor. Each menu offers options for the selected element. If a context menu blocks your view, close it by clicking anywhere outside the menu or by pressing Escape.

Figure 2-6 shows the following examples:

1. Right-clicking a column in a table opens a context menu with options for that column’s settings.
2. Right-clicking a group value in a standard crosstab’s row or column lets you slice the crosstab.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure Labels</td>
<td>Displays the label of each measure in the crosstab.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Displays the levels that have been added to the crosstab from each dimension. Note that dimensions can be added as both rows and columns.</td>
</tr>
<tr>
<td>Measures</td>
<td>Displays the measures that have been added to the crosstab. Note that measures can be added as either rows or columns.</td>
</tr>
<tr>
<td>Columns</td>
<td>Displays dimensions and measures as columns.</td>
</tr>
<tr>
<td>Rows</td>
<td>Displays dimensions and measures as rows.</td>
</tr>
</tbody>
</table>

2.2 Working with Ad Hoc Views

The following sections provide details on creating views with the Ad Hoc Editor:

- Summaries
- Setting the Data Format
- Custom Fields

2.2.1 Summaries

In Ad Hoc table views, each field can display a single summary calculation. In crosstabs, each measure displays a summarized value. In charts, the type of chart determines whether measures are summarized. In general, you can change the summary function of any measure, with the exception of those that use the percent of total and percent of parent custom field functions.

Summaries show the result of a function applied to all data values. In tables, they appear at the bottom of each group, as well as at the bottom of the view. In crosstabs, they determine the values of the measures at the intersection of each row and column. In summarized charts, they determine the size or location of the graphical elements that represent your data.
In a table, summarize a column by right-clicking it and selecting **Add Summary** from the context menu. The summary function is automatically applied to all groups in the table. When a new group is added, it includes a summary for each column.

By default, JasperReports Server summarizes fields of each datatype as follows:

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Summary Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric</td>
<td>Sum</td>
<td>Displays the sum of all values in the set.</td>
</tr>
<tr>
<td>Date</td>
<td>Count</td>
<td>Displays the total number of values in the set.</td>
</tr>
<tr>
<td>String</td>
<td>Count</td>
<td>Displays the number of values in the set.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Count</td>
<td>Displays the number of values in the set.</td>
</tr>
</tbody>
</table>

You select from these options to set a measure’s summary function in any type of view:

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
<th>Available for….</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>Displays the average of all values in the set.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Count All</td>
<td>Displays the number of rows in the set.</td>
<td>Boolean, Date, Numeric, and String</td>
</tr>
<tr>
<td>Distinct Count</td>
<td>Displays the number of unique values in the set.</td>
<td>Boolean, Date, Numeric, and String</td>
</tr>
<tr>
<td>Maximum</td>
<td>Displays the highest value in the set.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Minimum</td>
<td>Displays the lowest value in the set.</td>
<td>Numeric</td>
</tr>
<tr>
<td>Sum</td>
<td>Displays the grand total for the set.</td>
<td>Numeric</td>
</tr>
</tbody>
</table>

On the **Table** and **Crosstab** tabs, you can remove the summaries:

- For tables, remove a column’s summary by right-clicking the column or the summary itself, and selecting **Remove Summary** from the context menu.
- For crosstabs, remove a column group’s summary by right-clicking the group label and selecting **Delete Column Summary**; remove a row group’s summary by clicking **Delete Row Summary** on the same context menu. These options are only available for the outermost group on either axis.

### 2.2.2 Setting the Data Format

You can set the format of data in tables and crosstabs. Click a row or column header and select **Change Data Format** from the context menu. In tables, the format is applied to all rows as well as the group- and view-level summaries. In crosstabs, the format is applied to the measures.

The options that appear in the menu are the formats available for objects of the given datatype. For example, for monetary datatypes, the menu might list $1,234.56, -$1,234.56 and ($1,234.56), while for date datatypes it might list December 31, 2008, and 12/31/2008. By default, non-integer fields use the -1,234.56 data format; integers use -1234.

In some cases, the options in the **Change Data Format** menu are affected by the locale; for example:
### 2.2.3 Custom Fields

You can always create custom numeric fields in the editor, such as multiplying a field by an absolute number, subtracting one field from another, or displaying a field as a percent of a total for a column or group. You can add the fields to the view as you would any other numeric field.

---

#### Figure 2-8 Dialogs for Creating Custom Fields

<table>
<thead>
<tr>
<th>Selecting the fields</th>
<th>Right-click any numeric field in the list of available fields and select Create Custom Field... To work with multiple fields, use Ctrl-right-click on the second field. In tables, you can also create custom fields by right-clicking columns in the canvas.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-field arithmetic</td>
<td>In the dialog for single fields, enter a constant operand for one of the arithmetic operations and click Create Field. When subtracting, and dividing, the order is of the operands is significant. Click Swap if necessary to achieve the result you want.</td>
</tr>
<tr>
<td>Special function on a single field</td>
<td>In the dialog for single fields, select one of the advanced functions and click Create Field.</td>
</tr>
<tr>
<td>Two-field arithmetic</td>
<td>Click the first field, Ctrl-right-click the second field, and select Create Custom Field... from the context menu. Select an operation to perform on the fields and click Create Field. When adding or multiplying, the order in which you select fields doesn’t matter. When subtracting and dividing, the order is significant. Click Swap if necessary.</td>
</tr>
<tr>
<td>Difference of dates</td>
<td>The only operation available for date fields is to compare the difference between two dates. Select two date fields, right-click and select Create Custom Field... In the Custom Field dialog, select the units in which to express the time difference, such as Minutes, Hours, or Days. You may also set the data format on the custom field to show decimals or round to the nearest integer.</td>
</tr>
<tr>
<td>Editing a custom field</td>
<td>Right-click the field and select Edit Formula from the context menu. In the Custom Field dialog, make the edit and click Update Field.</td>
</tr>
</tbody>
</table>

As with any field, you can add a summary, change the data format, or change the display label of a custom field. You can also use custom fields in other custom fields to create more complex computed values.
2.3 Administering Ad Hoc Views

While the previous section focused on end-user tasks, this section provides information for administrators who maintain Ad Hoc Topics and Domains and configure JasperReports Server, including:

- Administering Topics
- Administering Domains
- Scalability

For information about OLAP client connections, which can also form the basis of Ad Hoc views, refer to the Jaspersoft OLAP User Guide and Jaspersoft OLAP Ultimate Guide.

2.3.1 Administering Topics

From a user perspective, Topics are sets of fields that can be added to a view or report. Topics provide a starting point for end-users using the Ad Hoc Editor. Under the covers, Topics are JRXML files that have been uploaded to a specific location in the repository. The views in the /Ad Hoc Components/Topics folder populate the Topics tab that appears when users click Create > Ad Hoc View.

The JRXML file that the Topic is based on must contain a query and a field list. For details about creating JRXML files, refer to the JasperReports and iReport Designer documentation, which is described in section 1.3.2, “Premium Documentation,” on page 11.

Perhaps the simplest way to create Topics is to create new JRXML files using iReport, then use the JasperReports Server plug-in for iReport to upload them to the repository. Note that iReport can edit Ad Hoc views, but the grouping and sorting you defined in the Ad Hoc Editor are lost. For more information, refer to section 9.5.7, “iReport and Ad Hoc Views,” on page 104.

Any report layout in the Topic’s JRXML file is ignored by the Ad Hoc Editor. Jaspersoft recommends that a Topic’s JRXML file not include anything other that the query and field list.

When you create a JRXML file that will be used as a Topic, you can specify the name to display for each column that the Topic returns. To do so, define a field property named adhoc.display for each field declared in the JRXML. For more information, see the JasperReports Server User Guide.

2.3.2 Administering Domains

From a user perspective, Domains are sets of fields that can be configured and filtered before being added to a view. Domains provide a starting point for end-users using the Ad Hoc Editor. Under the covers, Domains are defined by a design that can be uploaded to the server and exported as XML. Unlike Topics, which must be stored in a specific folder in the repository, Domains are detected regardless of their location in the repository. The /Domains folder is included for your convenience, but the Domains tab in the Source dialog (which appears when users click Create > Ad Hoc View) displays all the Domains to which you have access in the repository.

For details about creating Domains, refer to the JasperReports Server User Guide.

2.3.3 Scalability

When you open views in the Ad Hoc Editor, the query’s entire result set is retrieved. If your Topics, Domains, or OLAP client connections return large result sets, your server instance requires more memory. Similarly, many actions users take in the Ad Hoc Editor (such as adding groups) require the server to re-sort the data on the server; if the query returns a large result set, the user may notice a delay when making such changes.

To reduce delays, decrease the memory requirement, and support more users, Jaspersoft recommends that the queries in Topics, Domains, and OLAP client connections return a reasonable amount of data for your hardware and system capacity.

If you encounter scalability or performance issues around Ad Hoc views, examine the server’s memory usage first. Then consider optimizing your Topics and Domains.
A Domain very often returns a large volume of data, which can impact performance of the Domain designer, the Ad Hoc Editor, and the final views and reports. If your Domain’s performance is slow, try the following remedial steps:

- Set your data policies and other Ad Hoc settings to reasonable values for your data and system configuration. In the case of data policies, you can configure the server to use less memory but perform more queries, which may perform better under certain circumstances. For more information, refer to the JasperReports Server Administrator Guide.
- The Java Virtual Machine (JVM) that the server runs in may need to be configured for higher memory usage. For information, refer to the documentation associated with your JVM. For more information, refer to the JasperReports Server Installation Guide.
- Use the smallest number of joins that creates the data islands you need. Complex join relationships can impact performance drastically.
- If your end-users experience time out messages or views and reports that seem to never complete, consider changing the governors defined for views and reports. For more information, refer to the JasperReports Server Administrator Guide.
- Use filters to narrow the data returned by Domains or Domain Topics to improve performance of views based on large or complex Domains: limit the initial load time of a Domain by defining a filter in the Choose Data wizard. Set it to prompt to allow your users to edit it or remove it in the Ad Hoc Editor’s filter pane.
- When running a view that relies on a Domain, the server uses the filters and security defined for the particular view and user to limit the query. Running many views with slightly different security or filters may cause problems with the server’s memory usage. In this case, similar data is duplicated in memory, which can impact performance. Increasing the memory allocated to the application server that hosts JasperReports Server can mitigate this issue.

For more information about designing Domains, refer to section 6.8, “Domain and Security Recommendations,” on page 58.
CHAPTER 3  THE REPORT VIEWER AND CONDITIONAL TEXT

This section describes functionality that can be restricted by the software license for JasperReports Server. If you don’t see some of the options described in this section, your license may prohibit you from using them. To find out what you’re licensed to use, or to upgrade your license, contact Jaspersoft.

The interactive Report Viewer lets you and your users interact with saved reports to visualize the data in different ways. Report users can format tables and charts, filter reports, and highlight table values using conditional formatting. This chapter shows how to use multiple conditions in a table to create a stoplight format based on ranges. To set up this format, you need to use the inheritance feature of conditional formatting. For colored backgrounds, this specifies that when a table cell satisfies multiple conditions, the condition that appears highest in the list of conditions is applied.

**To create the Ad Hoc table for use in the example:**

1. Select **Create > Ad Hoc View** from the menu. The Data Chooser wizard opens.
2. Click **Domains**, select SuperMart Domain, and click **Choose Data**. The Data Chooser opens to the Select Fields page.
3. In the Source panel, double-click Sales to move it to the Selected Fields panel.
4. Click **Table**. The Ad Hoc Editor is displayed with the selected fields.
5. Double-click the following fields and measures to add them to the Columns area: Product Name, Recyclable Packaging, Store Sales. The Ad Hoc view appears as shown in the following figure.

![Ad Hoc View for Conditional Text](image)

**Figure 3-1  Ad Hoc View for Conditional Text**
6. Hover over and select **Save Ad Hoc View and Create Report**. The Save Ad Hoc View dialog opens.

7. Fill in the required fields as follows:
   a. Data View Name: Conditional Text Example View
   b. Data View Description: Created in Ultimate Guide
   c. Report Name: Conditional Text Example Report
   d. Report Description: Created in Ultimate Guide

8. For Save Location, click **Browse**, select **Organization > Reports > Samples**, and click **OK**.

9. Click **Save**. A message confirms that the view was saved.

**To open the report in the viewer:**
1. Select **View > Repository**.

**To create “stop light” conditional formatting on a numeric column:**
1. Click the Store Sales column. The column is highlighted and the column formatting icons appear at the top of the column.

2. Move your mouse over and select **Formatting**... The Format Columns dialog box appears.

3. Click the **Conditional Formatting** tab. The Conditional Formatting options appear.

4. Click **Add** to create a new condition, and fill in the fields as follows:
   a. Select **Greater than** from the Operator menu.
   b. Enter **8** in the Condition box.
   c. Click and pick a green background.

5. Click **Add** to create a second condition, and fill in the fields as follows:
   a. Select **Greater than** from the Operator menu.
   b. Enter **3.5** in the Condition box.
   c. Click and pick a yellow background.

6. Click **Add** to create a new condition, and fill in the fields as follows:
   a. Select **Less than or equal to** from the Operator menu.
   b. Enter **3.5** in the Condition box.
   c. Click and pick a red background.

![Figure 3-2 Conditional Formatting for Numeric Values](image-url)
7. Click **OK**. The dialog box closes and your choices are applied. The report appears as shown in the following figure:

![Figure 3-3 Report with Conditional Formatting](image)

Notice that numbers greater than 8 satisfy the first two conditions; the first condition they satisfy is the one that is applied.
CHAPTER 4  DASHBOARDS

This section describes functionality that can be restricted by the software license for JasperReports Server. If you don’t see some of the options described in this section, your license may prohibit you from using them. To find out what you’re licensed to use, or to upgrade your license, contact Jaspersoft.

A dashboard displays several reports in a single, integrated view. A dashboard can also include input controls that determine the data displayed in one or more reports, other dashboards, and any other web content. By combining different types of related content, you can create appealing, data-rich dashboards that quickly convey business trends.

This chapter provides details about the dashboard designer and includes the following sections:

• User Interface Components
• Context Menus
• Tips and Tricks
4.1 User Interface Components

The figure below illustrates the main components of the dashboard designer:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Content</td>
<td>The list of content you can add to the dashboard, including Special Content and repository content. Standard content includes buttons and input controls for the reports you add. Repository content is limited to reports and dashboards; you cannot include analysis views or report resources such as images. You can double-click items in the list to place it automatically in the dashboard, or drag and drop items to place them yourself. To hide the column of available content, click the icon in the top left corner of the column; this is helpful when arranging content in a large dashboard. Click the same icon on the minimized column to expand it again.</td>
</tr>
<tr>
<td>Canvas</td>
<td>Occupying the right side of the designer, the canvas area is a visual editor for your dashboard content. It displays an example of how the dashboard will look, but the contents are not interactive. To interact with the dashboard as it will appear to users, click Preview. Before frames and other content have been added, the dashboard area only displays the title area and the grid, which is helpful in aligning content. Optionally, you can set guide lines to show you the edge of common screen sizes.</td>
</tr>
<tr>
<td>Tool bar</td>
<td>These buttons let you interact with the dashboard as a whole or change your view of the designer. The Save button gives you the choice of saving with the current name (overwriting) or saving a copy as a different name. The Options button lets you control the size of the optional guide lines on the canvas.</td>
</tr>
<tr>
<td>Title bar</td>
<td>The area of the dashboard where the title is generally displayed. If you do not use this title field, it displays as blank in a dashboard and you can place content over it.</td>
</tr>
<tr>
<td>Selection frame</td>
<td>Shows the active element in the dashboard for moving or resizing. Drag anywhere inside the selection frame to move the element. Drag the blue square in the lower left corner to resize it. Click or right-click in any other element to change the selection.</td>
</tr>
</tbody>
</table>
4.2 Context Menus

Context menus appear when you right-click elements in the dashboard designer. Each menu offers additional options for the selected element.

For labels and free text, you can also click the text to edit it when the blue selection frame is not active. For reports and custom URLs you can set options such as scroll bars and the refresh interval, as shown in Figure 4-2.
### 4.3 Tips and Tricks

Here are some tips on designing dashboards:

<table>
<thead>
<tr>
<th>Multi-select options</th>
<th>When you select multiple frames, you can move or resize them all at once. To select several frames at once, use click-and-drag to draw a box around them or Ctrl-click while you select the frames.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passing hidden parameters</td>
<td>If a report on the dashboard has a parameter that isn’t mapped to an input control in the dashboard, you can set a value for that parameter by adding it to the URL. To do so, append &amp;hidden_&lt;parameter&gt;=&lt;value&gt;, where &lt;parameter&gt; is the name of a parameter defined in the report and &lt;value&gt; is a valid value for the parameter. For example, to set a dashboard report’s Country parameter to USA, the URL might be similar to: http://&lt;hostname&gt;:8080/jasperserver-pro/flow.html?_flowId=dashboardRuntimeFlow&amp;dashboardResource=%2Fdashboards%2FMyDash&amp;hidden_Country=USA The hidden parameter applies to all reports that reference this input control. This can be useful when emailing a link to a dashboard. You can select the default value the recipient will see by editing the URL in the email.</td>
</tr>
<tr>
<td>Suppressing server UI decoration</td>
<td>By default, dashboards are displayed on a standard JasperReports Server page called the Dashboard Viewer. This page includes other elements of the user interface such as the search field and main menus. To suppress all of the server UI decoration around the dashboard, add the viewAsDashboardFrame parameter to the dashboard URL as follows: http://&lt;hostname&gt;:8080/jasperserver-pro/flow.html?_flowId=dashboardRuntimeFlow&amp;dashboardResource=%2Fdashboards%2FMyDash&amp;viewAsDashboardFrame=true This can be useful when emailing a link to a dashboard. You can strip out the header and footer so the recipient’s eye is drawn to the most important information. This can also be useful when embedding the dashboard in another application.</td>
</tr>
<tr>
<td>Embedding a dashboard in another page</td>
<td>You can embed a dashboard in another HTML page outside of JasperReports Server by creating an iFrame and specifying the dashboard’s URL as the iFrame’s src attribute. The dashboard icons (normally visible when you hover over a dashboard component) may be missing when the dashboard is embedded in an iFrame. To ensure these icons are visible, add the JasperReports Server CSS class outerDashboardFrame to your iFrame.</td>
</tr>
</tbody>
</table>
| Using keyboard shortcuts | You can move or delete dashboard content using your keyboard:  
- Arrow keys: move up, down, left, or right.  
- Delete key: delete the selected content.  
- Escape: close the dialog or cancel edit, depending on your selection.  
- Ctrl: select multiple frames or buttons. When you are dragging or resizing content, Ctrl disables the snap-to-grid behavior. |
| HTML in text fields | Free Text fields have limited support for HTML code. For example, to create a label in a different color, such as blue, you could define a span within the Free Text field. In this case, you could enter the following:  
\[
\text{<span style="color:blue;">Blue Text</span>}
\]  
Note that this advanced feature may return unexpected results, depending on the nature of the HTML you enter and the browser that displays the dashboard.  
In some versions of JasperReports Server, you may receive an error when you attempt to enter HTML code in a Free Text field. In 5.0, you can enable HTML in Free Text fields as follows:  
Edit the file `<js-install>/WEB-INF/classes/esapi/security.properties`, and locate the line:  
`label=Alpha,AlphaNumPunctuation,500,true,label-ViewRepositoryEdit_context`  
Change this to:  
`label=Alpha,AlphaNumPunctuationBrackets,500,true,label-ViewRepositoryEdit_context`  
Note that changing this line in the security.properties file can affect the security of your installation. |
| Adding labels on input controls | When you add an input control to the dashboard, its label is automatically added as well; you can also add labels manually by dragging the Text Label standard control from the Available Content list. Text labels are like free text elements, but they cannot be resized. |
| Adding local content, such as images | You can add images and other types of web content to a dashboard. To create a Custom URL frame that displays custom content, either:  
• Publish the content to a URL-addressable location and create a Custom URL frame that points to it; or  
• Add the file under the jasperserver-pro directory in your installation, by default `<js-install>/apache-tomcat/webapps/jasperserver-pro/`. For example, you could create the jasperserver-pro/content directory to hold a file named `cow_logo.jpg`. The URL to this content would be `http://<hostname>:8080/jasperserver-pro/content/cow_logo.jpg`.  
Custom URLs in dashboards support any content that can be displayed in an iFrame. See the example in Figure 4-3 on page 35. |
| Sizing frames | To automatically fit the frame around a report or dashboard, right-click the item and select **Size to Content**. You can also hide and show scroll bars in frames with other options on the context menu. |

![Free text field using HTML](image1)

*Figure 4-3 Dashboard Tips and Tricks*
CHAPTER 5  CUSTOM DATA SOURCES

JasperReports Server provides built-in support for many commonly used data sources, such as JDBC, JNDI, and JavaBeans, as described in the JasperReports Server Administrator Guide. However, JasperReports Server does not include all JasperReports Library data sources, and you may want to use a custom JasperReports Library data source. In either case, you can extend JasperReports Server to support additional data sources by adding files to your configuration.

In order to perform many of the tasks described in this section, you must have the administrator role and administrator access to the computer where JasperReports Server is installed.

This chapter contains the following sections:

- Data Sources in JasperReports Library
- Overview of the Custom Data Source Examples
- Prerequisites and Installation of the Examples
- Creating a Custom Data Source
- Installing a Custom Data Source

5.1  Data Sources in JasperReports Library

While a JasperReports Library data source is a different object from a JasperReports Server data source, they work together closely:

- A JasperReports Library data source is an implementation of the JRDataSource interface that provides data organized in rows and columns to the JasperReports Library filler; it produces a JasperPrint object. Each field declared in the JRXML corresponds to a column in the JRDataSource output.

- A JasperReports Server data source is a persistent object in the repository; it is typically created by stepping through a wizard. The data source stores properties that tell JasperReports Server how to create a JRDataSource (typically in collaboration with a JRQueryExecuter). These properties vary with the type of data source; for example, a JDBC data source needs a JDBC driver, URL, user, and password. A data source can be defined as a public repository object that can be used by any report unit (for example, the repository includes the /datasources/JserverJdbcDS if you installed the sample data), or as a local object defined during the creation of a specific report unit.

When JasperReports Server receives a request to run a report unit, it maps the report unit’s data source to an implementation of ReportDataSourceService, which returns a JRDataSource based on the data source’s persistent properties. The JRDataSource is used to fill the report and produce a JasperPrint object, from which the server generates HTML or other supported output formats.
Each JasperReports Server data source implementation must support the following features:

- Read and write persistent properties in the JasperReports Server repository.
- Provide a user interface for creating and editing instances that are integrated with the JasperReports Server web interface.
- Create a JRDataSource using the property values for a specific data source instance, or pass parameters to a JRQueryExecuter that produces the JRDataSource.

JasperReports Server’s built-in data sources rely on several Java classes, along with specialized Spring bean files, WebFlow configurations, message files, and JSP files. The custom data source framework provides the same functionality by using a Spring bean file, a message catalog, and a minimum of one Java file (more are required to support optional features).

### 5.1.1 Query Executers

A query executer is an implementation of the JRQueryExecuter interface in JasperReports Library. It interprets the queryString in the JRXML and produces a JRDataSource. JasperReports Library (either standalone or running in JasperReports Server) determines which query executer to use by looking at the language attribute of the queryString and looking up a query executer factory registered for that language.

JasperReports Server data sources can use two different methods to create a JRDataSource:

- The JasperReports Server data source can create a JRDataSource directly, without a queryString in the JRXML; or
- The server can pass implementation-specific objects to the query executer through the report parameter map. The query executer then uses the objects from the parameter map, as well as the contents of the queryString, to create the JRDataSource.

Selecting the method to use depends on the nature of the data source, as well as whether you want to use a queryString to control your data source. A good example of a data source using a query executer is the JDBC data source: it passes a JDBC connection to the JDBC query executer, which it uses to pass the SQL queryString to the database.

The examples described in the following sections demonstrate both methods:

- The custom bean data source creates a JRDataSource directly, which returns a hard-coded list of JavaBeans.
- The webscraper data source can either create a JRDataSource directly, using the properties supplied by the data source instance, or it can get those properties from a queryString in the JRXML. In this case, a data source instance isn’t required. The sample reports for this data source each demonstrate one of these approaches.

### 5.2 Overview of the Custom Data Source Examples

Jaspersoft provides two example custom data sources:

- Custom Bean Data Source
- Webscraper Data Source

The examples are found in the <js-install>/samples/customDataSource directory where you installed JasperReports Server. Once you have deployed JasperReports Server to your application server, you can use Apache Ant to build and deploy the examples.

The examples in this section have been verified with 4.7.1.

### 5.2.1 Custom Bean Data Source

The custom bean data source implementation creates a data source from a collection of Java beans declared in the source code. Its Spring bean definition file is in <js-install>/samples/customDataSource/webapp/WEB-INF/ applicationContext-sampleCDS.xml. Jaspersoft provides an example report that uses this data source; it is called simpleCDS.jrxml and is located in the <js-install>/samples/customDataSource/reports directory.
5.2.2 Webscraper Custom Data Source

The webscraper custom data source implementation fetches a web page, decodes its HTML, and extracts selected data that is turned into field values in the data source. Its Spring bean definition file is located in <js-install>/samples/customDataSource/webapp/WEB-INF/applicationContext-webscraperDS.xml.

The example reports for this data source read a web page from http://www.craigslist.org and extract a list of items for sale.

The webscraper data source configuration includes these elements:

- **URL**: An HTTP URL that refers to the HTML page containing the desired content.
- **DOM path**: An XPath expression that locates HTML elements to be turned into rows in the data source.
- **Field paths**: XPath expressions for each field defined in the JRXML. JasperReports Server uses these paths to locate the field value in each row selected by the DOM path.

The implementation creates a data source by:

- Using the URL to issue a GET request for an HTML page.
- Using the DOM path to select XML elements from the converted response.
- Creating a new data source row for each selected element.
- Determining the context for each field based on its field path.

The data source takes two parameters: the URL of the web page and the XPath that determines how elements in the HTML page become rows in the data source. The parameters can either be specified by a data source definition in the repository or by a query string in the JRXML. JasperReports Server uses these paths to locate the field value in each row selected by the DOM path.

In order to use the webscraper data source, you must first register the webscraper query executer factory. One way to do this is as follows:

1. Open the file <js-install>/WEB-INF/classes/jasperreports.properties for editing.
2. Add the following at the end of the file:
   ```properties
   # registering query executer for webscraperQEtest.jrxml example
   net.sf.jasperreports.query.executor.factory.webscraper=example.cds.WebScraperQueryExecuterFactory
   ```
3. Save the file.
4. Restart your application server.

For more information about registering query executors, see the Report Query section in the *JasperReports Library Ultimate Guide*.

---

The URL above is an example of the type of query parameter that might work with an external web source. Note that web sites are frequently redesigned and the URLs used by any website are subject to change.
5.3 Prerequisites and Installation of the Examples

5.3.1 Java Development Kit
Because you must recompile the Java source files, you need the Java Development Kit (JDK). Ensure that the JAVA_HOME environment variable points to a full JDK installation.

5.3.2 About Apache Ant
If you used an installer to install JasperReports Server, you have Ant installed already. Run Ant using the following command:

```
<js-install>/apache-ant/bin/ant <ant-arguments>
```

If you installed JasperReports Server manually with a WAR file, you must download Ant from http://ant.apache.org. Ant 1.8.1 was used for testing, but earlier versions may also work.

5.3.3 Installation
Each sample directory includes:
- src: Java source directory.
- webapp: A directory containing other files required by the examples, such as JSPs and Spring configuration files, which are copied directly to the JasperReports Server web application directory.
- reports: A directory containing example JRXML files that use the sample custom data sources.

To install the samples in your JasperReports Server web application:
1. At the command line, change directories to the custom data source sample directory (<js-install>/samples/customDataSource).
2. Edit build.xml and set the webAppDir property to the root of the JasperReports Server web application.
3. Run the Ant command (as described in 5.3.1, “Java Development Kit,” on page 40) with no arguments; this executes the default target, which is named deploy. The deploy target initiates these actions:
   - Compiles the Java source under the src directory.
   - Deploys the compiled Java class files to the web application.
   - Deploys files under the webapp directory to the web application.
4. Restart the application server.

These steps only make the example custom data sources themselves available in JasperReports Server. To test the data sources, you must also create instances of the custom data sources in JasperReports Server, then upload the reports that accompany the samples.
5.4 Creating a Custom Data Source

A custom data source consists of Java code, a message catalog, and a Spring bean definition file that configures all the parts of the implementation with JasperReports Server. This section describes the implementation of a custom data source.

### Files Used by a Custom Data Source Implementation

<table>
<thead>
<tr>
<th>Type</th>
<th>Path (relative to web application directory)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spring bean definition</td>
<td>WEB-INF/applicationContext-&lt;name&gt;.xml where &lt;name&gt; uniquely identifies your custom data source</td>
<td>Defines Spring beans needed to configure the data source. Choose a unique name starting with applicationContext- and ending with .xml.</td>
</tr>
<tr>
<td>Message catalog</td>
<td>WEB-INF/bundles/&lt;cat_name&gt;.properties where &lt;cat_name&gt; uniquely identifies your custom data source</td>
<td>Defines messages used by the data source implementation (this path is referenced in the Spring bean definition file).</td>
</tr>
<tr>
<td>Implementation classes</td>
<td>WEB-INF/lib or WEB-INF/classes</td>
<td>Any Java code required by the implementation.</td>
</tr>
</tbody>
</table>

#### 5.4.1 Implementing the ReportDataSourceService Interface

A custom data source requires an implementation of the `ReportDataSourceService` interface, which sets up and tears down data source connections in JasperReports Server. It relies on:

- `void setReportParameterValues(Map parameterValues)`: called before running a report; it creates resources needed by JasperReports Library to obtain a `JRDataSource`, and adds them to the parameter map.
- `void closeConnection()`: cleans up any resources allocated in `setReportParameterValues()`.

#### 5.4.2 Defining Custom Data Source Properties

A custom data source can define properties that help users configure each data source instance differently, in the same way that a JDBC data source has properties for JDBC driver class, URL, user name, and password. While implementing your `ReportDataSourceService`, Jaspersoft recommends that you consider which properties you’ll need.

There are two kinds of properties:

- **Editable properties** that must be string values. When you use the JasperReports Server data source wizard to create an instance of your custom data source, you can enter values for the editable properties using text fields. These values are persisted when you save the data source.
- **Hidden properties** that can be of any type. These property’s values are determined by the Spring configuration file: they are not persisted, nor are they visible in the data source wizard. Use them to give your `ReportDataSourceService` implementation access to a Spring bean instance.

For an example of both types of properties, see the custom bean data source definition in the XML example in section 5.4.5, “Defining the Custom Data Source in Spring,” on page 43.

These property values are set by the custom data source framework after it instantiates your `ReportDataSourceService` implementation. You need property setters and getters corresponding to each property name; for example, if you defined a property with the name `foo`, you need `getFoo()` and `setFoo()` methods.
5.4.3 Implementing Optional Interfaces

If you want to use the value of the `queryString` in the JRXML to obtain your data source, you must create implementations of the `JRQueryExecuter` and `JRQueryExecuterFactory` interfaces.

<table>
<thead>
<tr>
<th>Optional Interfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
</tr>
<tr>
<td>JRQueryExecuterFactory</td>
</tr>
<tr>
<td>JRQueryExecuter</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>CustomDataSourceValidator</td>
</tr>
</tbody>
</table>

5.4.4 Creating the Message Catalog

The message catalog contains messages displayed by JasperReports Server’s data source wizard when creating and editing custom data source instances. The various types of messages are shown in the following table, along with message naming conventions:

<table>
<thead>
<tr>
<th>Messages about Instances of Custom Data Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
</tr>
<tr>
<td>Name of the custom data source type</td>
</tr>
<tr>
<td>Name of the custom data source property</td>
</tr>
<tr>
<td>Validation messages</td>
</tr>
</tbody>
</table>
For example, the webscraper message catalog contains the following:

```java
webScraperDataSource.name=Web Scraper Data Source
webScraperDataSource.properties.url=URL
webScraperDataSource.properties.path=DOM Path
webScraperDataSource.url.required=A value is required for the URL
webScraperDataSource.path.required=A value is required for the DOM path
```

### 5.4.5 Defining the Custom Data Source in Spring

To configure your data source, you must add an instance of `CustomDataSourceDefinition` to the Spring bean definition file. This class has the following properties:

<table>
<thead>
<tr>
<th>Properties of <code>CustomDataSourceDefinition</code> Class</th>
<th>Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>factory</td>
<td>Yes</td>
<td>A fixed value of <code>ref=&quot;customDataSourceFactory&quot;</code> This bean manages all the custom data sources.</td>
</tr>
<tr>
<td>name</td>
<td>Yes</td>
<td>A unique name that identifies this data source to the custom data source framework. It is also used as a prefix for all messages in the message catalog. Choose the name that is not used by other custom data sources.</td>
</tr>
<tr>
<td>serviceClassName</td>
<td>Yes</td>
<td>A class name for your <code>ReportDataSourceService</code> implementation.</td>
</tr>
<tr>
<td>validator</td>
<td>—</td>
<td>An instance of your <code>CustomDataSourceValidator</code> implementation.</td>
</tr>
<tr>
<td>propertyDefinitions</td>
<td>—</td>
<td>Information describing each property used by the data source implementation, structured as a list of maps.</td>
</tr>
</tbody>
</table>

The `propertyDefinitions` property is a list of maps, each one describing a property of the custom data source implementation. It includes these entry keys:

<table>
<thead>
<tr>
<th>Entry Keys for <code>propertyDefinitions</code> Property</th>
<th>Required</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Yes</td>
<td>Name of property that matches a Java Bean property in the <code>ReportDataSourceService</code> implementation; it is also used in message catalog keys.</td>
</tr>
<tr>
<td>default</td>
<td>—</td>
<td>A default value for the property.</td>
</tr>
<tr>
<td>hidden</td>
<td>—</td>
<td>If a property has the <code>hidden</code> entry key set to <code>true</code>, then its value is fixed to that of the <code>default</code> entry key. Such properties are not be editable in the JasperReports Server data source wizard, nor are they persisted. This is handy for making Spring beans accessible to <code>ReportDataSourceService</code> implementations.</td>
</tr>
</tbody>
</table>
The following XML defines a `CustomDataSourceDefinition` bean for the custom bean data source example:

```xml
<bean id="myCustomDataSource" class="com.jaspersoft.jasperserver.api.engine.jasperreports.util.
CustomDataSourceDefinition">
  <property name="factory" ref="customDataSourceServiceFactory"/>
  <property name="name" value="myCustomDataSource"/>
  <property name="serviceClassName" value="example.cds.
  CustomSimplifiedDataSourceService"/>
  <property name="validator">
    <bean class="example.cds.CustomTestValidator"/>
  </property>
  <property name="propertyDefinitions">
    <list>
      <map>
        <entry key="name" value="foo"/>
      </map>
      <map>
        <entry key="name" value="bar"/>
        <entry key="default" value="b"/>
      </map>
      <map>
        <entry key="name" value="repository"/>
        <entry key="hidden" value="true"/>
        <entry key="default" value-ref="repositoryService"/>
      </map>
    </list>
  </property>
</bean>
```

### 5.4.6 Configuring the Message Catalog

To configure your message catalog, add a bean definition such as the following to the Spring definition file that you created in “5.4.5, “Defining the Custom Data Source in Spring,” on page 43”:

```xml
<bean class="com.jaspersoft.jasperserver.api.common.util.spring.GenericBeanUpdater">
  <property name="definition" ref="addMessageCatalog"/>
  <property name="value" value="WEB-INF/bundles/cdstest"/>
</bean>
```

For the `value` property, substitute the location of your message catalog file, omitting the `.properties` extension. Setting the `addMessageCatalog` property precludes the need to edit the `messageSource` bean definition in `applicationContext.xml`. Note that, if you also supply localized versions of the message catalog that follow the Java conventions for naming resource bundles, users with other locales automatically see the localized strings when creating a new data source of this type.

### 5.5 Installing a Custom Data Source

To install your custom data source in JasperReports Server, add all the files it requires to the server web application directory. For the correct locations, refer to the table, “Files Used by a Custom Data Source Implementation,” on page 41. After adding the files, restart JasperReports Server.
When you create a new data source in JasperReports Server, the new custom data source type appears in the list of available data source types. If the new type is selected, JasperReports Server displays a form containing the list of properties you configured.

When the form is submitted, the parameter values are validated with your `CustomDataSourceValidator` implementation and appropriate validation messages are displayed. Once the data source is validated, save it to the repository. The data source can now be used in a report or analysis connection.

When defining `<queryString>` in JRXML, use a language setting that your custom data source supports.

When you add a report to the repository, you can define a local data source or you can select one of the data sources in the repository. In either case, you can use a data source based on your custom data source implementation. In the case of a data source in the repository, you must create it before adding the report. If, during the creation of your data source, the custom data source is not listed as an available data source type, the custom data source is not properly installed.
CHAPTER 6  SECURING DATA IN A DOMAIN

This section describes functionality that can be restricted by the software license for JasperReports Server. If you don’t see some of the options described in this section, your license may prohibit you from using them. To find out what you’re licensed to use, or to upgrade your license, contact Jaspersoft.

You may need to restrict access to the data in a Domain when it is accessed by different people. For example, you may allow managers to analyze data across their department but only allow individual contributors to see data related to themselves. For this purpose, Domains support security files.

When Domain security is properly configured, a user only sees the data that the organization wants them to see. To define this access, you write data access filtering rules (access grants) in XML and upload them as a new security file using the Domain designer. These rules are powerful and flexible, and can be based on a number of aspects, such as user roles or profile attributes.

The power of this solution is best presented as an example business case. This section describes a fictional company’s implementation of Domains in JasperReports Server—from both a business perspective and an implementation perspective. For details about the basics of Domains, refer to the JasperReports Server User Guide.

This chapter describes a number of tasks that only administrative users can perform.

In addition, the examples in this chapter assume that you have a JasperReports Server version 3.7.1 or newer. If you are running version 3.7.0, update to the latest version before testing the filter expressions in this chapter.

This chapter includes the following sections:

- Business Case
- Overview of CZS’s Process
- Sales Domain
- Roles, Users, and Profile Attributes
- Setting Up Testing
- Creating a Security File
- Testing and Results
- Domain and Security Recommendations
- Reference Material
6.1 Business Case

CZS is an up-and-coming consumer electronics company with operations in the U.S. and Japan. CZS uses JasperReports Server to track sales data, such as sales revenue and operating cost.

The CZS Sales organization employs the following personnel:

- Rita is the regional sales manager in the Western U.S. She uses the Sales Domain to create reports that track sales trends in her region.
- Pete is a sales representative selling televisions in Northern California. He uses reports based on the same Domain to track his quarterly progress.
- Yasmin is a sales representative selling cell phones in Northern California. She uses reports based on the same Domain to track her quarterly progress.
- Alexi is the regional sales manager in Kansai, Japan. He uses reports based on the same Domain to track sales trends in his region.

CZS stores its data in a MySQL database. The data is exposed by the Sales Domain, which displays information about CZS’s consumer electronics sales across the world. It is filtered depending on each employee’s cities of operation and product. In addition, only managers can access cost information.

6.2 Overview of CZS’s Process

1. This chapter shows how to implement this business case using a Domain. The table below summarizes the steps CZS could take to create the Sales Domain and configure it to secure their data using user profile attributes and roles; the following sections describe these steps in more detail.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Described in Section …</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Define a Domain. The CZS business case is met by a Sales Domain that includes the following fields from their JDBC data source: city, state, product department, sales amount, cost amount, and unit sales.</td>
<td>6.3, “Sales Domain,” on page 48</td>
</tr>
<tr>
<td>2. Identify and create access roles. CZS needs two roles: one for managers, and another for sales representatives. Both are granted access to the Sales Domain.</td>
<td>6.4.1, “Roles,” on page 50</td>
</tr>
<tr>
<td>3. Create users and assign appropriate roles to each one.</td>
<td>6.4.2, “Users,” on page 50</td>
</tr>
<tr>
<td>4. Identify and create profile attributes that determine each user’s access to data in the Domain. For this example, CZS needs two attributes: Cities and ProductDepartment.</td>
<td>6.4.3, “Profile Attributes,” on page 50</td>
</tr>
<tr>
<td>5. Prepare to test the security implementation by enabling logging and creating an example report.</td>
<td>6.5, “Setting Up Testing,” on page 51</td>
</tr>
<tr>
<td>6. Iteratively create, upload, and test an XML file that defines the access granted to users based on the attributes defined in step 4.</td>
<td>6.6, “Creating a Security File,” on page 53</td>
</tr>
<tr>
<td>7. Test the Domain as various users.</td>
<td>6.7, “Testing and Results,” on page 56</td>
</tr>
</tbody>
</table>

6.3 Sales Domain

The first step is to create a Domain that presents the relevant data. CZS is primarily interested in the volume and revenue of their sales, as well as their operational cost. These metrics are represented in the Sales Domain as fields: unit sales, store sales, and store cost. The Domain also includes fields to establish context for the sales data, such as product department, city, and state. The following figures show the configuration of this Domain in the designer.
The XML representation of this Domain design is shown in section 6.9.1, “Domain Design in XML Format,” on page 59.
6.4 Roles, Users, and Profile Attributes

6.4.1 Roles

Domain security can reference a user’s roles to determine the access permissions to grant. The following roles meet CZS’s needs:

- ROLE_SALES_MANAGER is assigned to sales managers.
- ROLE_SALES_REP is assigned to sales representatives.

CZS grants each role access to view the Sales Domain. For details about creating roles and assigning privileges, refer to the *JasperReports Server Administrator Guide*. The following shows CZS’s ROLE_SALES_REP:

![Figure 6-4 CZS Sales Representative Role](image)

6.4.2 Users

CZS created a user for each of their employees and assigned roles based on each employee’s level of responsibility:

<table>
<thead>
<tr>
<th>User</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alexi</td>
<td>ROLE_SALES_MANAGER</td>
</tr>
<tr>
<td>Pete</td>
<td>ROLE_SALES_REP</td>
</tr>
<tr>
<td>Rita</td>
<td>ROLE_SALES_MANAGER</td>
</tr>
<tr>
<td>Yasmin</td>
<td>ROLE_SALES_REP</td>
</tr>
</tbody>
</table>

For details about creating users, refer to the *JasperReports Server Administrator Guide*.

6.4.3 Profile Attributes

A profile attribute is a name-value pair defined at the user level that corresponds to some data in a Domain. CZS wants to be able to describe their users in terms of product lines that they sell and the cities where they sell them. Thus, each CZS user is assigned two profile attributes in addition to the users’ roles:

<table>
<thead>
<tr>
<th>User</th>
<th>Profile Attributes</th>
<th>Product/Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rita</td>
<td>San Francisco, Los Angeles, Sacramento</td>
<td>Television, Wireless Devices</td>
</tr>
<tr>
<td>Pete</td>
<td>San Francisco</td>
<td>Television</td>
</tr>
</tbody>
</table>

For details about setting profile attributes, refer to the *JasperReports Server Administrator Guide*.
The security file shown in section 6.9.2, “Domain Security File,” on page 62 refers to two of these profile attributes:
- The Cities profile attribute corresponds to the City field in the Geography item group in the Sales Domain.
- The ProductDepartment attribute corresponds to the Department field in the Product item group in the Sales Domain.

Each user’s attributes determine the data returned to him by the Domain, based on an access grant definition that refers to profile attributes. For example, Rita’s attribute value for Cities is San Francisco, Los Angeles, Sacramento while Pete’s is San Francisco. Thus, Pete sees less data than Rita does.

As of JasperReports Server 5.0, user profile attributes can be created via the JasperReports Server user interface. Refer to the JasperReports Server Administrator Guide for details. For information on configuring profile attributes in earlier versions of JasperReports Server, see the JasperReports Server Ultimate Guide corresponding to your version.

The following figure shows the configuration of Rita’s user account. Notice Rita’s profile attributes listed below her roles:

---

### Table 6-1 Profile Attributes of All CZS Users, continued

<table>
<thead>
<tr>
<th>User</th>
<th>Profile Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cities</td>
</tr>
<tr>
<td>Yasmin</td>
<td>San Francisco</td>
</tr>
<tr>
<td>Alexi</td>
<td>Osaka, Sakai</td>
</tr>
<tr>
<td></td>
<td>Product/Department</td>
</tr>
<tr>
<td></td>
<td>Wireless Devices</td>
</tr>
</tbody>
</table>

---

6.5 Setting Up Testing

Before creating a security file, CZS prepares for the implementation by:
- Enabling Logging
- Creating a Test Report

---

Figure 6-5 CZS User Rita’s Configuration
6.5.1 Enabling Logging

To assist in the iterative creation of their security file, CZS enables more verbose logging to help troubleshoot problems with the Sales Domain and security file. Such logging features are disabled by default to minimize the size of logs. They should be enabled in test environments when defining security.

To enable Domain security logging:
1. Locate and open the log4j.properties file and scroll to the bottom of the file.
   This file is found in the WEB-INF folder; if you use Tomcat as your application server, the default path to this location is: 
   `<js-install>`\apache-tomcat\webapps\jasperserver-pro\WEB-INF.
2. Add the following lines after the last line in the file:

   ```
   log4j.logger.com.jaspersoft.commons.semantic.dsimpl.JdbcTableDataSet=DEBUG, stdout, fileout
   log4j.logger.com.jaspersoft.commons.util.JSControlledJdbcQueryExecutor=DEBUG, stdout, fileout
   ```
3. Save the file.

Information about Domains and their security will now be written to the log and to the console.

   The additional information written to the log can be very verbose, and your log files will grow more quickly with these properties enabled. You can manage your logs in the file system; they are found in the WEB-INF/logs folder under your JasperReports Server installation. For more information, refer to the log4j documentation, which is available at:

   Because these options are so verbose, Jaspersoft recommends that they only be used during debugging; these options should be disabled in production environments.

6.5.2 Creating a Test Report

CZS creates an Ad Hoc crosstab based on the Sales Domain to assist in testing the security file as they create each access grant. The report displays store sales amount, store sales cost, and store units sold for all cities and departments.

Each user’s limited view of this report is shown in section 6.7, “Testing and Results,” on page 56.
6.6 Creating a Security File

A Domain’s security file contains item and resource access grants that specify access based on certain aspects of a user, such as roles. Typically, access grants check a user’s roles and grant access to the columns and rows available to that role.

A Domain’s security file consists of access definitions of two types:

- Row-level access, which determines the rows in the data source that can be displayed to a specific user.
- Column-level access, which determines the columns in the data source that can be displayed to specific users.

This section illustrates both kinds of access grant.

Note the comments in the XML examples in this section; for example: <!-- Comment -->. It’s good practice to comment the access grants you define, and to format your XML neatly. Jaspersoft recommends that you use an XML editor when creating security files. See also section 6.8, “Domain and Security Recommendations,” on page 58.

6.6.1 Row-level Security

This section gives an overview of row-level security and then shows how CZS uses row-level security to restrict access based on Cities and ProductDepartment.

6.6.1.1 Understanding Row-level security

Row-level access determines the rows in the data source that can be displayed to a specific user.

For example, consider a table that includes values for the cities where products are sold. You could define a resource access grant that finds users for which a city has been defined as a profile attribute and, for each such user, limits access to rows where the city value is the user’s specific city.

For example, take Rita and Alexi. Both have the same role and the same access to the Sales Numbers analysis view, but CZS doesn’t want them to see the same data—Rita should see data about San Francisco, Sacramento, and Los Angeles; and Alexi should see data about Osaka and Sakai. Without profile attributes, this would only be possible if CZS’s access roles were defined along geographic lines.

The following resource grant gives access to users whose Cities profile attribute is San Francisco. The principle expression determines the users to whom the resource access grant applies, that is, users whose Cities profile attribute is San Francisco. The filter expression determines the rows to display, that is, those rows where the store_city field is San Francisco:

```xml
<resourceAccessGrant id="Jointree_1_row_access_grant_2">
  <principalExpression><![CDATA[authentication.getPrincipal().getAttributes().any
{it.getAttrName() in ['Cities'] && it.getAttrValue() in ['San Francisco'] }]]></principalExpression>
  <filterExpression>store.store_city in ('San Francisco')</filterExpression>
</resourceAccessGrant>
```

Access grant IDs must be unique within the scope of the security file.

You can define several similar resource access grants for each resource defined in your Domain. By default, the server assumes access grants are chained together with a logical AND. You can force the server to use a logical OR by setting the orMultipleExpressions property to TRUE.

6.6.1.2 The testProfileAttribute Function

The expression in the previous section is limited. You do not want to write a separate expression for each instance of the Cities profile attribute — for example, one expression for San Francisco and another expression for Osaka. To avoid this, use the DomEl function testProfileAttribute.
The `testProfileAttribute` function takes two parameters:

\[
\text{testProfileAttribute(table\_ID.field\_name, 'profileAttribute')}
\]

where:
- `table\_ID.field\_name` is the table name and field name of the field whose value you’re comparing to a profile attribute.
- `profileAttribute` is the name of the user profile attribute.

The `testProfileAttribute` function is not available in versions of JasperReports Server earlier than 3.7.1.

For example, CZS used the following XML to define a principal expression and filter expression that grant access to users based on their `Cities` profile attribute:

```xml
<resourceAccessGrant id="Jointree_1_row_access_grant_20">
  <principalExpression><![CDATA[authentication.principal.attributes.any
    {it.attrName in ['Cities' ]}]></principalExpression>
  <filterExpression>testProfileAttribute(store.store_city,'Cities')
  </filterExpression>
</resourceAccessGrant>
```

The principle expression is simple; it checks the `Cities` attribute of the logged-in user. The filter expression checks the user’s `Cities` profile attribute as well, but it compares this value with the values in the Domain’s `store\_city` field. The Domain then returns all the rows that match the user’s `Cities` profile attribute.

### 6.6.1.3 CZS’s Resource Access Grants

CZS uses the access grant above to determine data access based on a user’s `Cities` profile attribute. Because CZS defines all their profile attributes in the same manner, they can use a similar resource access grant to determine data access for users based on their `ProductDepartment` profile attribute.

The resulting security file included these two resource access grants (see the complete file in section 6.9.2, “Domain Security File,” on page 62):

```xml
<!-- Row level security -->
<!-- What access do roles/users have to the rows in the resource? -->
<resourceAccessGrantList id="JoinTree_1_List" label="ListLabel"
  resourceId="JoinTree_1">
  <resourceAccessGrants>
    <!-- Row level for Cities -->
    <resourceAccessGrant id="Jointree_1_row_access_grant_20">
      <principalExpression><![CDATA[authentication.principal.attributes.any
        {it.attrName in ['Cities' ]}]></principalExpression>
      <filterExpression>testProfileAttribute(store.store_city,'Cities')
      </filterExpression>
    </resourceAccessGrant>
    <!-- Row level for Product Dept -->
    <resourceAccessGrant id="Jointree_1_row_access_grant_30">
      <principalExpression><![CDATA[authentication.getPrincipal().getAttributes().any
        {it.getAttrName() in ['ProductDepartment' ]}]></principalExpression>
      <filterExpression>testProfileAttribute(product_class.product_department,
        'ProductDepartment')</filterExpression>
    </resourceAccessGrant>
  </resourceAccessGrants>
</resourceAccessGrantList>
```
6.6.2  Column-level Security

Column-level access determines the columns in the data source that can be displayed to specific users.

6.6.2.1  Understanding Column-level Security

Consider a table that includes employee contact and salary information. You could define item group access grants that check the user’s role and grant access to the salary field only if the user has the Human Resources role. For example, the following code sample modifies access for the ROLE_SALESREP role, first by revoking the default access for that role and then granting access to sales information only. The principle expression determines the users to whom the item group access grant applies, that is, users with the ROLE_SALESREP role. The item access grants determine the specific access of the users, that is, all role-specific access is revoked then access to the StoreSales and StoreCost item is granted:

```
<itemGroupAccessGrant id="Jointree_1_item_group_access_grant_2" access="granted">
  <principalExpression>authentication.getPrincipal().getRoles().any
    { it.getRoleName() in ['ROLE_SALES_REP'] } </principalExpression>
  <itemAccessGrantList id="Jointree_1_grant2_item_group_items"
    defaultAccess="denied">
    <itemAccessGrants>
      <itemAccessGrant id="Jointree_1_grant2_items_grant1" itemId="StoreSales"
        access="granted" />
      <itemAccessGrant id="Jointree_1_grant2_items_grant2" itemId="UnitSales"
        access="granted" />
    </itemAccessGrants>
  </itemAccessGrantList>
</itemGroupAccessGrant>
```

6.6.2.2  CZS’s Item Group Access Grants for Sales Data

To ensure that sales representatives don’t have access to cost information, CZS adds item group access grants; the first grants full access to managers and the administrator:

```
<!-- Column-level access for Sales Manager and Admins-->
<itemGroupAccessGrant id="Jointreel_item_group_access_grant_MNG" access="granted">
  <principalExpression>authentication.getPrincipal().getRoles().any
    { it.getRoleName() in ['ROLE_ADMINISTRATOR', 'ROLE_SALES_MANAGER'] } </principalExpression>
</itemGroupAccessGrant>
```
CZS then adds an item group access grant that grants limited access to sales representatives; the following XML grants access to the Store Sales and Sales Units fields while revoking access to the Store Cost field:

```xml
<!-- Column-level access for Sales Reps-->
<itemGroupAccessGrant id="Jointree_1_item_group_access_grant_REPO"
  access="granted">
  <principalExpression>authentication.getPrincipal().getRoles().any
    { it.getRoleName() in ['ROLE_SALES_REPO'] }</principalExpression>
  <itemAccessGrantList id="Jointree_1_grant2_item_group_items"
    defaultAccess="denied">
    <itemAccessGrants>
      <itemAccessGrant id="Jointree_1_grant2_items_grant1" itemId="StoreSales"
        access="granted" />
      <itemAccessGrant id="Jointree_1_grant2_items_grant2" itemId="UnitSales"
        access="granted" />
    </itemAccessGrants>
  </itemAccessGrantList>
</itemGroupAccessGrant>
```

### 6.6.3 Uploading the Security File

CZS uploads the security file each time they add a new access grant. You can upload the security file when you add or edit a Domain.

![Uploaded Security File in the Domain Dialog](image)

### 6.7 Testing and Results

Finally, CZS verifies the Domain as various users by clicking the **Login as User** button on the Manage Users page.

**To test the access granted to users on data in the Domain:**

1. Log in as administrator (**jasperadmin**) if necessary.
2. Click **Manage > Users**.
3. In the list of user names, click the name of the user you want to test.
4. In the User page, click **Log in as User**. The selected user’s Home page appears.
5. Click **View > Reports**.

6. In the list of reports, click the test report you created when defining your security file.

The report appears.

7. Review the report to ensure that it only displays the data this user should see. Also verify that you have not restricted data that the user should be able to view. The figures below show CZS’s results.

8. Click **Logout** to return to the administrator view.

When viewing the test report created from the Sales Domain:

- Rita can see all data pertaining to California and the three Californian cities where CZS has offices (Los Angeles, Sacramento, and San Francisco):

![Figure 6-8 Rita's view of the CZS Test Report](image)

- Pete can only see Television data about San Francisco; he sees zeros for Store Cost because he is denied access to that field:

![Figure 6-9 Pete’s view of the CZS Test Report](image)

- Yasmin can only see Wireless Devices data about San Francisco; she sees zeros for Store Cost because she is denied access to that field:

![Figure 6-10 Yasmin’s view of the CZS Test Report](image)
6.8 Domain and Security Recommendations

When defining a Domain and its security, keep these recommendations in mind:

- A Domain should cover a large subject area and include data with multiple uses. Define joins to create data islands that each contain related information; the data islands themselves can contain completely unrelated data. For example, you could include both human resources and sales data in a single Domain; different users would see only the information relevant to their job responsibilities. For an example of this type of Domain, refer to the SuperMart example that can be installed with JasperReports Server.

- When defining a Domain, don’t create too many item groups, and avoid very deep structures with many levels. Such complexity makes the Domain harder to use.

- Logging can help you troubleshoot any problems you encounter while implementing Domain security. For more information, refer to section 6.5.1, “Enabling Logging,” on page 52.

- Refer to http://groovy.codehaus.org for information on the Groovy expressions that Domain security files support. Note that, while the server does validates Groovy expressions, the validation is very light weight: it doesn’t detect all improperly formed expressions.

- If the names of tables and fields in your data source change, you can edit the Domain design XML file so that the resource names match the new names in the database. Then, upload the new version of the file; your reports that rely on the Domain will work properly without being updated individually. If you have defined a security file for this Domain, you must also edit the resource names in the security file, as well.

- Start with the simplest item or resource grant, and when that works, expand upon it. Start simple and iterate until you have the full set of access grants needed. Follow good troubleshooting practices, such as only changing a single aspect of the security file before testing the results of the change.

- Use an XML editor to create your security file. While the server validates the schema against its own XML definition, a typical XML editor can identify such issues as tags that aren’t properly closed. For example, open the security file with Internet Explorer; if it returns errors, use them to identify and correct your XML.

- Once your Domain is created, create several Domain Topics that focus on specific aspects of the Domain or specific data your end-users will want to review regularly. To do so, click Create > Ad Hoc Report, select your Domain, and use the Data, Filters, and Display pages to customize the contents and the way it is displayed, then use the Topics page to save the new Domain Topic.

For tips on improving the performance of Domains and reports that rely on them, refer to section 2.3.3, “Scalability,” on page 24.
6.9 Reference Material

6.9.1 Domain Design in XML Format

The CZS-sales-Domain.xml file defines a Domain that returns data from the sales_fact_2006 table stored in a MySQL database. It includes the three fields that CZS is interested in displaying, as well as the data that corresponds to the profile attributes described in the security file.

```xml
  <itemGroups>
    <itemGroup description="Product family and department" descriptionId=""
                id="Products" label="Products" labelId="" resourceId="JoinTree_1">
      <items>
        <item description="Family" descriptionId="" id="Family" label="Family"
               labelId="" resourceId="JoinTree_1.product_class.product_family" />
        <item description="Department" descriptionId="" id="Department"
               label="Department" labelId=""
               resourceId="JoinTree_1.product_class.product_department" />
      </items>
    </itemGroup>
    <itemGroup description="Geography" descriptionId="" id="Geography"
                label="Geography" labelId="" resourceId="JoinTree_1">
      <items>
        <item description="City" descriptionId="" id="City" label="City"
               labelId="" resourceId="JoinTree_1.store.store_city" />
        <item description="Country" descriptionId="" id="Country" label="Country"
               labelId="" resourceId="JoinTree_1.store.store_country" />
        <item description="State" descriptionId="" id="State" label="State"
               labelId="" resourceId="JoinTree_1.store.store_state" />
      </items>
    </itemGroup>
    <itemGroup description="Sales Data" descriptionId="" id="SalesData"
                label="Sales Data" labelId="" resourceId="JoinTree_1">
      <items>
        <item description="Store Cost" descriptionId="" id="StoreCost"
               label="Store Cost" labelId="" resourceId="JoinTree_1.sales_fact_2006.store_cost" />
        <item description="Store Sales" descriptionId="" id="StoreSales"
               label="Store Sales" labelId="" resourceId="JoinTree_1.sales_fact_2006.store_sales" />
        <item description="Unit Sales" descriptionId="" id="UnitSales"
               label="Unit Sales" labelId="" resourceId="JoinTree_1.sales_fact_2006.unit_sales" />
      </items>
    </itemGroup>
  </itemGroups>
  <resources>
    <jdbcTable datasourceId="czsdata" id="product" tableName="product">
      <fieldList>
        <field id="brand_name" type="java.lang.String" />
        <field id="gross_weight" type="java.lang.Double" />
        <field id="net_weight" type="java.lang.Double" />
        <field id="product_class_id" type="java.lang.Integer" />
        <field id="product_id" type="java.lang.Integer" />
      </fieldList>
    </jdbcTable>
  </resources>
</schema>
```
<field id="product_name" type="java.lang.String" />
<field id="recyclable_package" type="java.lang.Boolean" />
<field id="shelf_depth" type="java.lang.Double" />
<field id="shelf_height" type="java.lang.Double" />
<field id="shelf_width" type="java.lang.Double" />
<field id="SKU" type="java.lang.Long" />
<field id="SRP" type="java.math.BigDecimal" />
<field id="units_per_case" type="java.lang.Short" />
</fieldList>
</jdbcTable>
</jdbcTable> datasourceId="czsdata" id="product_class" tableName="product_class">
<fieldList>
<field id="product_category" type="java.lang.String" />
<field id="product_class_id" type="java.lang.Integer" />
<field id="product_department" type="java.lang.String" />
<field id="product_family" type="java.lang.String" />
<field id="product_subcategory" type="java.lang.String" />
</fieldList>
</jdbcTable>
</jdbcTable> datasourceId="czsdata" id="product" tableName="product">
<fieldList>
<field id="brand_name" type="java.lang.String" />
<field id="gross_weight" type="java.lang.Double" />
<field id="net_weight" type="java.lang.Double" />
<field id="product_class_id" type="java.lang.Integer" />
<field id="product_id" type="java.lang.Integer" />
<field id="product_name" type="java.lang.String" />
<field id="recyclable_package" type="java.lang.Boolean" />
<field id="shelf_depth" type="java.lang.Double" />
<field id="shelf_height" type="java.lang.Double" />
<field id="shelf_width" type="java.lang.Double" />
<field id="SKU" type="java.lang.Long" />
<field id="SRP" type="java.math.BigDecimal" />
<field id="units_per_case" type="java.lang.Short" />
</fieldList>
</jdbcTable>
</jdbcTable> datasourceId="czsdata" id="sales_fact_2006" tableName="sales_fact_2006">
<fieldList>
<field id="customer_id" type="java.lang.Integer" />
<field id="product_id" type="java.lang.Integer" />
<field id="promotion_id" type="java.lang.Integer" />
<field id="store_cost" type="java.math.BigDecimal" />
<field id="store_id" type="java.lang.Integer" />
<field id="store_sales" type="java.math.BigDecimal" />
<field id="time_id" type="java.lang.Integer" />
<field id="unit_sales" type="java.math.BigDecimal" />
</fieldList>
</jdbcTable>
<jdbcTable datasourceId="czsdata" id="store" tableName="store">
  <fieldList>
    <field id="coffee_bar" type="java.lang.Boolean" />
    <field id="first_opened_date" type="java.sql.Timestamp" />
    <field id="last_remodel_date" type="java.sql.Timestamp" />
    <field id="region_id" type="java.lang.Integer" />
    <field id="store_city" type="java.lang.String" />
    <field id="store_country" type="java.lang.String" />
    <field id="store_fax" type="java.lang.String" />
    <field id="store_id" type="java.lang.Integer" />
    <field id="store_manager" type="java.lang.String" />
    <field id="store_name" type="java.lang.String" />
    <field id="store_number" type="java.lang.Integer" />
    <field id="store_phone" type="java.lang.String" />
    <field id="store_postal_code" type="java.lang.String" />
    <field id="store_sqft" type="java.lang.Integer" />
    <field id="store_state" type="java.lang.String" />
    <field id="store_street_address" type="java.lang.String" />
    <field id="store_type" type="java.lang.String" />
    <field id="video_store" type="java.lang.Boolean" />
  </fieldList>
</jdbcTable>

<jdbcTable datasourceId="czsdata" id="JoinTree_1" tableName="product">
  <fieldList>
    <field id="product_class.product_category" type="java.lang.String" />
    <field id="product_class.product_class_id" type="java.lang.Integer" />
    <field id="product_class.product_department" type="java.lang.String" />
    <field id="product_class.product_family" type="java.lang.String" />
    <field id="product_class.product_subcategory" type="java.lang.String" />
    <field id="sales_fact_2006.customer_id" type="java.lang.Integer" />
    <field id="sales_fact_2006.product_id" type="java.lang.Integer" />
    <field id="sales_fact_2006.promotion_id" type="java.lang.Integer" />
    <field id="sales_fact_2006.store_cost" type="java.math.BigDecimal" />
    <field id="sales_fact_2006.store_id" type="java.lang.Integer" />
    <field id="sales_fact_2006.store_sales" type="java.math.BigDecimal" />
    <field id="sales_fact_2006.time_id" type="java.lang.Integer" />
    <field id="sales_fact_2006.unit_sales" type="java.math.BigDecimal" />
    <field id="product.brand_name" type="java.lang.String" />
    <field id="product.gross_weight" type="java.lang.Double" />
    <field id="product.net_weight" type="java.lang.Double" />
    <field id="product.product_class_id" type="java.lang.Integer" />
    <field id="product.product_id" type="java.lang.Integer" />
    <field id="product.product_name" type="java.lang.String" />
    <field id="product.recyclable_package" type="java.lang.Boolean" />
    <field id="product.shelf_depth" type="java.lang.Double" />
    <field id="product.shelf_height" type="java.lang.Double" />
    <field id="product.shelf_width" type="java.lang.Double" />
    <field id="product.SKU" type="java.lang.Long" />
  </fieldList>
</jdbcTable>
6.9.2 Domain Security File

The CZS-sales-security.xml file is based on the CZS-sales-domain.xml Domain design file, and defines access for users with Cities and ProductDepartment profile attributes.
<securityDefinition xmlns="http://www.jaspersoft.com/2007/SL/XMLSchema" version="1.0"
itemGroupDefaultAccess="granted">
<resourceAccessGrants>
  <!-- Row level security -->
  <!-- What access do roles/users have to the rows in the resource? -->
  <resourceAccessGrantList id="JoinTree_1_List" label="ListLabel"
    resourceId="JoinTree_1">
    <resourceAccessGrants>
      <!-- Row level for Cities -->
      <resourceAccessGrant id="Jointree_1_row_access_grant_20">
        <principalExpression><![CDATA[authentication.principal.attributes.any
          {it.attrName in ['Cities']]}]]></principalExpression>
        <filterExpression>testProfileAttribute(store.store_city,'Cities')</filterExpression>
      </resourceAccessGrant>
      <!-- Row level for Product Dept -->
      <resourceAccessGrant id="Jointree_1_row_access_grant_30">
        <principalExpression><![CDATA[authentication.getPrincipal().getAttributes().any
          {it.getAttrName() in ['ProductDepartment']}]></principalExpression>
        <filterExpression>testProfileAttribute(product_class.product_department,
          'ProductDepartment')</filterExpression>
      </resourceAccessGrant>
    </resourceAccessGrants>
  </resourceAccessGrantList>
</resourceAccessGrants>
</securityDefinition>
<!-- Column level for sales reps -->
<itemGroupAccessGrant id="Jointree_1_item_group_access_grant_2"
  access="granted">
  <principalExpression>authentication.getPrincipal().getRoles().any
  { it.getRoleName() in ['ROLE_SALES_REP'] } </principalExpression>
  <itemAccessGrantList id="Jointree_1_grant2_item_group_items"
    defaultAccess="denied">
    <itemAccessGrants>
      <itemAccessGrant id="Jointree_1_grant2_items_grant1" itemId="StoreSales"
        access="granted" />
      <itemAccessGrant id="Jointree_1_grant2_items_grant2" itemId="UnitSales"
        access="granted" />
    </itemAccessGrants>
  </itemAccessGrantList>
</itemGroupAccessGrant>
</itemGroupAccessGrantList>
</itemGroupAccessGrants>
</securityDefinition>
CHAPTER 7 ACCESS CONTROL

In JasperReports Server, access control is determined by two separate mechanisms, authentication and authorization. Authentication is the process of verifying user credentials to give access to the server. Authorization is the process of checking permissions granted to users and roles to access resources within the server. More generally, authentication determines who can access JasperReports Server, and authorization determines what they see.

For example, a user might bookmark the repository page; if the user’s session has timed out when he clicks the bookmark, the server prompts for the login name and password. The authentication mechanism compares these to the existing user accounts and if a match is found, the user is logged in and redirected to the repository page. The user session includes any roles stored in the user account, and these roles are processed by the authorization mechanism to determine what the user is allowed to see in the repository. Roles determine much of what users see, including the menu options, pages, folders, reports, repository objects, and even the data they can view.

This chapter contains the following sections:
- Authentication
- Authorization
- Authorization Example

7.1 Authentication

To perform authentication, JasperReports Server integrates Spring Security, part of the Spring framework. Spring is an open source security solution for assembling J2EE components by way of configuration files. This section describes how Spring Security performs authentication, its default behavior, and some options you have for customizing it.

The default configuration of Spring Security represents the most common use cases, but Spring Security’s flexibility can provide you with very fine-grained control of the security system. However, since Spring Security can be configured in so many ways, you may find its configuration daunting. This section is only meant as an introduction to get you started in thinking about customizing JasperReports Server’s security system. Refer to section 7.1.3, “Further Documentation,” on page 67 for more information.

7.1.1 Spring Security Filter Chain

The main entry point for authentication in Spring Security is the securityFilter, which is configured in WEB-INF/web.xml. As with all J2EE servlet filters, the securityFilter is invoked for every HTTP request for paths in this web application, whether the request comes from users or automated agents. The securityFilter is essentially a proxy for Spring Security’s FilterChainProxy class, which handles the actual logic that performs authentication. In JasperReports Server, this class is instantiated as a Spring bean defined in the WEB-INF/applicationContext-security.xml file. For
implementations with security requirements that differ from the default behavior, the FilterChainProxy can be configured to support other authentication schemes. Finally, Spring Security allows the server to accept authentication from an external authentication mechanism.

The `filterChainProxy` bean determines how the server enforces authentication on its web pages:

```xml
<bean id="filterChainProxy" class="org.springframework.security.util.FilterChainProxy">
  <property name="filterInvocationDefinitionSource">
    <value>
      CONVERT_URL_TO_LOWERCASE_BEFORE_COMPARISON
      PATTERN_TYPE_APACHE_ANT
      /xmla=httpSessionContextIntegrationFilter,basicProcessingFilter,
      JIAuthenticationSynchronizer,anonymousProcessingFilter,
      basicAuthExceptionTranslationFilter,filterInvocationInterceptor
      /services/**=httpSessionContextIntegrationFilter,basicProcessingFilter,
      JIAuthenticationSynchronizer,anonymousProcessingFilter,
      basicAuthExceptionTranslationFilter,filterInvocationInterceptor
      /**=httpSessionContextIntegrationFilter,authenticationProcessingFilter,
      basicProcessingFilter,JIAuthenticationSynchronizer,anonymousProcessingFilter,
      exceptionTranslationFilter,filterInvocationInterceptor
    </value>
  </property>
</bean>
```

Each expression has the format `URI_pattern=filter1,filter2,...` so that a list of processing filters is defined for any URI exposed by the server. Each filter is given the request and response context and has a chance to take action before control is passed to the next filter. You can even define and add your own filter if you need to implement a custom authentication schema, although the packaged options are sufficient in almost every case.

You’ll notice that the `/xmla` and `/services/**` expressions are configured with one set of filters, while all other URLs have a different set of filters. The expressions are configured this way because the first two (that represent the XML for Analysis servlet and the web services, respectively) are designed to receive SOAP and REST requests from other servers, while all other server URLs are designed for humans using web browsers; for example, only humans are asked to proceed to the login page.

The filter beans have the following functions:

- `httpSessionContextIntegrationFilter` – Stores the SecurityContext in the HttpSession.
- `authenticationProcessingFilter` – Redirects browsers to the login page, then handles the username and password credentials entered by the user.
- `basicProcessingFilter` – Handles HTTP BASIC style authentication, where the username and password are passed as an HTTP header.
- `JIAuthenticationSynchronizer` – Notifies JasperReports Server which user has logged in; this is not a standard Spring Security class.
- `anonymousProcessingFilter` – Marks the user as anonymous if no other authentication occurred.
- `exceptionTranslationFilter` – Sets a 403 Forbidden HTTP response code if the user is not authenticated to view the requested page.
- `filterInvocationInterceptor` – Integrates the filter chain with other Spring Security components.

The `flowVoter` bean in the `<js-webapp>/WEB-INF/applicationContext-security.xml` file controls access to individual web pages and flows based on user authentication and roles. See 11.8, “Working With Source Code Files,” on page 167 for more information.
7.1.2 Authentication Processing Filter

As seen in the previous section, a request for JasperReports Server pages from a user is processed through the filterChainProxy where it is handled by the authenticationProcessingFilter. This filter gathers the user’s credentials from the login page and processes them with the authenticationManager bean.

The authenticationManager bean is configured with a list of authentication providers who can verify the credentials. The default configuration is as follows:

```xml
<bean id="authenticationManager"
     class="org.springframework.security.providers.ProviderManager">
   <property name="providers">
     <list>
       <ref local="daoAuthenticationProvider"/>
       <ref local="anonymousAuthenticationProvider"/>
     </list>
   </property>
</bean>
```

The property list includes the following:
- `daoAuthenticationProvider` – Compares the username and password (passed from the login form) to those stored in the server’s private database. This is the default form of authentication.
- `anonymousAuthenticationProvider` – Grants anonymous access to the login page itself.

If you use a Lightweight Directory Access Protocol (LDAP) directory, you can configure an LDAP provider bean by adding it to the list of providers in the authenticationManager bean. The LDAP provider bean must be of the class `org.springframework.security.providers.ldap.LdapAuthenticationProvider`.

When JasperReports Server uses an external authentication service such as LDAP, JIAuthenticationSynchronizer ensures that any user that is authenticated successfully is created if she does not already exist in the server. Roles defined in the external authentication service are also created if they do not exist in the server. To grant access to users, these roles must be associated with repository resources, such as reports and analysis views.

Assuming the credentials are valid, the daoAuthenticationProvider finds a match in the user database and creates the user session under the given username. It also reads the roles from the user account information and stores them in the user session. The combination of username and assigned roles can then be used by authorization mechanism every time the user requests access to a resource, such as a report, in the repository.

7.1.3 Further Documentation

For more background on how Spring Security works and can be configured, including extensions for external authorization and single sign-on, refer to the following documents:
- *JasperReports Server External Authentication Cookbook*
- *Spring Security Reference Documentation*
- Spring Web Flow 2.0 has quite different syntax for flow files than previous versions, so if a user has custom flow, it needs to be upgraded. Spring offers a special tool, WebFlowUpgrader, which helps to upgrade the flows. For more information, see the *Spring Security chapter on upgrading from 1.0*.

7.2 Authorization

In JasperReports Server, all resources are stored in the repository in a hierarchical structure of folders. Each resource in the repository has a set of permissions explicitly granting certain kinds of access. Folders also have permissions, and all contents of a folder inherit these permissions if they do not explicitly define their own. Often, many resources need the same permissions, and therefore it is easier to manage permissions on folders.
Permissions can grant access to users or to roles. Roles are groups of users created for the purpose of simplifying authorization. Often, it is easier to manage permissions for groups of users, and then manage role membership separately. However, if necessary, permissions can be granted to specific users.

The following sections describe how users, roles, and repository objects interact in the authorization mechanism. Section 7.3, “Authorization Example,” on page 72 demonstrates how these entities are created and modified, and how authorization works in practice. For procedural documentation about managing user, roles, and repository objects, see the JasperReports Server Administrator Guide.

7.2.1 Repository Design for Access Control

The repository is the main storage facility for resources in JasperReports Server. Resources are represented as objects in the repository, contained in folders. Folders give structure to the repository and let you organize your resources in a logical manner. Folders can be nested to any level to support any organization of resources. The following section provides some guidelines for designing your repository.

Access control and the organization of the repository are inter-dependent. It is important to understand their interactions before you configure them.

Approach configuration of the repository and its access control with the following guidelines in mind:

- Determine how best to organize the repository. Define folders to group the repository objects that require similar permissions. This simplifies access control maintenance. A straight-forward repository organization also encourages reuse of report units and resources.
- Abstract out the similarities of your users to create roles that can be combined to grant the required level of access.
- Revisit the repository organization scheme you originally devised and modify it according to your findings regarding your role requirements.
- Create the roles for the permissions you determined were needed, then create the folders of the repository.
- Populate the repository with the report units and resources that define your reports.
- Set the role-level permissions for each folder, and in special cases, for report units and resources. You may also want to specify user-level access in some cases, as well.
- Test your access control model by logging into the server as various users with different roles using Login as User. Correct any problems you find.
- As new objects are added to the repository, be sure to define their permissions.
- When you add new roles, be sure to restrict the access they grant before assigning them to users.
- If your instance hosts multiple organizations, edit the Template Folder to include the resources each organization should have. Take this step before adding your additional organizations, so that they are populated with the correct resources.
- As your repository grows, delete report units and resources that are no longer in use. If you organize your repository to maximize reuse, you may not need to clean up your repository often.

7.2.2 Roles

Roles are a mechanism for grouping users for the purpose of assigning permissions in bulk. Administrators assign roles to each user, and permissions in the repository name the roles to which they grant access.

When you define your roles, start by defining one role for each unique type of user in your enterprise. For example, you might have roles for administrators, DBAs, developers, accountants, executives, and other end users. Once you determine the various sets of rights you need to define, you can sometimes compare them and abstract out sub-sets of permissions. Then assign each user a set of roles to provide the exact level of access needed. This approach simplifies the maintenance of access control.

Consider an example in which there are three different user types: users that can view revenue reports, users that can view cost reports, and users that can view both. You could define two roles: Role A, which is granted access to revenue reports, and Role B, which is granted access to cost reports. Users who only need to view revenue reports would be assigned Role A, users who need to view cost reports would be assigned Role B, and users who need to view both revenue and cost reports would be granted both roles.

If a user is assigned roles in which access rights conflict, access is granted. For example, consider a user with two roles: one role revokes access to view revenue reports and the other grants that same access. The user would have access to the revenue reports.
If a user does not have a role, he cannot log in; a user must at least have ROLE_USER, ROLE_ADMINISTRATOR, or ROLE_SUPERUSER in order to access the repository. JasperReports Server has the following default roles:

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROLE_ADMINISTRATOR</td>
<td>This role grants all object-level access, as well as granting access to the administrator home page and the Manage menu (except for the Ad Hoc Settings and Analysis Settings). This role is automatically granted to the jasperadmin user (who administers each organization) and superuser.</td>
</tr>
<tr>
<td>ROLE_ANONYMOUS</td>
<td>This modifiable role is automatically granted to the anonymoususer user, and to any agent accessing the server without logging in; by default it only grants access to the login page.</td>
</tr>
<tr>
<td>ROLE_DEMO</td>
<td>This role grants access to the SuperMart demo Home page, sample reports, and, if you have Jaspersoft OLAP, sample analysis views. These objects are available only if you installed the sample data when you installed JasperReports Server.</td>
</tr>
<tr>
<td>ROLE_ETL_ADMIN</td>
<td>This role was included in previous versions of the server to support integration with Talend Information Suite Enterprise Edition (TIS EE). It only appears if you have upgraded from a version of the server earlier than 3.1 (then called JasperServer). ROLE_ETL_ADMIN enables users of the commercial editions to access the Talend Integration Suite Enterprise Edition (TIS EE) administrator’s login page (on the Home page, click Manage &gt; JasperETL). The command appears only for users who have the ETL administrator role. For details, see the JasperReports Server Administrator Guide.</td>
</tr>
<tr>
<td>ROLE_PORTLET</td>
<td>This role is assigned to users who are created automatically by the server when a portal such as Liferay contacts it with an authentication request. If the specified user name does not exist in the server, it is created, assigned the password of the user in the portal, and given ROLE_PORTLET and ROLE_USER.</td>
</tr>
<tr>
<td>ROLE_SUPERMART_MANAGER</td>
<td>This role manages permissions for the sample data. It demonstrates data security features available in commercial editions of JasperReports Server.</td>
</tr>
<tr>
<td>ROLE_SUPERUSER</td>
<td>This role grants all object-level access, as well as granting access to the administrator Home page and the Manage menu, including the Ad Hoc Settings and Analysis Settings. This role is automatically granted to the superuser (who administers the entire system).</td>
</tr>
<tr>
<td>ROLE_USER</td>
<td>Every non-administrator user that logs into the server must have this role. This role is automatically granted to every new user.</td>
</tr>
</tbody>
</table>

* JasperReports Server commercial editions only.

For more information about creating and assigning roles, refer to the JasperReports Server Administrator Guide.

### 7.2.3 Users

Everyone who accesses JasperReports Server needs a user account that defines his online session. Administrators assign roles to user accounts to determine their access to data and functionality. By default, the server contains the following users:

<table>
<thead>
<tr>
<th>User Name (Default Password)</th>
<th>Default Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>anonymousUser (none)</td>
<td>ROLE_ANONYMOUS</td>
<td>Special end user; included in minimal server setup. By default, this user cannot log in.</td>
</tr>
<tr>
<td>CaliforniaUser* (CaliforniaUser)</td>
<td>ROLE_USER ROLE_SUPERMART_MANAGER*</td>
<td>Special end user; included in sample data.</td>
</tr>
</tbody>
</table>
### 7.2.4 Assigning Permissions

Every repository object and folder either defines or inherits a permission for every role and every user. The permission determines the level of access that is granted to the members of the role or directly to the user.

Permissions are set by administrators through the repository interface. For example, the following two figures show the interface to view and set permissions on a folder. You can set a separate permission for each role and for each user. If no permission is defined explicitly, the permission inherited from the enclosing folder applies:

![Figure 7-1 Example of Viewing Permissions on a Folder](image)

<table>
<thead>
<tr>
<th>User Name (Default Password)</th>
<th>Default Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>demo (demo)</td>
<td>ROLE_USER</td>
<td>Special end user; included in sample data.</td>
</tr>
<tr>
<td>jasperadmin (jasperadmin)</td>
<td>ROLE_ADMINISTRATOR ROLE_USER</td>
<td>Administrator user, or organization admin; included in minimal server setup.</td>
</tr>
<tr>
<td>joeuser (joeuser)</td>
<td>ROLE_USER</td>
<td>Standard end user; included in sample data.</td>
</tr>
<tr>
<td>superuser (superuser)</td>
<td>ROLE_SUPERUSER ROLE_ADMINISTRATOR</td>
<td>Special system administrator user.</td>
</tr>
</tbody>
</table>

* JasperReports Server commercial editions only.

---

User Name (Default Password) | Default Roles | Description |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>demo (demo)</td>
<td>ROLE_USER</td>
<td>Special end user; included in sample data.</td>
</tr>
<tr>
<td>jasperadmin (jasperadmin)</td>
<td>ROLE_ADMINISTRATOR ROLE_USER</td>
<td>Administrator user, or organization admin; included in minimal server setup.</td>
</tr>
<tr>
<td>joeuser (joeuser)</td>
<td>ROLE_USER</td>
<td>Standard end user; included in sample data.</td>
</tr>
<tr>
<td>superuser (superuser)</td>
<td>ROLE_SUPERUSER ROLE_ADMINISTRATOR</td>
<td>Special system administrator user.</td>
</tr>
</tbody>
</table>

* JasperReports Server commercial editions only.
A permission that appears with an asterisk (*) is inherited from its parent folder, which may in turn be inherited from a higher folder. Permissions that are greyed out cannot be modified, for example the administrator cannot remove his own access to a file (otherwise it would become impossible to manage). Possible permissions are the same for roles as for users and include:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Access</td>
<td>Users or roles with this permission cannot see or access this resource.</td>
</tr>
<tr>
<td>Execute Only</td>
<td>Users or roles with this permission cannot see this resource, but they may run a report that accesses the resource.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Users or roles with this permission can read but not update or delete the resource.</td>
</tr>
<tr>
<td>Delete + Read</td>
<td>Users or roles with this permission can delete and read the resource.</td>
</tr>
<tr>
<td>Write + Delete + Read</td>
<td>Users or roles with this permission can update, read, and delete the resource.</td>
</tr>
<tr>
<td>Administer</td>
<td>Users or roles with this permission can change the permissions defined for this resource, as well as read, update, and delete it.</td>
</tr>
</tbody>
</table>

Through a combination of role-based permissions and explicit user-based permissions, a user can have several permissions defined for a single resource. In this case, the most permissive is granted to the user. For example, if a user belongs to a role that has Read Only access to a folder, but the user has also specifically been granted Write+Delete+Read permission, the person has Write+Delete+Read access to the resource.

For security purposes, when a new user or role is added, its permission at the root of the repository is No Access, which is thus inherited on every folder and object. You must explicitly grant the user or role access to folders or resources by setting their permissions in the repository.

### 7.2.5 Design Recommendations

Before you define access control for JasperReports Server, consider these tips:

- If you plan to have a large number of objects in the repository, model your roles and repository organization on paper before configuring them in the server. It’s helpful to refer to a visual representation of the access control model when you create it.
- Map your roles along meaningful lines that will be easy to apply to new objects. Job functions within your company can provide some guidance; for example, you may want to create a separate role that provides access to financial reports that should only be available to your Accounting department. By granting this role view permissions on the appropriate reports and assigning it to your accounting users, you create an easily-extensible organization: new Accounting users will be assigned this role, and new accounting report units and resources will grant view permissions to the role.
Create folders to group reports that have similar access requirements, then grant access at the folder level. This simplifies maintenance and gives you default locations for additional reports in the future.

Take a business-oriented approach to access control, and ensure that users’ level of access is based on their job functions.

Choose a repository organizing principle that makes sense for your application and business model. The obvious choice is often best, as it is usually the most intuitive for your users.

The relationships between objects in the repository and the roles you define determine the level of access your users have. When modeling access control, focus on these relationships.

Remember that your repository and access control model will evolve through system usage. A straight-forward repository organization scheme is easier to maintain and extend.

Abstract out common privileges between user types and create roles that can be combined to grant the proper access to each user.

Do not over-complicate your object permissions and roles. You can create a very complicated access model using very simple roles and assigning each user complimentary roles. The simpler your roles and the fewer object-level customizations you make, the easier it will be to troubleshoot and maintain access control. Note that there is a trade-off to consider, as well: having a large number of very simple roles can be cumbersome to maintain. Strike a balance between simplicity of role permissions and proliferation of roles.

The majority of your access control model should be implemented through roles. Ensure that the roles you define will generally grant your users the correct permissions.

Minimize the need for customization and use inheritance to your advantage by defining access for your top-level folders that is sensible for the majority of the repository. Setting most of your object’s access to None Defined will then define sensible access throughout the repository. Then customize the objects that cannot use the inherited set of permissions.

If you must define user-level access control on objects, do so sparingly. While such customizations shouldn’t impact performance, their maintenance may be tedious and prone to errors.

When you create a new role, you must manually grant access to any folders and objects that users with the new role should see.

Don’t customize the access granted to ROLE_USER, unless the change should apply to every one of your users. While the server properly enforces whatever access you define for this role, your maintenance will be easier if you create new roles to augment the ROLE_USER role rather than directly editing ROLE_USER.

When you add a new object or folder, it inherits the access control policies of its parent folder. Be sure that the inherited privileges are reasonable and necessary for the new object, and change them if they aren’t.

7.3 Authorization Example

The example presented in this section can help you understand the authorization mechanism in JasperReports Server. It describes a simplified repository structure, users, roles, and objects for a fictitious company called MyCompany.

This example does not explain data-level authorization. For an example of securing the data returned by Domains, refer to Chapter 6, “Securing Data in a Domain,” on page 47. For an example of securing the data returned by an analysis view, refer to the Jaspersoft OLAP Ultimate Guide.

If you’d like to follow along in your own test installation of JasperReports Server, you can download and import a ZIP file that includes the example’s users, roles, and objects. The reports in the example use sample data that is optional when installing the server. You do not need the sample data to demonstrate authorization.

7.3.1 Downloading and Importing the Authorization Example

The example is available in a ZIP archive called js-authorizations-example-<ver>.zip that can be downloaded from one of two locations:

- From the releases page on http://community.jaspersoft.com.
The version of the zip is currently 3.5, but it has also been verified to work with later versions of JasperReports Server. The following procedure describes how to import the ZIP file’s contents using the command-line import utility.

To import the example:
1. JasperReports Server can be running or stopped when using the import utility. If it is running, you do not need to stop it, you can import resources on the fly.
2. Copy the js-authorization-example.zip to a temporary location on your JasperReports Server host computer.
   For simplicity, the following steps assume that you saved the file directly in the <js-install>/buildomatic directory where the import utility is located.
3. At the command line, change directories to the location of the import utility. For example:
   - Windows: cd "C:\Program Files\jasperserver[-pro]-<ver>\buildomatic"
   - Linux: cd /home/<user>/jasperserver[-pro]-<ver>/buildomatic
4. Run the import command, and specify the example ZIP. For example:
   - Windows: js-import.bat --input-zip js-authorization-example.zip
   - Linux: js-import.sh --input-zip js-authorization-example.zip

   The import command lists the roles, users, folders, and resources that were successfully imported. It may return warning messages; you can ignore them. Unless the import utility returns errors, your repository now includes the example objects.

Refer to the JasperReports Server Administrator Guide for information on running the import utility.

7.3.2 Understanding the Example

MyCompany represents a fictional company with a set of users organized into departments; users in most departments cannot view other departments’ reports:
- Sales users can only view Sales reports.
- Shipping users can only view Shipping reports.
- Accounting oversees the other departments, so its users can view all reports in any department.

Let’s look at the general structure of the example, and see whether MyCompany’s authorization requirements are met.

To review the example:
1. If the server isn’t running, start it, and login as jasperadmin; the default password is jasperadmin.
2. Click View > Repository and expand the folders to see the contents of the new /Reports/MyCompany folder.

   Since you are logged in as the administrator, you can view everything in the default organization. The My Company folder contains a separate folder for each department:
3. Click **Manage > Roles** to view the roles that are defined at MyCompany:

![Roles](image)

**Figure 7-4  My Company Example Roles**

In commercial editions, The MyCompany roles are defined in the default organization, which has the ID organization_1. In addition to the default roles, MyCompany has defined a role for each department: ROLE_ACCOUNTING, ROLE_SALES, and ROLE_SHIPPING.

4. Click **Manage > Users** to see the users defined at MyCompany.

![Users](image)

**Figure 7-5  My Company Example Users**

In addition to the default users, MyCompany has six users, two per department. In this example, the users’ first name is their user ID and their last name indicates their department, for example Sally Accounting works in the Accounting department.

Now you can test the permissions by logging in as each user to see the folders they can access.

5. Click Xiang’s user name and click **Login as User**.

The login name at the top-right shows that you are logged in as “jasperadmin as Xiang Sales.” You can now see the JasperReports Server and its repository as the user Xiang would see it, including all permissions and restrictions.

6. Click **View > Repository**, expand the /Reports/My Company folder, and select the Sales Department Folder.
Xiang is a member of the Sales department and has ROLE_SALES. The permissions only allow him to see the Sales Department folder and view the three sales reports it contains.

When you run the reports in this example, they all produce the same output. This example demonstrates only access permissions, and the reports are not meant to represent actual sales, shipping, or accounting reports.

7. Click Logout to return to the administrator’s account.
8. Select Friedrich among the users and click Login as User.
9. Click View > Repository, expand the /Reports/My Company folder again, and select the Shipping Department Folder.

Friedrich is a member of the Shipping department and has ROLE_SHIPPING. He can only see the Shipping department folder and view the three shipping reports it contains.

10. Click Logout to return to the administrator’s account again.
11. Finally, select Sally among the users and click Login as User.
12. Click **View > Repository**, expand the /Reports/My Company folder, and select the Accounting Department Folder.

![Diagram of the repository structure showing the Accounting Department Folder]

**Figure 7-8 Sally Can See All Three Department Folders**

Sally is a member of the Accounting department and has ROLE_ACCOUNTING. The permissions allow her to see all three example folders: her own department folder (Accounting) as well as those of the Sales and Shipping departments. She can run any report in any of these folders.

13. Click **Logout** to return to the administrator’s account again.

Let’s look at the user accounts, roles, and folders in this example to understand how they are set up.

14. Click **Manage > Roles** and select ROLE_ACCOUNTING.

![Diagram showing the roles and users]

**Figure 7-9 ROLE_ACCOUNTING Users**

Krishnan and Sally, both from Accounting, have this role. Hovering over their names gives a tool tip with their full name and organization. This role assignment defines the two users as members of the Accounting department and gives them all the permissions assigned to ROLE_ACCOUNTING.

15. Click **View > Repository** and expand the /Reports/My Company folder to see the department folders.
16. Right-click the Accounting Department Folder and select Permissions... from the context menu.

![Permissions for My Company Accounting Folders](image)

For the Accounting Department Folder, most roles are set to No Access. However, the ROLE_ACCOUNTING role is set to Read Only, which explains why Sally could see this folder but the users in the other departments could not.

17. Click Cancel, then right-click the Sales Department Folder, and select Permissions... from the context menu.

![Permissions for My Company Sales Folders](image)

The Sales Department Folder gives read permission to both ROLE_SALES and ROLE_ACCOUNTING. This explains why Sally could also see the sales reports but Friedrich in shipping could not.

In both cases, administrators automatically have access as well, which is why the folders are also visible in this procedure when logged in as jasperadmin.

### 7.3.3 Modifying the Example

As in many authorization cases, the My Company example focuses on folder permissions. Because of inherited permissions, all reports in the example folders are secured with the same policy as the folder itself, so you can define the access policy once on the folder and avoid managing permissions for each individual report.

In this section, you’ll create a user with unique authorization requirements. A new employee in the Shipping department needs special access to Sales data, as well as the usual access to reports in his own department.
Since the new user is the only one in the company with this unique need, it doesn’t make sense to modify an existing role or create a new one. Instead, you’ll assign the user to the Shipping role, and grant him the additional permissions he needs. However, unlike the other permissions in this example, he will not have access to a whole folder, but only the specific report he needs.

To modify the example with a special Shipping user:
1. Login as jasperadmin.
2. Click Manage > Users and click Add User...
3. Enter the user information as shown in Figure 7-12 below:
   - User name: Giovanni Shipping.
   - User ID: automatically filled in from the user name, but edit this to Giovanni.
   - Email: leave blank.
   - Password and confirmation: use any value.
   - Leave User is enabled checked.

![Figure 7-12 New User Defined in the My Company Example](image)

4. Click Add User to organization_1.
   Giovanni appears in the list of users on the users page. Let’s assign him to the Shipping department by assigning the corresponding role to him.
5. Select Giovanni and click Edit.
6. In the list of Roles Available, double click ROLE_SHIPPING to assign it to Giovanni.
7. Click Save in the user properties to save the new role assignment.
   From the current permissions on the department folders, you can see that Giovanni, like Friedrich, can now access the Shipping Department Folder and all the reports it contains. But Giovanni also needs special access to sales data for the southern region.
8. Click View > Repository, expand the /Reports/My Company folder, and select the Sales Department Folder.
9. In the right-hand list of resources, right-click the South Region Sales Report and select Permissions... from the context menu. The Assign Permissions by Role page appears. Notice that ROLE_SHIPPING has no access to this report.
10. Click **User** near the top of the permissions dialog and set Giovanni’s permission to Read-only.

![Permissions Dialog]

**Figure 7-13  Assign Permissions by User on a My Company Example Report**

Remember that permissions are additive, so Giovanni will have access based on this permission by user, even if he is not granted access by his roles.

11. Click **Apply** then **OK** to save your changes and return to the repository.

12. Click **Manage > Users**, click Giovanni’s name, and click **Login as User**.

13. Click **View > Repository** and expand the /Reports/My Company folder.

   You did not change the permissions on the Sales Department Folder, so Giovanni cannot see that folder or its contents. To find the sales report that he has access to, Giovanni must search the repository.

14. Enter **south** in the search field at the top of the page and click the search icon.

   A search applies to all resources in the repository, regardless of the permission on the folders. As shown in the following figure, Giovanni has permission to view and run the South Region Sales Report, even though he cannot browse the Sales Department Folder.

![Search Results](image)

**Figure 7-14  My Company Example User With Special Permissions**

This example shows how easy it is to set up permissions to protect reports on the basis of roles and folder permissions. It also shows that you can just as easily change permissions to handle special access cases on a per-user basis, a per-resource basis, or both.
CHAPTER 8 APPLICATION SECURITY

Application security protects the JasperReports Server web application from unwarranted changes, malicious intrusions, and malware. This chapter explains measures you can take in order to provide such protection on the Tomcat server. These measures do not offer 100% protection—no measures can guarantee that except possibly pulling the plug—but they do create an acceptable level of protection, and they are a foundation upon which more thorough measures can be built.

The JasperReports Server Administrator Guide contains important information about configuration settings for security. Apply those security settings to the server before applying the following settings to the application server.

What follows is not a complete tutorial on securing your web application. To do so would take volumes. Instead, we have written instructions on the basic components of a secure Tomcat environment; we also added related code in the default installation. These additions demonstrate the basic procedures you should follow, but you may have to adapt the procedures to your installation.

The tutorials assume the following system configuration:
- JasperReports Server 4.1
- JDK 1.6.0.18
- Apache Tomcat 6.0.26
- Web App Deployed Name: jasperserver

For more information on the components of a secure environment, see the OpenSSL web site and the Java documentation.

The chapter includes the following sections:
- Using SSL in the Web Server
- Disabling Unused HTTP Verbs
- Setting the Secure Flag on Cookies
- Setting httpOnly for Cookies
- Using a Protection Domain Infrastructure
- Encrypting Passwords in URLs
- Final Note

8.1 Using SSL in the Web Server

Secure Sockets Layer (SSL) is a widely-used protocol for secure network communications. It encrypts network connections at the Transport Layer and is used in conjunction with HTTPS, the secure version of the HTTP protocol.
This section shows how to install SSL on Tomcat 6.0 and to configure JasperReports Server to use only SSL in Tomcat:

1. Setting Up an SSL Certificate
2. Enabling SSL in the Web Server
3. Configuring JasperReports Server to Use Only SSL

8.1.1 Setting Up an SSL Certificate

To use SSL, you need a valid certificate in the Tomcat keystore. In the Java Virtual Machine (JVM), certificates and private keys are saved in a keystore. This is the repository for your keys and certificates. By default, it is implemented as a password-protected file (public keys and certificates are stored elsewhere).

If you already have a suitable certificate, you can import it into the keystore, using the import switch on the JVM keytool utility. If you don't have a certificate, you can use the keytool utility to generate a self-signed certificate (one signed by your own certificate authority). Self-signed certificates are acceptable in most cases, although certificates issued by certificate authorities are even more secure. And they do not require your users to respond to a security warning every time they login, as self-signed certificates do.

The following command is an example of how to import a certificate. In this case, it is a self-signed certificate imported into a PKCS12 keystore using OpenSSL:

```
openssl pkcs12 \-export \-in mycert.crt \-inkey mykey.key \-out mycert.p12
 \-name tomcat \-CAfile myCA.crt \-caname root \-chain
```

Next in this example, you create key.bin, the keystore file, in the Tomcat home folder. Use one of these commands:

<table>
<thead>
<tr>
<th>OS</th>
<th>Command</th>
</tr>
</thead>
</table>
| Windows| `%JAVA_HOME%\bin\keytool -genkey -alias tomcat -keyalg RSA -keystore
%CATALINA_HOME%\conf\key.bin` |
| Unix   | `$JAVA_HOME/bin/keytool -genkey -alias tomcat -keyalg RSA -keystore
$CATALINA_HOME/conf/key.bin` |

The basic install requires certain data. With the above commands, you are prompted for the data:

- Enter two passwords twice. The default for both is “changeit”. If you use the default, be sure to set better, stronger passwords later.
- Specify information about your organization, including your first and last name, your organization unit, and organization. The normal response for first and last name is the domain of your server, such as jasperserver.mycompany.com. This identifies the organization the certificate is issued to. For organization unit, enter your department or similar-sized unit; for organization, enter the company or corporation. These identify the organization the certificate is issued by.
- Keytool has numerous switches. For more information about it, see the Java documentation.

8.1.2 Enabling SSL in the Web Server

Once the certificate and key are saved in the Tomcat keystore, you need to configure your secure socket in the SCALINA_BASE/conf/server.xml file, where SCALINA_BASE represents the base directory for the Tomcat instance. For your convenience, sample <Connector> elements for two common SSL connectors (blocking and non-blocking) are included in the default server.xml file that is installed with Tomcat. They are similar to the code below, with the connector elements commented out, as shown.
To implement a connector, you need to remove the comment tags around its code. Then you can customize the specified options as necessary. For detailed information about the common options, consult the Tomcat 6.0 SSL Configuration HOW-TO. For detailed information about all possible options, consult the Server Configuration Reference.

The default protocol is HTTP 1.1; the default port is 8443. The port is the TCP/IP port number on which Tomcat listens for secure connections. You can change it to any port number (such as the default port for HTTPS communications, which is 443). However, note that on many operating systems, special setup that is outside the scope of this document is necessary if you run Tomcat on port numbers lower than 1024.

8.1.3 Configuring JasperReports Server to Use Only SSL

At this point, the JasperReports Server web application runs on either protocol (HTTP and HTTPS). You can test the protocols in your web browser:

- HTTP: http://localhost:8080/jasperserver[-pro]/
- HTTPS: https://localhost:<SSL port>/jasperserver[-pro]/

The next step, then, is to configure the web application to enforce SSL as the only protocol allowed. Otherwise, requests coming through HTTP are still serviced.

Edit the file `<js-webapp>/WEB-INF/web.xml`. Near the end of the file, make the following changes inside the first `<security-constraint>` tag:

- Comment out the line `<transport-guarantee>NONE</transport-guarantee>`.
- Uncomment the line `<transport-guarantee>CONFIDENTIAL</transport-guarantee>`.

Your final code should be like the following:

```xml
<security-constraint>
  <web-resource-collection>
    <web-resource-name>JasperServerWebApp</web-resource-name>
    <url-pattern>/*</url-pattern>
  </web-resource-collection>
  <user-data-constraint>
    <!-- SSL not enforced -->
    <!-- <transport-guarantee>NONE</transport-guarantee> -->
    <!-- SSL enforced -->
    <transport-guarantee>CONFIDENTIAL</transport-guarantee>
  </user-data-constraint>
</security-constraint>
```

In the code, the term CONFIDENTIAL forces the server to accept only SSL connections through HTTPS. And because of the URL pattern `/*`, all web services must also use HTTPS. If you need to turn off SSL mode, you can set the transport guarantee back to NONE or delete the entire `<security-constraint>` tag.
8.2 Disabling Unused HTTP Verbs

It is prudent to disable all unused HTTP verbs so that they cannot be used by intruders.

In the default JasperReports Server installation, the following HTTP verbs are not used, but they are allowed. However, to facilitate your disabling the verbs, they are listed in a single block of code in <js-webapp>/WEB-INF/web.xml. As in the code immediately above, the URL pattern /* applies the security constraint to all access to the server, including web service requests.

![The list is commented out by default because it has not been exhaustively tested with all system configurations and platforms.]

After uncommenting the security constraint, your final code should be like the following:

```xml
<!-- This constraint disables the listed HTTP methods, which are not used by JS -->
<security-constraint>
  <web-resource-collection>
    <web-resource-name>RestrictedMethods</web-resource-name>
    <url-pattern>/*</url-pattern>
    <http-method>HEAD</http-method>
    <http-method>CONNECT</http-method>
    <http-method>COPY</http-method>
    <http-method>LOCK</http-method>
    <http-method>MKCOL</http-method>
    <http-method>OPTIONS</http-method>
    <http-method>PATCH</http-method>
    <http-method>PROPFIND</http-method>
    <http-method>PROPPATCH</http-method>
    <http-method>SEARCH</http-method>
    <http-method>TRACE</http-method>
    <http-method>UNLOCK</http-method>
  </web-resource-collection>
</security-constraint>
```

8.3 Setting the Secure Flag on Cookies

JasperReports Server uses cookies in several ways:

- `userTimezone` and `userLocale` to store user settings
- Repository tree information (all cookies have the prefix `tree*`)
- Other UI settings such as `lastFolderUri` and `inputControlsPanelWidth`

The JSESSIONID cookie is managed by the application server, so its security setting depends on your app server configuration.

Jaspersoft does not set the secure flag on these cookies because we don't want to force you to use secure connections. If you want all cookies to be secure, you must customize the source files that create the cookies. This requires the source code distribution and recompiling and building the server app, as described in the *JasperReports Server Source Build Guide*.

To customize JasperReports Server so that cookies are sent only via secure connections:

1. For the time zone and locale cookies, open the following file to edit:
   `jasperserver-war-jar\src\main\java\com\jaspersoft\jasperserver\war\UserPreferencesFilter.java`
2. Locate the following code in 2 locations, one for each cookie, and add the middle line to both:

```javascript
cookie.setMaxAge(cookieAge);
cookie.setSecure(true); /* requires HTTPS */
httpOnlyResponseWrapper.addCookie(cookie);
```

For more information, see the JavaDoc for the `setSecure` method on the `javax.servlet.http.Cookie` class.

3. For the repository tree cookies, open the following file to edit:
   jasperserver-war\src\main\webapp\scripts\tree.nanotree.js

4. Locate the following line in the `setCookie` function:
   ```javascript
   ```
   Replace the entire line with:
   ```javascript
   var secure = true;
   ```

5. For the UI settings cookies, open the following file to edit:
   jasperserver-war\src\main\webapp\scripts\utils.common.js

6. Locate the following line:
   ```javascript
   JSCookie.addVar('cookieTemplate', new Template('#{name}={value}; expires={expires}; path=/;'));
   ```
   Modify the line as follows:
   ```javascript
   JSCookie.addVar('cookieTemplate', new Template('#{name}={value}; expires={expires}; path=/; secure;'));
   ```

7. Recompile, rebuild, and redeploy the JasperReports Server application.
   This only acts on the cookies; providing a secure connection is up to the client application, usually by configuring and establishing an HTTPS connection, as described in 8.1, “Using SSL in the Web Server,” on page 81. If no secure connection is established, the cookies with the secure flag will not be sent and user settings won’t take effect.

### 8.4 Setting `httpOnly` for Cookies

The application server that hosts JasperReports Server handles the session cookie. To prevent malicious scripts on a client from accessing the session cookie, and thus the user connection, you should set the application server to use `httpOnly` cookies. This tells the browser that only the server may access the cookie, not scripts running on the client. This setting safeguards against cross-site scripting (XSS) attacks.

The settings for Tomcat are shown below. Consult the documentation for your application server on how to set `httpOnly` cookies.

#### 8.4.1 Setting `httpOnly` for Tomcat 5 or 6

Since Apache Tomcat 6.0.19 or 5.5.28, you can enable `httpOnly` in the file `<tomcat>/conf/context.xml`:

```xml
<Context useHttpOnly="true">
  ...
</Context>
```

#### 8.4.2 Setting `httpOnly` for Tomcat 7

Tomcat 7 sets `httpOnly` on session ID cookies by default. However, on some versions of Tomcat 7, a session error will occur while running reports, with the log error “A request has been denied as a potential CSRF attack.” This is due to a known conflict between security settings in Direct Web Remote library (DWR) 2.x and some versions of Tomcat 7.0.x:

- Tomcat 7 sets `httpOnly` on session ID cookies to safeguard against cross-site scripting (XSS) attacks.
- DWR 2.x uses session ID cookies to safeguard against cross-site request forgery (CSRF).
To work around this problem, you must modify these safeguards by doing one of the following:

- Allowing requests from other domains in DWR
- OR
- Disabling httpOnly for cookies in Tomcat

For more information on the security impact and relative risks of these two choices, see, for example, the Cross-site Scripting and Cross-site Request Forgery pages at the [Open Web Application Security Project (OWASP)](https://owasp.org).

### 8.4.2.1 Allowing Requests from Other Domains in DWR

DWR is a server-side component used for input Controls. By default, DWR uses session ID cookies to prevent against cross-site request forgery. You can disable the protection in DWR by setting the `crossDomainSessionSecurity` parameter for the `dwr` servlet in the file `<tomcat>/webapps/jasperserver-pro/WEB-INF/web.xml`:

```xml
<servlet>
  <servlet-name>dwr</servlet-name>
  <servlet-class>org.directwebremoting.spring.DwrSpringServlet</servlet-class>
  ...
  <init-param>
    <param-name>crossDomainSessionSecurity</param-name>
    <param-value>false</param-value>
  </init-param>
</servlet>
```

### 8.4.2.2 Disabling httpOnly for Cookies in Tomcat 7

You can disable httpOnly in the file `<tomcat>/conf/context.xml`:

```xml
<Context useHttpOnly="false">
  ...
</Context>
```

### 8.5 Using a Protection Domain Infrastructure

Legitimate code can be used to introduce harmful measures into the web application. For instance, calls for disk access and calls to `System.Exit` can be hidden in classpaths when running a report. An effective measure against such intrusions is to implement a protection domain. In Tomcat, in order to implement a protection domain you have to enable the Tomcat Security Manager then edit its parameters according to the requirements of your server environment.

The `ProtectionDomain` class encloses a group of classes whose instances have the same permissions, public keys, and URI. A given class can belong to one and only one ProtectionDomain. For more information on `ProtectionDomain`, see the [Java documentation](https://docs.oracle.com/javase/8/docs/api/java/security/ProtectionDomain.html).

### 8.5.1 Enabling the JVM Security Manager

Enabling the Security Manager restricts permissions at the application server level. By default, all permissions at that level are disallowed, so legitimate permissions must be added specifically. You must add permissions for JasperReports Server. Doing so does not interfere with server operations because JasperReports Server security restrictions occur on other levels.

Add the enabling code for the Security Manager in the file `<apache-tomcat>/conf/catalina.policy` file. ProtectionDomains can be enabled, as defined in `<js-webapp>/WEB-INF/applicationContext.xml`, `reportsProtectionDomainProvider` bean.
To enable the Security Manager and give JasperReports Server full permissions there, add the following code fragment at the end of catalina.policy:

```java
// These permissions apply to the JasperReports Server application
grant codeBase "file:${catalina.home}/webapps/jasperserver[-pro]/-" {
    permission java.security.AllPermission;
};
```

After enabling the manager, you should add the security parameter to your Tomcat startup command. For example:

```
<apache-tomcat>\bin\startup -security
```

If you did not add the permissions properly, you will receive errors like the following:

```
Feb 9, 2010 12:34:05 PM org.apache.catalina.core.StandardContext listenerStart
SEVERE: Exception sending context initialized event to listener instance of class
org.springframework.web.context.ContextLoaderListener
java.security.AccessControlException: access denied (java.lang.RuntimePermission
accessDeclaredMembers)
    at java.security.AccessControlContext.checkPermission(Unknown Source)
    at java.security.AccessController.checkPermission(Unknown Source)
    at java.lang.SecurityManager.checkPermission(Unknown Source)
    at java.lang.SecurityManager.checkMemberAccess(Unknown Source)
    at java.lang.Class.checkMemberAccess(Unknown Source)
    at java.lang.Class.getDeclaredMethods(Unknown Source)
```

### 8.5.2 Restoring Disallowed Permissions

The file `<js-webapp>/WEB-INF/applicationContext.xml` defines the permissions that are allowed for `java.security.Class`. You might have to use the file to add permissions that enabling the Security Manager has disallowed. On the application level, only specified permissions are granted now, so any application-level permissions you were using have been disallowed. You must write code that restores them.

To help you restore necessary permissions, the following commented sample code is provided in the applicationContext.xml file. For instance, to add permission for read/write access to the /temp folder, you would uncomment the code for the bean class `java.io.FilePermission`:

```xml
<bean id="reportsProtectionDomainProvider" class="com.jaspersoft.jasperserver.api.
    engine.jasperreports.util.PermissionsListProtectionDomainProvider">
    <property name="permissions">
        <list>
            <!-- no permissions by default -->
            <!-- sample permission: read and write to temp folder -->
            <!--<bean class="java.io.FilePermission">
            <!--<constructor-arg value="${java.io.tmpdir}${file.separator}*"/>
            <!--<constructor-arg value="read,write"/>
            <!--</bean>-->-->
            <!-- all permissions can be granted if desired -->
            <!--<bean class="java.security.AllPermission"/>-->
        </list>
    </property>
</bean>
```
8.5.3 Additional Customizations for Previous Versions of Tomcat

For Tomcat versions 5.5.28 and earlier and 6.0.20 and earlier, you also need to add permissions for Groovy scripts in the catalina.policy file and in the protection domain for reports.

In <apache-tomcat>/conf/catalina.policy, permissions to read the JasperReports Server classpath needs to be granted to Groovy scripts (which use /groovy/script as their codebase). This change applies to calculated fields in Ad Hoc, which use Groovy to evaluate expressions:

```java
grant codeBase "file:/groovy/script" {
  permission java.io.FilePermission "${catalina.home}${file.separator}webapps
  ${file.separator}jasperserver-pro${file.separator}WEB-INF${file.separator}
  classes"", "read";

  permission java.io.FilePermission "${catalina.home}${file.separator}webapps
  ${file.separator}jasperserver-pro${file.separator}WEB-INF${file.separator}lib
  ${file.separator}*", "read";
}
```

In <js-webapp>/WEB-INF/applicationContext.xml, the same permissions need to be added to `reportsProtectionDomainProvider`. This change grants access to reports that use the Groovy language, plus reports that need to load additional classes from the JasperReports Server web application:

```xml
<bean id="reportsProtectionDomainProvider" class="com.jaspersoft.jasperserver.api.
  engine.jasperreports.util.PermissionsListProtectionDomainProvider">
  <property name="permissions">
    <list>
      <bean class="java.io.FilePermission">
        <constructor-arg value="${catalina.home}${file.separator}webapps
        ${file.separator}jasperserver-pro${file.separator}
        WEB-INF${file.separator}classes"/>
        <constructor-arg value="read"/>
      </bean>
      <bean class="java.io.FilePermission">
        <constructor-arg value="${catalina.home}${file.separator}webapps
        ${file.separator}jasperserver-pro${file.separator}WEB-INF
        lib"/>
        <constructor-arg value="read"/>
      </bean>
    </list>
  </property>
</bean>
```

Also, for a Tomcat bug found in 5.5.26, 5.5.27 and 6.0.16, and fixed in 5.5.28 and 6.0.18, the following configuration change is required for JasperReports Server to start properly.

In <apache-tomcat>/conf/catalina.policy, find the section that starts with:

```java
grant codeBase "file:${catalina.home}/bin/tomcat-juli.jar" {
```

Add the following line in that section:

```java
permission java.io.FilePermission "${catalina.base}${file.separator}webapps
  ${file.separator}jasperserver-pro${file.separator}WEB-INF${file.separator}classes
  ${file.separator}logging.properties", "read";
```
8.6 Encrypting Passwords in URLs

One advantage of having the JasperReports Server is being able to share reports with other users. You can easily share the URL to access a report, even with people who do not have a username. For embedding the web app, it’s often necessary to include a link to a page without logging in, for example:

http://example.com:8080/jasperserver/flow.html?_flowId=homeFlow&j_username=joeuser&j_password=joeuser

However, you must take special precautions to avoid revealing a password in plain text. The server provides a mechanism to encrypt any password that appears in a URL:

1. Configure login encryption as described in the *JasperReports Server Administrator Guide*. Specify static key encryption by setting `encryption.dynamic.key` to `false` and configure the keystore as described.
2. Once the server is restarted, log into the server to generate the static key.
3. Open the following URL: http://example.com:8080/jasperserver/encrypt.html.
4. Enter the password that you want to encrypt, for example `joeuser`, then click **Encrypt**. The script on this page will use the public key to encrypt the password.
5. Paste the encrypted password into the URL instead of the plain text password (log out of the server to test this): http://example.com:8080/jasperserver/flow.html?_flowId=homeFlow&j_username=joeuser&j_password=<encrypted>
6. Use the URL with the encrypted password to share a report.

For complex web applications that are generating report URLs on the fly, you can also encrypt the password programmatically. Your JavaScript should perform the same operations as the encrypt.js script that is used by the encrypt.html page at the URL indicated above. Using the `encryptData()` function in encrypt.js, your JavaScript can generate the encrypted password and use it to create the URL.

Static key encryption is very insecure and is recommended only for intranet server installation where the network traffic is more protected. Anyone who sees the username and encrypted password can use them to log into JasperReports Server. Therefore, Jaspersoft recommends creating user IDs with very specific permissions to control access from URLs.

The only advantage of encrypting passwords in URLs is that passwords cannot be deciphered and used to attack other systems where users might have the same password.

8.7 Final Note

The example instructions in this chapter apply only to the indicated versions of Tomcat. They have not been tested on any other server. We offer them as a useful model for implementing security on your server, regardless of its type.

Additional measures that you might take include disabling unnecessary applications and resources, encrypting usernames and passwords, closing unused ports, and avoiding memory leaks.

Jaspersoft is committed to application security; we remain alert to advances in the art.
CHAPTER 9 JASPERREPORTS SERVER PLUG-IN FOR IREPORT

iReport Designer is the most widely used advanced visual designer for JasperReports. The JasperReports Server plug-in for iReport transforms iReport into a client with which you can access the server’s repository, navigate it, manage its content, and run report units. You can create, edit and manage folders, report units, JRXML sources, and all the related resources, such as images, fonts, and input controls. The additional Domain plug-in helps you create reports that return data from a Domain.

The JasperReports Server plug-in uses the web services API to access the repository. For more information, refer to the web services documentation provided with JasperReports Server.

This chapter describes:
- Getting Started
- Folders and Resources
- Data Sources
- File Resources
- Report Units

9.1 Getting Started

9.1.1 Installation and Startup

Depending on the distribution you installed from, you start up iReport differently:
- If you installed iReport as part of a JasperReports Server installation, start iReport by selecting Start > All Programs > JasperReports Server x.x > Start iReport (where x.x is your version of JasperReports Server).
- If you installed iReport from the stand-alone iReport Professional distribution, start iReport by selecting Start > All Programs > Jaspersoft > iReport-Professional-x.x.x > iReport-Professional-x.x.x (where x.x.x is your version of iReport).

To open the JasperReports Server Plug-in, click Window > JasperReports Server Repository. iReport displays the plug-in as a tree view in a panel on the left, with the Report Inspector.
The Domain plug-in is also available; note that it is only compatible with commercial editions of JasperReports Server.

### 9.1.2 Server Connection Configuration

By default, the plug-in doesn’t display any servers; they must be added manually. To add one, click ![Add Server](image). The server configuration window appears.

Specify the correct value for each field and click **Save** to add the server to the list.
Note that the **Organization** field is only supported in commercial editions of JasperReports Server since version 3.5 (then called JasperServer), and is only required if your instance hosts multiple organizations. For more information on organizations, refer to the *JasperReports Server Administrator Guide*.

Expand the server icon to display and explore its repository.

### 9.1.3 Common Connection Errors

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>(401) Bad credential</td>
<td>Invalid user name or password provided.</td>
</tr>
<tr>
<td>The AXIS engine could not find a target service to invoke!</td>
<td>The web services URL provided is incorrect.</td>
</tr>
<tr>
<td>java.net.ConnectException: Connection refused: connect</td>
<td>The server is down, or the host or port specified in the web services URL is incorrect.</td>
</tr>
</tbody>
</table>

### 9.2 Folders and Resources

When you view the repository in iReport, you can navigate its folders by double-clicking them.

Right-click an object in the docking panel to open the context menu for the object. The menu provides access to all the available actions that you can take, such as viewing object properties, refreshing a folder’s content, and deleting objects.

![Figure 9-3 Context Menu for iReport Objects](image)

Working in the repository through the JasperReports Server Plug-in is much like working directly in the repository.

While resources can be located anywhere in the repository, Jaspersoft recommends that you organize the repository in such a way that you can store similar resources together. Think carefully about the organization of your repository; such planning can facilitate maintenance and authorization by grouping similar objects together. For more information, refer to section 7.2.1, “Repository Design for Access Control,” on page 68.

Right-click a resource in the Repository Navigator panel and select **Properties** from the context menu to view its details. A resource must have a name and a label (that is, a display name); you can also specify a description. These properties appear on the **General** tab. A resource’s other properties are determined by its type; for example, a data source resource’s properties also includes whether it is a JNDI, JDBC, or Bean type data source. Such properties appear on other tabs in the Properties window.
Figure 9-4 shows the general properties of a query resource. For instructions on creating a query, see the *JasperReports Server Administrator Guide*.

![General Tab in the Properties Dialog](image)

The **Save** button is only active when:

- You have made changes since opening it; and
- All required fields are populated.

Since the ID of a resource is part of its URI (also called a resource path; for example /datasources/ProfileData Source, or /reports/samples/AllAccounts), the **ID** field cannot contain spaces or special characters. However, note that these characters are supported in the **Label** field because the label is only used for display.

### 9.3 Data Sources

Users generally define data sources in iReport when working with reports in iReport. For these reports to run in JasperReports Server, the server must have similar data sources. If you aren’t using the plug-in, you must test the reports in iReport, then login to the server to upload them and test them again on the server. With the plug-in, you can run the report on the server from within the plug-in. Since the server and iReport can have different access to the database (or other data source), Jaspersoft recommends running the report unit on the server rather than running it locally. This yields more reliable test results. In some cases, such as when the data source is a Domain, the report must be tested by way of the server, either by running it through the plug-in or by uploading it to the repository and then running it.

If needed, you can create data sources on the server through the plug-in. You can also view and edit the definition of a data source on the server if you have the required permission, usually if you’ve connected as an administrator (jasperadmin).

Creating a data source through the plug-in is very similar to working on the server:

1. In the Repository Navigator, right-click the folder where you want the data source and select **Add > Data Source**.
2. Enter an ID and a name for the data source on the general tab.
3. On the Data Source Details tab, select the type of data source you want to add:
   - JDBC Data Source
   - JNDI Data Source
   - Bean Data Source

   The information you need to enter for each is the same as when working on the server. For details about data sources, see the *JasperReports Server Administrator Guide*.

4. For JDBC data sources, you also have the option of importing a data source definition from those you have defined in iReport. Click **Import from iReport**, select the data source you want to import from, and enter the database password if necessary.
5. Click **Save** when done to create the data source on the server.
The plug-in also supports importing a data source from the server. It is often convenient to have the same data source within iReport for previewing a report during development. Use the context menu for data source objects in the Repository Navigator to import a data source definition from the server.

After importing a JasperReports Server data source, it appears as the default data source in iReport’s list of connections/data sources.

When you import a JDBC connection, iReport stores its password in clear text in a configuration file (located in the user’s home directory; for example: C:\Documents and Settings\<user>\Application Data\ireportpro\iReport version\config\Preferences\com\jaspersoft\ireport\jasperserver.properties. Ensure that this folder is properly safeguarded against unauthorized access.

In addition to the data source, reports can also rely on the Domains. Domains provide a metadata layer on top of other data sources defined in the repository. iReport can generate reports from Domains using the Domain plug-in. See the JasperReports Server User Guide for details.

Remember that you shouldn’t use a locally-defined data source when testing reports to run on JasperReports Server. JRXML files created for JasperReports Server can contain special URLs (using the repo: syntax) that refer to repository resources, such as images and subreports. Because iReport can’t resolve the special URLs, the report fails when run locally.
9.4 File Resources

When you create a new file resource, the plug-in prompts for a resource ID, a display name, an optional description, and a file to upload. You can also upload file resources automatically when you add them to an existing report in the repository. For more information, see section 9.5.4, “Adding Images, Style Templates, and Subreports,” on page 99.

![New Resource Window](image)

To edit an existing resource, right-click it and select Properties from the context menu. For fonts and images, the properties window includes a preview.

The Resource tab in the properties window enables you to share files between the server and your local computer.

- To replace the file on the server with a local instance, select the Replace the resource with this file check box on the context menu, and use the Browse button to locate and select the new file.
- To download a file that is stored on the server, click the Export button on the Properties window’s Resource tab.

Click Save to save your changes.

JasperReports Server won’t let you upload class files directly. To upload new classes, you must first package them, either by zipping them up or using the Java Development Kit’s JAR tool to create a JAR file.

Once you upload the JAR file, you must link it to the report unit that relies on it. You can also define the resource directly in the report unit.

9.5 Report Units

iReport displays a report unit as a folder; think of the report unit as a container for all the pieces you need to create the output you want. At a minimum, a report unit needs a JRXML (called the main JRXML) and a data source that fills it.

A report’s resources are either locally defined or externally defined:

- A locally defined resource resides in the report unit itself, and can only be used by this one report.
- An externally defined resource resides elsewhere in repository; the report unit references the resource using a pointer to its location.

A report unit can include every resource it requires; it could just as easily reference each resource externally, if each were defined in the repository. The decision of whether to define local or external resources revolves largely around the nature of the resource itself:

- If the resource is unique to the report, define it locally. For example, most JRXML source files and JAR files that contain report-specific scriptlets.
- If the resource would be useful in a number of reports, upload it to the repository separately and reference it externally. For example, you might externally define resources such as data sources, commonly-used JAR files, your logo, or fonts.
A report unit contains the main JRXML, the data source (only visible if it is locally defined), and two subfolders, Input Controls and Resources, which contain the input controls used to prompt users for the information and resources the report requires (both locally and externally defined).

### 9.5.1 Creating a JasperReport on the Server

This section walks you through the creation of a JasperReport on the server through the plug-in. You’ll use the iReport wizard to create a JRXML file that relies on a JDBC connection that’s already defined in the repository. While more complex reports might require you to start a new JRXML file from scratch, this example steps through the wizard.

Be sure that the data source you plan to use on the server is available as an active connection in iReport. This example uses the Jserver Jdbc data source connection in the /Data Sources repository folder; this is only created if you chose to install the sample data during installation. This connection points to the JasperReports Server SugarCRM sample database.

To create a new report:

1. In the Repository Navigator, right-click the Jserver Jdbc data source data source in the repository and select **Import JDBC Connection Definition**.
2. Select **File > New** and scroll down among the templates to select Simple Blue.
3. Click **Launch Report Wizard** to start the new report with this template.
4. Specify a name and location, and click **Next**.
5. Select the data source you imported in step 1.
6. Enter the following in the **Query (SQL)** field:

   ```sql
   SELECT
     accounts.id AS accounts_id,
     accounts.name AS accounts_name,
     accounts.industry AS accounts_industry,
     accounts.email1 AS accounts_email1
   FROM
     accounts accounts
   ```

7. Click **Next**.
8. Select all the fields that the query returns, and click **Next**.
9. Click **Next** to skip the definition of grouping for the report.
10. At the end of the wizard, click **Finish**.

   The report appears in the design area. You may need to click on the Report Inspector to make it visible, because it shares the same panel as the Repository Navigator. For more information about the wizard, refer to the [iReport Ultimate Guide](#).

11. Enter a report title such as **My Accounts** and a description such as **Accounts by Industry**. Save the report and preview it to see the values it contains.

   The report is ready to be uploaded to the server.
To upload the new report to JasperReports Server:

1. In iReport’s Repository Navigator, right-click the folder where you want to place the report, and click Add > JasperServer Report.

2. When you are prompted for a name and a label (display name) for the new report unit, enter them and click Next.

3. When you are prompted to select the main JRXML file, select the report you just created in the wizard by clicking Get source from current opened report.

4. Click Next.

5. When prompted to locate a data source, select From the repository, and from the drop-down, choose the data source you exported in step 1 of the previous procedure (/datasources/JServerJdbcDS), and click Finish.

The new report unit appears in the folder of the repository tree. You can expand the report unit, though this simple report only has a main JRXML component.
7. You can also login to JasperReports Server, and click **View > Reports** to locate the report and run it.

This example used a very simple report: it has no extra resources (such as images or fonts), nor does it include a subreport, input controls, or offer drill down functionality. These more advanced subjects, are discussed in the following sections:

- 9.5.4, “Adding Images, Style Templates, and Subreports,” on page 99
- 9.5.5, “Using Input Controls,” on page 101
- 9.5.6, “Using Drill Down Functionality,” on page 103

### 9.5.2 Editing the JRXML File

If you have sufficient permissions, you can edit any JRXML file in the repository by double-clicking it in the JasperReports Server plug-in tree view. The file is downloaded to a temporary file found in the `<user home>\Local Settings\Temp\jstmp` folder (in Windows).

To save the file in the repository, right-click the JRXML file in the JasperReports Server plug-in and select **Replace with current JRXML**.

### 9.5.3 Running a Report

When you are using the plug-in, Jaspersoft recommends that you avoid testing your changes in the local iReport instance (by using the **Preview** button). It relies on an iReport data source, which might not be available in the repository. Instead, test your reports directly on your instance of JasperReports Server by selecting the report unit that you want to test, then click **Run JasperServer Report** in the plug-in tool bar. Select the report unit rather than its main JRXML.

Testing your reports on your instance of JasperReports Server has several advantages:

- The report is executed in the environment where your users will access it, and it will use the exact data source defined on the server, even if the data isn’t directly accessible by iReport.
- It allows you to test reports that refer to externally-defined resources using the special `repo:` syntax; the server finds the referenced resource, and no error is returned (as is usually the case when testing such reports in iReport without the plug-in), since the resource can be found by the server engine. For more information on the `repo:` syntax, see section 9.5.4, “Adding Images, Style Templates, and Subreports,” on page 99.
- When testing reports that rely on input controls, iReport prompts you with them before running the report on the server.

### 9.5.4 Adding Images, Style Templates, and Subreports

Reports in JasperReports Server can reference several kinds of external objects:

- Images. File resources used in reports.
- Style templates. Files of type JRTX that define a set of styles for use in multiple reports.
- Subreports. Any JRXML files in your report other than the main JRXML file. Subreports reference the same data source as the main JRXML but not necessarily the same resources.

You can point to these files using a URI, classpath, or repository reference (for example, `repo:/images/JRLogo`). For reports that are uploaded to the server’s repository, Jaspersoft recommends that you also store the images, style templates, and
subreports in the repository and that you use the repo: syntax to reference them in the reports. For more information about referencing resources, see the JasperReports Server Administrator Guide.

The JasperReports Server plug-in for iReport makes it easy to manage the resources in the repository through iReport.

There are two ways to reference resources using iReport:

- Add the resources to the repository ahead of time, as described in section 9.4, “File Resources,” on page 96, then drag them from the iReport Repository Navigator to the design area. The resources appear in your report layout and iReport automatically creates the expressions that reference them. For subreports, JasperReports Server compiles the JRXML sources and locates the subreports’ generated .jasper files.

Adding the references ahead of time makes them available for use in other reports.

- If you do not add the resources before you upload the JRXML file to the repository, the plug-in detects all the resources that the JRXML file references and reminds you to upload them. It also recommends rewriting the expressions that reference them in repo: syntax, as shown in Figure 9-13.

When you upload the resources in this way, they are saved in the report unit and are unavailable for other reports.
9.5.5 Using Input Controls

A report can include input controls that determine the data in the report and its appearance. For example, you might include an input control to allow users to select the name of a customer from a drop-down list; when the report is run, it only includes data pertaining to that customer. Such input controls are mapped by their names to parameters in the report itself, which must match. JasperReports Server provides a default interface for input controls but you can specify your own JSP to show, as described in section 11.6.1, “Customizing the Input Controls Form,” on page 149.

JasperReports Server provides a rich set of highly configurable input controls. You can define as many as needed. They can be mandatory or optional, and can be made read only, so the user understands the report’s parameters but cannot change them.

When defining input controls, you must specify a type of control that is suitable for the parameter’s data. For example, it doesn’t make sense to define a Boolean type input control for a Date parameter.

The types of input control that JasperReports Server supports can be grouped in three basic categories:

- **Boolean.** The simplest type. Generally represented as a check box, these input controls return a java.lang.Boolean object to the report engine in response to a user’s selection.

- **Single value.** Require you to specify a datatype resource. Generally represented as a free-form text box; the user’s entry is validated against the datatype resource you specify. Note that you can manage datatype resources the same way you manage other resources; you can define them locally or externally to the input control.

- **List-based.** Refer to a resource in the repository. These controls offer the user a set of options, from which he can select one (single-select) or more (multi-select). If only a single selection is allowed, the input control is generally represented as a drop-down or a set of radio buttons. Multi-select input controls are generally represented as a scrollable list or a set of check boxes. The available options come from a repository resource that is either a static list or a query (SQL statement).

9.5.5.1 Datatypes

Datatypes are used with single-value input controls.
The only required information for a datatype is the datatype (Text, Number, Date, or Date/Time). Its optional information includes:

- Pattern. Similar to a format mask: the user’s entry must match it.
- Minimum and maximum. Set thresholds for valid values. While minimum and maximum are generally used with numbers, you can also use them with strings. The report engine uses the Java Comparable interface to check these constraints. The check boxes determine whether the constraint is inclusive. For instance, for a percent field, you might specify a minimum of 0 and a maximum of 100. If you do not want to accept 0 percent, you would select the minimum check box. If you want to accept 100 percent, you would clear the maximum check box.

<table>
<thead>
<tr>
<th>Java Class Type</th>
<th>Datatype That Is Returned</th>
</tr>
</thead>
<tbody>
<tr>
<td>java.lang.String</td>
<td>Text</td>
</tr>
<tr>
<td>java.math.BigDecimal</td>
<td>Number</td>
</tr>
<tr>
<td>java.util.Date</td>
<td>Date and Date/Time</td>
</tr>
</tbody>
</table>

9.5.5.2 List-Based

List-based input controls are populated using lists and queries.

- The static list is simply a set of labels and values that map to data returned by the report.

A query is identified by a query language and some text. By default, a query in iReport runs against the same data source as the report. However, you can specify a different data source than the report uses. This feature provides you a great deal of flexibility; the input values can come from a separate source.
Once the query is defined, you must indicate which columns in the query result to use as the item value, and which columns to display as the label when the input control is rendered.

A static list of values always returns an item value with the class type java.lang.String. However, when the list comes from a query, the type is unpredictable; you’ll need to know the type returned by the query before creating the input control.

9.5.5.3 Multi-Select Input Controls

For multi-select input controls, you can use the IN and NOT IN clause functions:

$X{ IN, COLUMN, PARAMETER NAME}

For example:

SELECT * FROM ORDER WHERE $X(IN, CITY, myCities)

where:

CITY is the column name.
myCities is the parameter.

This clause function is exploded in the following:

SELECT * FROM ORDER WHERE CITY IN ( 'city1', 'city2', ... )

The parameter myCities must be a non-null Java Collection.

9.5.6 Using Drill Down Functionality

One of the most interesting features of JasperReports Server is the ability to connect reports to create drill-down and drill-up functionality. In this case, your users can click elements in the report to navigate to other reports that are generated dynamically. You can configure this functionality for any report element that supports links, such as text fields, images, and charts.

To create such a link using iReport, simply drag the report unit icon from the JasperReports Server plug-in repository tree view, and drop it on the report element in the design area. The element’s Properties window appears, displaying the Link tab.
The plug-in automatically sets the **Hyperlink Type** to the correct value (ReportExecution), and it adds a parameter 
 (_report) that points to the report to generate when the user clicks the element. The plug-in also creates a list of the target report’s parameters. For each of these input parameters, you should specify an expression that indicates the correct input control in the repository (similar to what is done in JasperReports with subreports, crosstabs, or subdataset runs).

Report connections only work when reports are run in the JasperReports Server web interface (in a browser).

In addition to the report input parameters, the following optional parameters can be manually added along with value expressions:

- \_output – Specifies the format in which the target report should open. Values for this parameter are keys for the report exporters configured in JasperReports Server. By default, the server recognizes the following output types: pdf for PDF, xls for Excel (Paginated), xlsx for XLSX (Paginated), xlsxNoPag for XLSX, rtf for RTF, csv for CSV and swf for the Flash report viewer. When this parameter is not specified, the default format is HTML displayed in the report viewer.

- reportLocale spec – When this parameter is not specified, the default format is HTML displayed in the default report viewer.

- \_page – Specifies the initial page that should be displayed when opening the target report. By default the first page is displayed. This parameter is only effective when HTML output is used for the drill-down.

- \_anchor – Specifies the name of an anchor from the target report at which the report should open. This parameter is only effective when \_page is not specified and when the output format is HTML.

### 9.5.7 iReport and Ad Hoc Views

You can use the JasperReports Server plug-in for iReport to browse your server’s repository to locate and edit reports created from Ad Hoc views. You cannot open Ad Hoc views directly from iReport.
CHAPTER 10 JASPERREPORTS SERVER APIs

One of the main goals of JasperReports Server is to expose a set of reusable application programming interfaces (APIs) that are easy to understand, extend, and customize. This facilitates adapting JasperReports Server to the unique requirements of different deployments.

This chapter describes the main entry points into the JasperReports Server APIs, the functionality they provide, and how they are leveraged in the product. JasperReports Server supports the following APIs:

- Web Services APIs
- Java APIs
- Ad Hoc Launcher Java API
- Repository HTTP API

10.1 Web Services APIs

JasperReports Server’s web services allow client applications to interact with the server programmatically. There are two different Application Programming Interfaces (APIs), REST (REpresentational State Transfer) and SOAP (Simple Object Access Protocol). This section gives a brief summary of the web services APIs; for complete documentation, see the JasperReports Server Web Services Guide.

10.1.1 REST APIs

The RESTful interface depends on the standard methods provided by HTTP: GET, PUT, POST, and DELETE. This interface is new and the API is still expanding. The RESTful services in JasperReports Server 5.0 include:

- Repository web services, which allow you to search the repository; create, modify, and delete resources; and view and set permissions on repository objects.
- Report web services, which allow you to run reports and access report output; access and manipulate report options and input controls; and work with scheduled jobs.
- Administration web services, which allow you to work with users and user properties and attributes; roles and role membership; and, in commercial editions, organizations.
10.1.2 SOAP APIs

The SOAP interface sends and receives XML documents to process requests and provide results. This interface is still supported but is not enhanced with new features. The SOAP services in JasperReports Server 5.0 include:

- A repository web service, which allows you to list the contents of a folder or report unit in the repository, get information about a resource, add, modify, move, or copy resources, and run a report and return the results.
- A report scheduling web service, which allows you to create a scheduled job, set up email options, and specify where the report is saved in the repository.
- A Domain web service, which allows users to query Domains. This feature can be restricted by the terms of your license.
- Web services for administration, which allow you to work with users and roles, permission, and, in commercial editions, organizations and tenants.

For complete documentation on the web services APIs, see the JasperReports Server Web Services Guide.

10.2 Java APIs

This section describes some of the important Java interfaces available in JasperReports Server, including commercial editions and Jaspersoft OLAP modules.

10.2.1 The Public JasperReports Server API

A subset of the Java classes and interfaces in JasperReports Server has been designated as the public JasperReports Server API. These classes are marked with an @JasperServerAPI annotation, as demonstrated in the example below.

```java
package com.jaspersoft.jasperserver.api.metadata.jasperreports.domain;

import com.jaspersoft.jasperserver.api.JasperServerAPI;
import com.jaspersoft.jasperserver.api.metadata.common.domain.DataSource;

@JasperServerAPI
public interface ReportDataSource extends DataSource {

    // ...
}
```

The JavaDoc for the JasperReports Server API classes can be downloaded from the Support Portal (for the commercial editions) or from the Jaspersoft community site (for the community project).

Classes included in the public API are more likely to be stable from release to release, so Java developers should use them in preference to other classes which are not part of the API. Developers should note, however, that the public API is a small subset of all JasperReports Server classes; it doesn’t provide all of the functionality that developers may need, in which case you must create and use other classes. The public API will continue to be expanded to provide APIs for new features, and future releases may fill some current gaps. Also note that this section does not cover all JasperReports Server API classes.

These JasperReports Server Java APIs are a contract between JasperReports Server (including Jaspersoft OLAP) and other applications and services that are exposed as Java interfaces. If the APIs change in the future, the changes will be gradual.

10.2.1.1 Accessing API Implementations Using the Spring Framework

Many of the implementations of the API interfaces are singletons, usually services, which are instantiated by the Spring Framework. The Spring bean configuration files control how these singletons are created and configured, so it is important to understand the files before writing Java code that will run in JasperReports Server using the API.
The following is a brief overview of Spring 3.1.0 and is not meant to cover all the possible ways to configure Spring. For more information on Spring, refer to its reference documentation at http://static.springsource.org/spring/docs/3.1.x/spring-framework-reference/html/.

The Spring configuration files use XML to define Java singleton instances, called beans. In the JasperReports Server web application, these files are located under the WEB-INF directory. Their file names begin with applicationContext and end in .xml, for example, the file WEB-INF/applicationContext-adhoc.xml contains Ad Hoc-related beans:

- Each instance of a singleton is defined by a <bean> element.
- Its type is specified by the class attribute.
- Its reference ID is specified by the id attribute.
- Properties of the instance are set with the <property> element:
  - The name attribute corresponds to a Java property that follows JavaBean conventions. For example, a property with name abc should have a getter method getAbc() and a setter method setAbc().
  - Using the value attribute, properties can be set with a constant value.
  - Using the ref attribute, properties can be set with a reference to another bean.

Below is part of a definition from a sample custom data source implementation. It demonstrates all of the conventions above; the original file is samples/customDataSource/webapp/WEB-INF/applicationContext-hibernateDS.xml in the JasperReports Server distribution.

```xml
<bean id="hibernateDataSource"
     class="com.jaspersoft.jasperserver.api.engine.jasperreports.util.
        CustomDataSourceDefinition">
    <!-- this property is always the same; it registers the custom ds -->
    <property name="factory" ref="customDataSourceServiceFactory"/>
    <!-- name used in message catalog and elsewhere -->
    <property name="name" value="hibernateDataSource"/>
</bean>
```

To add your own instances to the server, you first need information about the specific enhancement that you want to implement. This determines the Java implementations that are required. A good example is creating a custom data source, which is documented in the JasperReports Server Administrator Guide for the commercial editions or the JasperReports Server Community Project User Guide. Samples of custom data sources are located in the JasperReports Server distribution under samples/customDataSource.

Once you have a Java class that you want instantiated along with JasperReports Server, you can deploy it by modifying the webapp directory as follows:

- Add your compiled Java class files to WEB-INF/classes, or create a JAR and add it to WEB-INF/lib.
- Create a new Spring bean file under WEB-INF, using the naming convention described above.
- Add a <bean> element for each object instance you want to create.
- For each property you want to set, you must have a public setter and getter.
- For each API implementation you want to access:
  - Add a setter and getter to your implementation whose types match the Java type of the API.
  - Find out the ID of the API instance you want; some IDs are listed in the table below.
  - Add a <property> element to your bean with a ref attribute whose value is the ID of the API instance.

As an example of a reference to another bean, please refer to the factory property in the Spring file excerpt above. The CustomDataSourceDefinition instance uses the factory property to refer to a singleton implementation of CustomReportDataSourceServiceFactory, which has a bean ID of custom-DataSourceServiceFactory:

- The CustomDataSourceDefinition implementation defines a factory JavaBean property by implementing the following setter and getter:
  - public void setFactory(CustomReportDataSourceServiceFactory factory).
  - public CustomReportDataSourceServiceFactory getFactory().
- The <bean> element contains a <property> element with name set to factory and ref set to customDataSourceServiceFactory.
The following table contains the APIs described in the rest of this section, along with their corresponding bean IDs and descriptions of their functions.

**Table 10-1  JasperReports Server Public Java API**

<table>
<thead>
<tr>
<th>API</th>
<th>Bean ID</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>RepositoryService</td>
<td>repositoryService</td>
<td>Search, retrieve, and modify persistent objects in the repository.</td>
</tr>
<tr>
<td>EngineService</td>
<td>engineService</td>
<td>Run reports and handle report metadata.</td>
</tr>
<tr>
<td>ReportDataSourceService and</td>
<td>n/a</td>
<td>Implement data sources used for running reports and other purposes.</td>
</tr>
<tr>
<td>ReportDataSourceServiceFactory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ReportSchedulingService</td>
<td>reportSchedulingService</td>
<td>Manage report schedules.</td>
</tr>
<tr>
<td>UserAuthorityService</td>
<td>userAuthorityService</td>
<td>Manage internal users and roles.</td>
</tr>
<tr>
<td>OlapConnectionService</td>
<td>olapConnectionService</td>
<td>Manage OLAP-specific repository and model runtime.</td>
</tr>
<tr>
<td>OlapManagementService</td>
<td>olapManagementService</td>
<td>Manage OLAP server run time.</td>
</tr>
<tr>
<td>ObjectPermissionService</td>
<td>objectPermissionService</td>
<td>Search, retrieve, and modify metadata repository object permissions.</td>
</tr>
</tbody>
</table>

### 10.2.2 Repository API

It’s easy to populate the repository (using metadata or output content) and subsequently exploit it. This functionality relies on a limited set of interfaces and classes.

#### 10.2.2.1 Object Model and Service

The `com.jaspersoft.jasperserver.api.metadata.common.service.RepositoryService` interface is central to accessing the metadata repository. It exposes various methods to store, lookup, and retrieve content from the repository. The repository is hierarchical; it is very similar to a file system. However, instead of files, the repository stores resources in a metadata representation of a tree structure.

All resources must have a name, label (display name), description, and type; the names must be unique within a folder. Resources reference their parent folder and are uniquely identified by their absolute URI. This URI consists of the full folder path within the repository, suffixed with the resource name. For example, the URI for the ContentFiles folder created when you run the installer is `/ContentFiles`.

From the object model perspective, all resources are instances of the `com.jaspersoft.jasperserver.api.metadata.common.domain.Resource` interface and represent various entities that constitute the metadata (such as reports, data sources, datatypes, analysis views, and fonts), or generated content (such as generated report output in PDF or XLS format).

Even folders are special types of resources. The `com.jaspersoft.jasperserver.api.metadata.common.domain Folder` interface, which represents folders, directly inherits from `com.jaspersoft.jasperserver.api.metadata.common.domain.Resource`.

All interfaces that represent the main object model of the repository have convenience class implementations in the `com.jaspersoft.jasperserver.api.metadata.common.domain.client` package; they have the `Impl` suffix added to their corresponding interface name. These implementations are shown in the examples that follow when you instantiate folders and resources.

#### 10.2.2.2 Working with Folders

With the most minimal setup (manual WAR file deployment), the repository includes a single folder by default; it serves as the repository’s root directory. In this setup, Jaspersoft recommends that you create sensible folders (within root) to hold all your repository resources.
If you use one of the installers, the root directory includes a number of standard folders. You can use them as-is or create your own structure, depending on your needs. The following code creates a folder in /root:

```java
import com.jaspersoft.jasperserver.api.common.domain.ExecutionContext;
import com.jaspersoft.jasperserver.api.metadata.common.service.RepositoryService;
import com.jaspersoft.jasperserver.api.metadata.common.domain.client.FolderImpl;
...
ExecutionContext context = ...; // gets the instance of the ExecutionContext
// interface, or receives it as a parameter in the // current method
RepositoryService repositoryService = ...; // gets the instance of the // RepositoryService interface
...
Folder myFolder = new FolderImpl();
myFolder.setName("examples");
myFolder.setLabel("Examples");
myFolder.set_description("Folder containing various resources to use as examples.");
repositoryService.saveFolder(context, myFolder);
```

Note that the code doesn't specify a parent for the new folder. In this case, the server assumes that the new resource should reside in /root.

The following code creates a new subfolder in the /examples folder created immediately above:

```java
Folder imagesFolder = new FolderImpl();
imagesFolder.setName("images");
imagesFolder.setLabel("Images");
imagesFolder.set_description("Folder containing image resources to use in the examples.");
imagesFolder.setParentFolder("/examples");
repositoryService.saveFolder(context, imagesFolder);
```

The following code gets the /examples/images subfolder and changes its description:

```java
Folder imagesFolder = repositoryService.getFolder(context, "/examples/images");
imagesFolder.set_description("Example Images Folder");
repositoryService.saveFolder(context, imagesFolder);
```

The existence of a folder can be verified using the `folderExists` method, as shown here:

```java
repositoryService.folderExists(context, "/examples/images");
```

Removing a folder from the repository is also easy. It needs only one method call that identifies the folder by its absolute URI. For example:

```java
repositoryService.deleteFolder(context, "/examples/images");
```

Just as the server’s web interface lets you explore the repository and manage it, the API includes methods (exposed by the RepositoryService) that allow you to get a list of subfolders and manage a given folder’s content. The API includes one
method that gets the list of subfolders and another method that gets the list of other types of child resources. For example, the following code returns a list of folders:

```java
List folders = repositoryService.getSubFolders(context, "/reports"); if (!folders.isEmpty()) {
    System.out.println("No folders found under /reports"); } else {
    System.out.println(folders.size() + " folder(s) found under /reports");
    for (Iterator it = folders.iterator(); it.hasNext();)
        System.out.println("Subfolder: " + folder.getName());
}
```

10.2.2.3 Repository Resources

Adding a new resource in the repository differs from adding a folder, despite the fact that folders are themselves resources. Unlike folders, which are simple in structure and behavior, other types of resources might need to be initialized in a special way, and the initialization logic would probably reside in a service. As a result, we created a unique API for managing repository resources; you can use it regardless of type and internal structure.

New resource instances are created by making a special request to the `RepositoryService`, not by direct instantiation. This can be seen in the following example, where you create a new image resource and put it in the repository by loading it from an image file on disk:

```java
FileResource img = (FileResource) repositoryService.newResource(context,
    FileResource.class);
img.setFileType(FileResource.TYPE_IMAGE);
img.setName("logo.gif");
img.setLabel("Logo Image");
img.setDescription("Example Logo Image");
img.readData(new FileInputStream("C:\Temp\MyImages\logo.gif");
img.setParentFolder("/examples/images");
repositoryService.saveResource(context, img);
```

To retrieve a resource from the repository, you could call the following method on the `RepositoryService` instance:

```java
// retrieve a data source resource from the repository
Resource resource = repositoryService.getResource(context, "/datasources/mydatasource");
if (resource == null) {
    throw new RuntimeException("Resource not found at /datasources/mydatasource");
}
if (resource instanceof JdbcReportDataSource){
    JdbcReportDataSource datasource = (JdbcReportDataSource) resource;
    System.out.println("JDBC data source URI: " + datasource.getConnectionUrl());
} else if (resource instanceof JndiJdbcReportDataSource) {
    JndiJdbcReportDataSource datasource = (JndiJdbcReportDataSource) resource;
    System.out.println("JNDI data source name: " + datasource.getJndiName());
} else {
    throw new RuntimeException("Was expecting /datasources/mydatasource to be a datasource");
}
```
You can save or persist a resource in the repository by calling the following (as already seen above where you created the image resource) on the RepositoryService instance:

```java
public void saveResource(ExecutionContext context, Resource resource);
```

Removing a resource from the repository is done by calling `repositoryService.deleteResource`:

```java
try {
    repositoryService.deleteResource(context, "/reports/myreport");
    System.out.println("Resource /reports/myreport deleted");
} catch (Exception e) {
    System.err.println("Not able to delete resource /reports/myreport");
    e.printStackTrace();
}
```

10.2.2.4 Content Files

Content resources are specially-created resource objects that hold binary data. The data is usually the result of using some of the BI tools available in JasperReports Server, such as the report-generating services, which produce PDF and XLS output. The output can be stored in the repository for later use, especially if the reports were generated in the background as scheduled jobs.

Creating a content resource and adding it to the repository is similar to what you've seen in the previous section, where you created an image resource:

```java
ContentResource pdfResource = new ContentResourceImpl();
pdfResource.setFileType(ContentResource.TYPE_PDF);
pdfResource.setName("report.pdf");
pdfResource.setLabel("PDF Report");
pdfResource.setDescription("Example PDF File");
pdfResource.readData(new FileInputStream("C:\Temp\MyReports\report.pdf"));
pdfResource.setParentFolder("/examples");
repositoryService.saveResource(context, pdfResource);
```

Retrieving the binary data of a content resource from the repository is achieved by using the `getContentResourceData` method of the RepositoryService, as follows:

```java
FileResourceData fileResourceData =
    repositoryService.getContentResourceData(context, "/examples/report.pdf");
byte[] pdfContentBytes = fileResourceData.getData();
```

10.2.2.5 Repository Search

You get the list of child resources within a given folder by using filter criteria. The server expects an instance of the `com.jaspersoft.jasperserver.api.metadata.view.domain.FilterCriteria` class as a parameter in the method call; the list of returned resources matches certain the selected filter conditions.

The only required condition for a `FilterCriteria` instance is that the returned resources’ parent folder must match a given folder. For example:

```java
FilterCriteria filterCriteria = FilterCriteria.createFilter();
filterCriteria.addFilterElement(FilterCriteria.createParentFolderFilter(folderURI));
List resources = repositoryService.loadResourcesList(context, filterCriteria);
```
The `loadResourcesList` method returns a list of `ResourceLookup` objects that contain basic resource attributes (such as the name and label). To retrieve the full resource definition, you must use the `getResource` method. Further filtering can be applied to get a refined list of resources based on a given resource type, or other conditions. For example, the following retrieves all the images and JRXMLs in a folder:

```java
FilterCriteria filterCriteria = FilterCriteria.createFilter(FileResource.class);
filterCriteria.addFilterElement(FilterCriteria.createParentFolderFilter(folderURI));
FilterElementDisjunction fileTypeDisj = filterCriteria.addDisjunction();
fileTypeDisj.addFilterElement(FilterCriteria.createPropertyEqualsFilter("fileType", FileResource.TYPE_IMAGE));
fileTypeDisj.addFilterElement(FilterCriteria.createPropertyEqualsFilter("fileType", FileResource.TYPE_JRXML));
List resources = repositoryService.loadResourcesList(context, filterCriteria);
```

To develop a more detailed understanding of the filter criteria, please refer to the API Javadoc.

### 10.2.3 Engine Service

The engine service includes methods related to report execution. The `engineService` interface includes the `getReportExecutionStatusList` and `getSchedulerReportExecutionStatusList` methods for listing running report jobs or scheduled running report jobs.

- **The `engineService` is used internally for report execution. Except for the `getReportExecutionStatusList` and `getSchedulerReportExecutionStatusList` methods, methods in the `engineService` service should not be accessed directly.**

To retrieve the list of all instances of the All Accounts report that are currently running, you would use code similar to this. The list of report jobs retrieved includes scheduled jobs as well as jobs users are running via the UI:

```java
criteria.setJobLabel("All Accounts");
List<ReportExecutionStatusInformation> reportExecutionList =
    engineService.getReportExecutionStatusList(criteria);
```

To retrieve only scheduled instances of the All Accounts report that are currently running, you would use code similar to this:

```java
criteria.setJobLabel("All Accounts");
List<ReportExecutionStatusInformation> reportExecutionList =
    engineService.getSchedulerReportExecutionStatusList(criteria);
```

Once you have a list of jobs, you can cancel those jobs using the `reportExecutionStatusInformation` interface:

```java
for (ReportExecutionStatusInformation reportExecution : reportExecutionList) {
    reportExecution.cancel();
}
```

### 10.2.4 Report Data Source Service API

JasperReports Server comes with built-in support for JDBC, JNDI, Mondrian, and XML/A data sources for reporting purposes. Each of these custom data sources has an implementation of `com.jaspersoft.jasperserver.api.metadata.`
jasperreports.service.ReportDataSourceService interface. This service is responsible for setting up and tearing down data source connections in the server.

The setReportParameterValues(Map parameterValues) is called before running a report and creates the resources needed by JasperReports to obtain a JRDataSource, then it adds them to the parameter map.

The closeConnection() method cleans up any resources allocated in setReportParameterValues().

The custom data source API enables easy integration of a new ReportDataSourceService implementation.

You can find further details on creating and configuring custom data sources in the JasperReports Server Administrator Guide or the JasperReports Server User Guide for the Community Project.

10.2.5 Report Scheduling API

Reports on the server can be executed asynchronously using the Report Scheduling API. Asynchronous report execution involves defining the report job and using the report scheduling service to schedule it.

10.2.5.1 Report Jobs

A report job definition consists of:

- Report attributes. Each job must be linked to a single JasperReport on the server. If applicable, the job must also contain values for the report input parameters.

- Scheduling attributes. Instruct the scheduler when to execute the job. A report job can be a one-time job that can be launched immediately or at a specified moment, or a recurring job that runs repeatedly at specified times.

  Two types of recurrence are supported by default:

  - Simple recurrence can be used to schedule a job to repeat at fixed time intervals, such as every 4 hours, every 2 days, or every week. The job start date attribute is used to specify the moment of the first occurrence. The user can specify the number of times the job should occur or an end date for the job.

  - Calendar recurrence can be used to schedule a job to repeat at specified calendar moments, such as at 8 PM every work day or on the first of every month.

- Output attributes. Instruct the scheduling service on what to do with the report output. The job creator has to specify the report output formats and the repository location where the report output is saved. It can also specify one or more addresses to which email notifications is sent. The notifications can include the report output.

A report job definition is an instance of the com.jaspersoft.jasperserver.api.engine.scheduling.domain.ReportJob bean class. To instantiate a new report job definition, you would use code similar to the following:

```
ReportJob job = new ReportJob();
    job.setLabel("foo"); //set the job label
    job.setDescription("bar"); //set the job description
```

The job source is created as a sub-bean:

```
ReportJobSource source = new ReportJobSource();
    source.setReportUnitURI("/test/reportURI"); //set the report to run
    Map params = new HashMap();
    params.put("param1", new Integer(5));
    params.put("param2", "value2");
    source.setParametersMap(params); //set the report input parameter values
    job.setSource(source); //set the job source
```

The job trigger is used to specify when the job should occur. The basic com.jaspersoft.jasperserver.api.engine.scheduling.domain.ReportJobTrigger bean type is abstract; two concrete types extend it: com.jaspersoft.jasperserver.api.engine.scheduling.domain.ReportJobSimpleTrigger and com.jaspersoft.jasperserver.api.engine.scheduling.domain.ReportJobCalendarTrigger.
For example, to create a job that fires 20 times every 10 days you would use code similar to this:

```java
date startDate = ...;
ReportJobSimpleTrigger trigger = new ReportJobSimpleTrigger();
trigger.setStartDate(startDate);
trigger.setOccurrenceCount(20);
trigger.setRecurrenceInterval(10);
trigger.setRecurrenceIntervalUnit(ReportJobSimpleTrigger.INTERVAL_DAY);
job.setTrigger(trigger);
```

Next, you need to specify the job output attributes. To set the output filename and format, use code similar to the following:

```java
job.setBaseOutputFilename("foo"); // the base output file name
job.addOutputFormat(ReportJob.OUTPUT_FORMAT_PDF); // output PDF
job.addOutputFormat(ReportJob.OUTPUT_FORMAT_HTML); // and HTML
```

You can send your output to several different locations; the most common output destination is the repository. Alternative output locations include an FTP server or a user’s local drive. To output to the `jasperserver` repository, use code similar to this:

```java
ReportJobRepositoryDestination repositoryDestination = new
ReportJobRepositoryDestination();
repositoryDestination.setFolderURI("/test/scheduled");
// the repository folder where to output the files
repositoryDestination.setSequentialFilenames(true);
// append a timestamp to the file names
job.setContentRepositoryDestination(repositoryDestination);
```

To upload the output to an FTP server instead of the repository, use code similar to this:

```java
FTPInfo ftpInfo = new FTPInfo();
ftpInfo.setUserName("jsmith$mycompany");
ftpInfo.setPassword("_________________");
ftpInfo.setFolderPath("/Shared/Users/JSmith");
ftpInfo.setServerName("ftp-mycompany.ftpserver.com");
job.getContentRepositoryDestination().setOutputFTPInfo(ftpInfo);
```

To send the output to a user’s local drive, use code similar to this:

```java
job.getContentRepositoryDestination().setOutputLocalFolder("C:\Users\JSmith\JRS");
```
Optionally, you can instruct the reporting scheduler to send a notification once the job completes. This notice normally goes to the user who created the report:

```java
ReportJobMailNotification mailNotification = new ReportJobMailNotification();
mailNotification.addTo("john@smith.com"); // the recipient
mailNotification.setSubject("Scheduled report"); // the subject
mailNotification.setMessageText("Executed report.\n"); // the message body
mailNotification.setResultSendType(ReportJobMailNotification.RESULT_SEND_ATTACHMENT);
// send the report output as attachments
mailNotification.setSkipNotificationWhenJobFails(true); // prevents email for failed jobs
job.setMailNotification(mailNotification);
```

ReportJobMailNotification has a number of field types, including RESULT_SEND, which embeds a link in the email, RESULT_SEND_ATTACHMENT which sends the results as a zipped attachment, RESULT_SEND_ATTACHMENT_NOZIP, and RESULT_SEND_EMBED, which embeds the results as HTML content in the email. RESULT_SEND can only be used when the output is saved to the repository using setContentRepositoryDestination().

You can also optionally email an alert to the job creator, an administrative user, or both. For example, to send an alert when the job fails, use code similar to the following:

```java
ReportJobAlert alert = new ReportJobAlert();
alert.setRecipient(ReportJobAlert.Recipient.ADMIN); // sets first recipient. Other options are OWNER, BOTH, NONE
alert.setMessageText("Report failed"); // the message body
alert.setJobState(ReportJobAlert.JobState.FAIL_ONLY);
ArrayList<String> to_Addresses = new ArrayList<String>();
// list of additional addresses to receive cc
to_Addresses.add("admin@smith.com");
to_Addresses.add("admin.smith@gmail.com");
alert.setToAddresses(to_Addresses);
job.setAlert(alert);
```

The ADMIN recipient is set by role; the default is ROLE_ADMINISTRATOR. The ADMIN recipient can be changed in the administratorRole bean in <js-src>/jasperserver/jasperserver-war/src/main/webapp/WEB-INF/applicationContext-report-scheduling.xml.

For example, suppose you have used Manage > Roles in the JasperServer user interface to add the role ROLE_SCHEDULER_ADMIN. To set that user as the recipient for all ADMIN email alerts, modify the administratorRole bean as follows:

```xml
<entry key="administratorRole" value="ROLE_SCHEDULER_ADMIN">
```

### 10.2.5.2 Report Job Model

A report job model allows you to specify scheduling and output attributes for multiple report jobs at the same time. A report job model takes a list of report job IDs and a single set of attributes for all report jobs in the list.

A report job model definition consists of:
- Scheduling attributes. Instruct the scheduler when to execute the job. A report job model can specify a one-time job, a simple recurring job, or a calendar recurring job.
- Output attributes. Instruct the scheduling service what to do with the report output.

You only need to define those attributes you wish to update; empty attributes are left unchanged in the original report jobs.
A report job model definition is an instance of the `com.jaspersoft.jasperserver.api.engine.scheduling.domain.ReportJobModel` bean class, which extends `ReportJob`.

To instantiate a new report job model definition, you would use code similar to the following:

```java
ReportJobModel jobModel = new ReportJobModel();
```

To set the destination, mail notification, and schedule for a report job model, you would use code similar to the following:

```java
ReportJobRepositoryDestinationModel destinationModel = new ReportJobRepositoryDestinationModel();
destinationModel.setFolderURI("/test/operations");
jobModel.setContentRepositoryDestinationModel(destinationModel);

ReportJobMailNotificationModel mailNotificationModel = new ReportJobMailNotificationModel();
mailNotificationModel.setSkipNotificationWhenJobFails(false);
// send email even when job fails
mailNotificationModel.setIncludeStackTraceWhenJobFails
// send stack trace when job fails
jobModel.setMailNotificationModel(mailNotificationModel);

Date startDate = ...
ReportJobSimpleTriggerModel trigger = new ReportJobSimpleTriggerModel();
trigger.setStartDate(startDate);
trigger.setOccurrenceCount(20);
trigger.setRecurrenceInterval(10);
trigger.setRecurrenceIntervalUnit(ReportJobSimpleTrigger.INTERVAL_DAY);
jobModel.setTriggerModel(trigger);
```

Any report job attributes not updated by `ReportJobModel` remain unchanged. In the example above, the existing email recipient, subject, and message remain the same for the updated jobs, as well as any existing alerts.

The report scheduling service also uses `ReportJobModel` to retrieve a list of all active report jobs that match the attributes specified in the report job model. The list of report jobs retrieved via `ReportJobModel` can be sorted using the `ReportJobSortType` subclass of `ReportJobModel`. See 10.2.5.5, “Report Scheduling Service,” on page 117 for more information.

### 10.2.5.3 Report Job Summary

Report job summaries hold information returned by the scheduler service. The `ReportJobSummary` class has a number of methods that allow you to retrieve specific information about the summary. Some useful methods are:

- **getStateCode**: This method returns the execution state of the report job, such as `STATE_COMPLETE`, `STATE_EXECUTING`, etc.
- **getNextFireTime**: This method returns the next time the job is scheduled to run; returns `null` if not scheduled in the future.
- **getPreviousFireTime**: This method returns the last time the job was run; returns `null` if the job has not yet been executed.

### 10.2.5.4 Report Job ID Holder

The `ReportSchedulingService` assigns every active report job a report job ID. This ID can be wrapped using the `ReportJobIDHolder` class; `ReportJobIDHolder` is used by some report scheduling API methods.
10.2.5.5 Report Scheduling Service

The scheduling service is used to schedule a report job and provide information about existing jobs. The built-in scheduling service implementation consists of a Hibernate-based component that persists job definitions and a Quartz scheduler that schedules and fires the jobs.

Once a report job definition is created, it is passed to the scheduling service:

```java
ReportSchedulingService schedulingService = ...;
ReportJob job = ...;
schedulingService.scheduleJob(executionContext, job);
```

The `ReportSchedulingService` is not a Java object that is included in the API; instead, you must inject a `ReportSchedulingService` instance (that is, define a bean called `reportSchedulingService` using Spring). Your bean should include custom code that produces the desired behavior. For more information on defining a bean, see section 10.2.1.1, “Accessing API Implementations Using the Spring Framework,” on page 106.

The scheduling service also contains methods for the removal of one or several existing report jobs: `removeScheduledJob` and `removeScheduledJobs`.

To load the full report job definition for a job, use the `getScheduledJob` method. The job definition can be altered then updated using the `updateScheduledJob` service method.

A list of report jobs can be altered and updated using the `updateScheduledJobs` service method. `updateScheduledJobs` takes a `ReportJobModel` and updates the specified jobs to match the attributes in the `ReportJobModel`; unspecified attributes remain unchanged. The trigger is handled somewhat differently from the other attributes. A Boolean parameter, `replaceTriggerIgnoreType`, specifies one of two options:
- **true**: Replace the trigger in all listed report jobs with the trigger in the `ReportJobModel`.
- **false**: If a trigger is present in the report job model, check that all listed report jobs have the same trigger type (`SimpleTrigger` or `CalendarTrigger`) as the report job model. If one or more report jobs have a different trigger type, update will fail for all report jobs.

For example, to update two report jobs, including the trigger, to match the parameters in a specified report job model, you would use code similar to the following:

```java
reportJobs.add(job_01);
reportJobs.add(job_02);
ReportJobModel jobModel = ...
updateScheduledJobs(executionContext, reportJobs, jobModel, true) //replaceTriggerIgnoreType - when true, replace trigger in the report jobs with the trigger from the model.
```

Caution is advised when updating the job trigger, since the original Quartz trigger is dropped and a new trigger that corresponds to the updated attributes is created.

Two methods of the scheduling service let you retrieve a list of jobs. The retrieved list consists of instances of `com.jaspersoft.jasperserver.api.engine.scheduling.domain.ReportJobSummary` that contain basic job attributes, plus runtime attributes such as job status and previous/next fire times.

- **getScheduledJobSummaries** can be used as follows:
  - Retrieves job summaries of all active report jobs defined in the scheduler.
  - With a `reportUnitURI`, retrieves the list of job summaries for scheduled jobs for a report unit.
  - With a `ReportJobModel` along with other parameters, retrieves the list of scheduled job summaries that match the criteria specified by the `ReportJobModel`.
- `getJobsByNextFireTime` retrieves the list of all jobs with a next fire time in a specified time interval.

For example to get all active jobs that match a report job model, you would use code similar to the following:

```java
ReportJobModel reportJobCriteria = ...
int startIndex = 5 // return all jobs after the first 5 (starts with 0)
int numberOfRows = 30 // number of jobs returned per page
getScheduledJobSummaries(executionContext, reportJobCriteria,
startIndex,
numberOfRows,
SORTBY_REPORTNAME, // value of enum class ReportJobModel.ReportJobSortType
true); // when true, sort in ascending order
```

To get all jobs that are scheduled with their next fire time between `startDate` and `endDate`, you would use code similar to the following. The next fire time is the value retrieved by `ReportJobSummary.getNextFireTime`.

```java
List<ReportJobSummary> jobList = new
Date startDate = ...
Date endDate = ...
List<ReportJobSummary> jobList =
  schedulingService.getJobsByNextFireTime(executionContext,
    null, startDate, endDate, null);
```

The pause and resume methods let you pause or resume a list of jobs. To pause all the jobs retrieved by the previous call, use code similar to the following. If an alert is set, pausing the job triggers the alert:

```java
schedulingService.pause(jobList, true);
```

The `pauseById` and `resumeById` methods let you pause or resume a `ReportJobIDHolder` list.

### 10.2.5.6 Report Jobs Scheduler

The `ReportJobsScheduler` service includes methods for adding, getting, and deleting calendars. Calendars in the `ReportJobsScheduler` service are implementations of the Quartz `Calendar` interface. They specify times during which scheduled jobs do not fire. For information about Quartz calendars, see the Quartz API documentation.

The `ReportJobsScheduler` service is used internally by the central scheduling service. Except for the calendar methods, most other methods in the `ReportJobsScheduler` service should not be accessed directly by the report scheduling code.

For example, to register a Quartz calendar, `myHolidayCalendar()`, with the `ReportJobsScheduler`, you would use code similar to the following:

```java
ReportJobsScheduler.addCalendar("US Holiday Calendar",
  myHolidayCalendar(),
  true, // overwrite any existing calendar with the same name
  true) // update existing triggers that refer to this calendar
```

Other methods allow you to delete a calendar, retrieve a calendar by name, or get a list of the names of all registered calendars: `deleteCalendar`, `getCalendar`, and `getCalendarNames`.

Once you have added a calendar, you can use it in any number of job triggers. For example, to create a trigger that tells a job to run every Monday at 1:00 A.M., unless it is a United States holiday as specified in `myHolidayCalendar()`, you would use code similar to the following:
You can use a trigger like this to set the holiday calendar for a number of ReportJobs using ReportJobModel. Set replaceTriggerIgnoreType to true to ensure that the trigger is updated for all ReportJobs.

### 10.2.6 Users and Roles API

Access to all JasperReports Server functionality is based on assigned user-level and role-level permissions. Thus, managing users and roles is a critical aspect of the public API.

The `com.jaspersoft.jasperserver.api.metadata.user.service.UserAuthorityService` interface has methods for creating, modifying, and removing users and roles. The API manipulates only these two types of entities for which public interfaces are available:

- Users are represented by the `com.jaspersoft.jasperserver.api.metadata.user.domain.User` interface.
- Roles are represented by the `com.jaspersoft.jasperserver.api.metadata.user.domain.Role` interface.

A new user can be defined in a few easy steps:

```java
User workingUser = userAuthService.newUser(null);
workingUser setUsername("john");
workingUser.setTenantID("organization_1");
workingUser.setPassword("changeme");
workingUser.setFullName("John Doe");
workingUser.setEnabled(true);
workingUser.setExternallyDefined(false);
userAuthService.putUser(null, workingUser);
```

The `setTenantId` method specifies the organization the user belongs to. However, note the following:

- If you are using commercial editions of JasperReports Server, you should use the method in most cases, but if your instance hosts only a single instance, this method should set most user’s organization to the default (organization_1).
- If this is a special administrative user (similar to superuser) that shouldn’t be affiliated with an organization, do not call `setTenantId`.

To get the user information from the database, the `getUser` method can be called by providing the user name.

Users can be removed from the database by name with the `deleteUser` method.

Equivalent methods for managing roles are available in the `UserAuthorityService`. You can assign users to roles using the following two methods:

```java
public void addRole(ExecutionContext context, User aUser, Role role);
public void removeRole(ExecutionContext context, User aUser, Role role);
```

Additional methods for finding users with specific roles are available; you can find details about them if you consult the Javadoc for the `UserAuthorityService` interface.
10.2.7 Object Permissions API

An object permission represents the right to perform a certain action on a repository resource by a user. Access to all functionality relies on a security mechanism that checks if the user has the right to perform the current action on the given object or resource. The `com.jaspersoft.jasperserver.api.metadata.user.service.ObjectPermissionService` interface grants or revokes permissions on an object to users and roles; it has methods for creating and removing permissions on objects and recipients.

An object permission is represented by an implementation instance of the `com.jaspersoft.jasperserver.api.metadata.user.domain.ObjectPermission` interface and holds information about the recipient (User or Role instance), the type of permissions granted to the user (combination of numeric constants defined in the Spring Security class `org.springframework.security.acl.basic.SimpleAclEntry`), and the resource to which they apply.

The following illustrates how to create an object permission on an image resource within the repository:

```java
Resource resource = ..an existing repository resource..;
ObjectPermission permission = objectPermissionService.newObjectPermission(null);
permission.setURI(resource.getURIString());
permission.setPermissionRecipient(user);
permission.setPermissionMask(SimpleAclEntry.READ);
objectPermissionService.putObjectPermission(null, permission);
```

Revoking object permissions can be done with one of the following public methods exposed by this service:

```java
public void deleteObjectPermission(ExecutionContext context, ObjectPermission objPerm);
public void deleteObjectPermissionForObject(ExecutionContext context, Object targetObject);
public void deleteObjectPermissionsForRecipient(ExecutionContext context, Object recipient);
```

10.2.8 OLAP Connection API

This section describes functionality that is available only in Jaspersoft OLAP. Contact Jaspersoft to obtain the software.

OLAP interactions through the Jaspersoft OLAP user interface and web services based on XML/A are supported by the repository and dedicated APIs. The repository can contain the following OLAP-related objects:

- **OlapUnit**. This is the data needed for an analysis view. It contains an MDX query and an OLAPClientConnection.
- **MondrianConnection**. Implementor of OLAPClientConnection. It contains a Mondrian schema and a JDBC or JNDI connection.
- **XMLAConnection**. Implementor of OLAPClientConnection. It contains a URL to an XML/A service and an optional data security definition.
- **MondrianXMLADefinition**. Jaspersoft OLAP can operate as an XML/A server on top of Mondrian connections. These objects catalog what can be accessed through XML/A.

The OLAP Connection API provided by Jaspersoft OLAP is simple, as most of the underlying functionality is within Mondrian (OLAP query engine, XML/A server) or JPivot (OLAP user interface). This call creates a JPivot-compatible OlapModel, based on the relevant OlapUnit:

```java
public OlapModel createOlapModel(ExecutionContext context, OlapUnit olapUnit );
```
The call should be made and the model object put into the user session before redirecting to the JPivot JSP viewOlap.jsp. An example is in ViewOlapModelAction:

```java
OlapUnit olapUnit = (OlapUnit) getRepository().getResource(executionContext, viewUri); OlapModel model = getOlapConnectionService().createOlapModel(executionContext, olapUnit);
```

The following call retrieves the server-wide Mondrian properties:

```java
// create a local Mondrian OLAP connection corresponding to a Mondrian connection resource defined in the repository
MondrianConnection connectionResource = ..get the resource from the repository. MondrianConnection connection = MondrianOlapUtil.createConnection(connectionResource); MondrianOlapModel model = MondrianOlapUtil.createModel(connection, executionContext);
```

See the Mondrian Technical Guide for details.

These calls can be used to validate an OlapUnit object while you are editing in the UI:

```java
public ValidationResult validate(ExecutionContext context, OlapUnit unit); public ValidationResult validate(ExecutionContext context, OlapUnit unit, FileResource schema, OlapClientConnection conn, ReportDataSource dataSource);
```

### 10.2.9 Flushing the Analysis Cache Using the API

Jaspersoft OLAP maintains a cache of previously-retrieved results in order to achieve high performance. There is a simple interface for flushing the entire cache programmatically, an action that is required when new data is inserted into databases while Jaspersoft OLAP is running.

```java
public interface OlapManagementService { public void flushOlapCache(); }
```

The interface can be configured as a Spring bean or instantiated with a standard Java constructor call. com.jaspersoft.jasperserver.api.metadata.olap.service.impl.OlapManagementServiceImpl is the default implementation of the interface.

### 10.3 Ad Hoc Launcher Java API

This section describes functionality that can be restricted by the software license for JasperReports Server. If you don’t see some of the options described in this section, your license may prohibit you from using them. To find out what you’re licensed to use, or to upgrade your license, contact Jaspersoft.
When users want to create a new view in the Ad Hoc Editor, they are normally presented with a page that allows them to choose the Topic, Domain, or OLAP client connections that will form the basis of the view. The selected Topic or Domain provides a query and a list of fields that can be used in the new view.

The Ad Hoc Launcher API allows a developer to replace the Source dialog with an alternative user interface for selecting data. This replacement for the Source dialog is referred to as an Ad Hoc launcher because the user can launch the Ad Hoc Editor interface after selecting and setting up the data. Whereas the Source dialog can only give users a choice of the queries previously stored in the repository, an Ad Hoc launcher implementation enables them to have full control over the data source, query, and fields to be used. This gives developers a wide latitude for creating data selection interfaces tailored to the needs of their users.

Creating an Ad Hoc launcher involves modifying the JasperReports Server web application by adding one or more servlet pages that gather user input for the setup required by the Ad Hoc Editor. When the user is ready to start laying out the view, the Ad Hoc launcher starts up the Ad Hoc Editor by redirecting to its URL.

Examples of possible Ad Hoc launcher applications include the following:

- A generic SQL query builder which allows the user to choose a JDBC data source, view the tables available from it, and build a query against one or more of the tables. This approach is demonstrated in browseDB, the sample Ad Hoc launcher that is described below.
- A query builder based on application-specific metadata, such as a list of pre-defined queries maintained in its own table.
- An interface for constructing queries against a custom data source that has metadata facilities, such as Hibernate.
- A “dumb” query builder in which the user chooses a data source from the repository and enters query text and field definitions manually. This would be analogous to creating a JasperReport by editing the JRXML.

The details of the setup required in an Ad Hoc launcher are described in the next section.

10.3.1 Communicating with the Ad Hoc Editor using AdhocTopicMetadata

This section describes how the Ad Hoc Editor initializes its reporting data, both when a Topic is selected and when an Ad Hoc launcher is active.

The Ad Hoc Editor uses the AdhocTopicMetadata Java class to represent an Ad Hoc Topic. Topics are typically stored in the repository as ReportUnits, but they can also be created by an Ad Hoc Launcher implementation. If the user starts the Ad Hoc Editor from the Topics page, AdhocTopicMetadata is set up as follows:

1. A new instance of AdhocTopicMetadata is created.
2. The report representing the selected Topic is read.
3. AdhocTopicMetadata.initDatasource() is called with the URI of the data source used by the Topic.
4. The JRXML resource for the Topic’s report is read.
5. AdhocTopicMetadata.setQueryText() is called with the query from the JRXML.
6. AdhocTopicMetadata.setQueryLanguage() is called with the query language from the JRXML.
7. The list of fields defined in the JRXML is read.
8. Each field is turned into an AdhocField instance and passed to AdhocTopicMetadata.addField().
9. If the user is creating a new view, the desired Ad Hoc type (table, crosstab, chart) is passed to AdhocTopicMetadata.setReportType().

If an Ad Hoc launcher is being used, it needs to place an instance of AdhocTopicMetadata in the servlet session, where the Ad Hoc Editor can use it. The following code examples are from the BrowseDBController.java source file from the browseDB example in section 10.3.3, “A Sample Ad Hoc Launcher,” on page 125.
To initialize an instance of the `AdhocTopicMetadata` class for use by the Ad Hoc Editor:

1. Create a new `AdhocTopicMetadata` instance, then initialize the data source by calling `initDatasource()` with the URI of a data source in the repository (which in this example is coming from an HTTP request parameter). Use `SessionAttributeManager` to create a new client key and store the `AdhocDate` instance in the session:

   ```java
   String datasourceURI = req.getParameter(DATASOURCE_URI);
   AdhocTopicMetadata data;
   long clientKey;

   // if you have a datasource URI, you just started...
   // so we need to init AdhocTopicMetadata and put it in session
   if (datasourceURI != null) {
      data = engine.getAdhocMetadataFactory().getTopicMetadata();
      data.setLocale(req.getLocale());
      data.initDatasource(engine, datasourceURI);
      // get new client key for Ad Hoc
      clientKey = SessionAttributeManager.getInstance().createClientKey();
      SessionAttributeManager.getInstance().setSessionAttribute(
         AdhocConstants.ADHOC_DATA, data, clientKey, req);
   } else {
      // code to handle existing view
   }

   String tableName = dbdata.getSelectedTable().getName();
   data.setQueryLanguage("sql");
   StringBuffer query = new StringBuffer("select * from " + tableName);
   Iterator sfi = dbdata.getSelectedTable().getFieldList().iterator();
   while (sfi.hasNext()) {
      DBField f = (DBField) sfi.next();
      DBField jf = f.getJoinField();
      if (jf != null) {
         query.append("\n");
         String fromField = f.getField().getName() + "." + f.getName();
         String toField = jf.getField().getName() + "." + jf.getName();
         query.append("join " + jf.getField().getName() + "+ on (" + fromField + " = " + toField + ")");
      }
   }
   data.setQueryText(query.toString());
   ```

2. Initialize the query to be used for the Topic by calling `setQueryText()` and `setQueryLanguage()`:

   ```java
   String tableName = dbdata.getSelectedTable().getName();
   data.setQueryLanguage("sql");
   StringBuffer query = new StringBuffer("select * from " + tableName);
   Iterator sfi = dbdata.getSelectedTable().getFieldList().iterator();
   while (sfi.hasNext()) {
      DBField f = (DBField) sfi.next();
      DBField jf = f.getJoinField();
      if (jf != null) {
         query.append("\n");
         String fromField = f.getField().getName() + "." + f.getName();
         String toField = jf.getField().getName() + "." + jf.getName();
         query.append("join " + jf.getField().getName() + "+ on (" + fromField + " = " + toField + ")");
      }
   }
   data.setQueryText(query.toString());
   ```
3. Add field definitions by creating new `AdhocField` instances and calling `addField()`:

```java
if (jf != null) {
    Iterator jtfi = jf.getTable().getFieldList().iterator();
    while (jtfi.hasNext()) {
        DBField jtf = (DBField) jtfi.next();
        AdhocField af = new AdhocField(jtf.getName(), getJRType(jtf.getDbType()));
        af.setDisplay(jtf.getLabel());
        data.addField(af);
    }
}
```

AdhocField instances require the following information:

- **Name.** The name of the field (set in the `AdhocField` constructor, or by calling `setName()`).
- **Type.** The name of the Java class representing the type of the field's data (set in the `AdhocField` constructor, or by calling `setType()`).
- **Display.** The string used as a label for the field in the Ad Hoc Editor (set by calling `setDisplay()`).

4. Set the type by calling `AdhocTopicMetadata.setAdhocReportType()`. Valid values are `table`, `crosstab`, and `chart`:

```java
String viewType = req.getParameter(AdhocAction.REPORT_TYPE);
if (viewType != null) {
    data.setAdhocReportType(viewType);
}
```

### 10.3.2 Integration with JasperReports Server

You can register your launcher with the Ad Hoc Editor so that, if the user starts a view with your launcher and later saves it, the launcher can be started again when the new view is edited.

**To register an Ad Hoc launcher:**

1. Choose a reference name for the Ad Hoc Launcher; this example assumes the name is `test`.
2. Define a Spring bean that registers the launcher’s name and URI. The following shows a portion of the `<js-install>` samples\customAdHoc\webapp\WEB-INF\applicationContext-adhoc-custom.xml file:

```xml
<bean class="com.jaspersoft.jasperserver.api.common.util.spring.GenericBeanUpdater">
    <property name="definition" ref="setCustomAdhocProps"/>
    <property name="key" value="test"/>
    <property name="valueType" value="idRefMap"/>
    <property name="value">
        <idref bean="sampleAdHocLauncher"/>
    </property>
</bean>

<util:map id="sampleAdHocLauncher">
    <entry key="editorURI" value="browseDB/browseDB.html?action=displayTables"/>
</util:map>
```

In this example, note the property named `key` with the value `test`; this element defines the name described in step 1.
3. Before you launch the Ad Hoc Editor, call `AdhocTopicMetadata.setCustomType()` with the name used to register the application.

```java
AdhocTopicMetadata data = (AdhocTopicMetadata) SessionAttributeManager.getInstance().getSessionAttribute(
    AdhocConstants.ADHOC_DATA, req);

data.setCustomType("test");
```

The launcher can also be used to store custom data in a saved Ad Hoc view, so that when you relaunch the view, you can retrieve the data conveniently. The data is persisted as a byte stream resource in the Ad Hoc view.

**To store data in a view:**
1. Create an implementation of `CustomAdhocDataHandler`, which tells the Ad Hoc Editor how to create, serialize, and deserialize the object you want to persist.
2. Call `AdhocTopicMetadata.setCustomDataHandler()` with an instance of your implementation:

```java
data.setCustomDataHandler(new BrowseDBDataHandler());
BrowseDBData dbdata = (BrowseDBData) data.getCustomData();
```
3. Call `AdhocTopicMetadata.getCustomData()` to access your custom data object.

**10.3.3 A Sample Ad Hoc Launcher**

`browseDB` is an example of how you might use the Ad Hoc Launcher API to create your own query editor. While it illustrates the API’s basic functionality, and is a useful example for administrators and developers who plan to implement their own launcher, it isn’t intended for end users. The application supports only the most basic SQL functions; it does not support such operations as a 2-column primary key or joins from parent to child (you must join child to parent).

In order to construct queries in `browseDB`, you must know the primary keys of the tables in the data source and any database constraints on joins.

**10.3.3.1 Installing the Sample Editor**

**To install the `browseDB` editor:**
1. Determine the location of the JasperReports Server web application; for the default installation with the bundled Tomcat, it is `<js_install>/apache-tomcat/webapps/jasperserver-pro`.
2. In an appropriate editor, open the file `<js_install>/samples/customAdHoc/build.xml`.
3. In the file, set the `webAppDir` property to the web application location in step 1.

![Figure 10-1 Setting the `webAppDir` Property](image)

4. Save and close the file.
5. On a command line, change directory to `<js_install>/samples/customAdHoc`. 
6. Run `<js-install>/apache-ant/bin/ant deploy`.
   The ant utility compiles the Java source, deploys the browseDB files to the appropriate folders, and displays a BUILD SUCCESSFUL message.

   ![](Image)
   If there are permissions errors, make sure you have ownership or write permission in the `<js-install>` folder.


10.3.3.2 Using browseDB

To define a simple query in browseDB:
1. In a web browser, start JasperReports Server and login with administrator privileges.

   ![Image](Figure 10-2 BrowseDB Pick Data Source Page)

3. Select a data source from the drop-down and click **Display Tables**. In this example, select the FoodmartDataSourceJNDI. A list of the tables in the data source appears.

   ![Image](Figure 10-3 Tables From the Selected Data Source)
4. To select the main table for the query, click that table’s name. In this example, click the employee table.

The selected table appears at the top of the list as the Main query table. It is expanded to show all the columns in the table.

![Figure 10-4 Main table for the Query Selected](image)

To join a table to the query:

1. Before you can join a table, you must designate one of its columns as a primary key. Expand the table you are joining by clicking . If you click the folder icon or name instead, that table becomes the main table of the query, replacing the one you selected. In this example, expand the store table.

![Figure 10-5 The Primary Key store_id in the store Table](image)
2. Indicate the additional table’s primary key by clicking the appropriate column name and clicking **Set the selected column as primary key** at the top of the page. In this example, select the `store_id` column of the `store` table as the primary key.

The additional table is added to the **Join** drop-down. The drop-down shows all the additional tables for which you select a primary key. In this example, the `store` table is added to the drop-down.

3. In the **Join** drop-down, select the table to add. Since you only expanded the store table, it should already be selected.

4. In the main query table, select the column to which the additional table should be joined. In this example, select the `employee` table’s `store_id` column.

5. Click **Join selected column on main table to**.

   The additional table (`store`) is added to the main query table as the join table. Expand the join table to see all of its fields.

   The following picture shows the join table, along with some of the corresponding fields as they are displayed in the Ad Hoc Editor.

To open the Ad Hoc Editor with this query:

1. In the Pick Datasource window, click a type (**Table**, **Crosstab**, or **Chart**). In this example, click **Table**.

   The Ad Hoc Editor opens. All the columns of the selected query tables appear in the editor’s list of available fields.

2. Define and save your view in the usual way. For more information, refer to the **JasperReports Server User Guide**.

To open a saved Ad Hoc Report created with the sample Ad Hoc launcher:

1. Locate the view saved from browseDB in the repository.

2. Click the view.

3. Because this view was saved, there is no longer the choice of Table, Crosstab, or Chart. The view will open to the format in which it was saved.
10.4 Repository HTTP API

The HTTP interface provides an easy way to implement the API for accessing repository objects. However, the HTTP interface is not embeddable in the same way that the web services and Java APIs can be embedded in non-Jaspersoft applications. Rather, the HTTP interface is used primarily as shortcuts or entry points to commonly used features or content. Typically, the HTTP interface is accessed programmatically by generating the URL that returns HTML that displays either the desired object (in the case of report execution and repository URLs) or the content of repository objects (such as report output in the form of content resources).

For example, the SuperMart demonstration data that ships with JasperReports Server commercial editions makes frequent use of the HTTP interface. This simple API allows users to interact with the SuperMart dashboard, dynamically pass parameters from a report to an analysis view, and display the user’s personal folder based on the login ID.

As shown in the following examples, the major entry points are:

- flow.html
- olap/**
- fileview/**

The examples in this section are generalized to describe both the community and commercial editions of JasperReports Server. For simplicity, this section refers to the deployment context generically. For example:

```
http://<host>:<port>/<context>/flow.html?_flowId=viewReportFlow&reportUnit=/reports/test
```

With the default deployments, the `<context>` refers to:

- `jasperserver-pro` in the commercial editions
- `jasperserver` in the community project

The Spring Web Flow has quite different syntax for flow files as compared to earlier versions, so if a user has a custom flow, it needs to be upgraded. Spring offers a special tool, `WebFlowUpgrader`, which helps to upgrade the flows. For information about migrating from Spring Web Flow 1.0 to Spring Web Flow 2.0, see the Webflow documentation.

10.4.1 Executing ReportUnits

The following sections provide examples and details about URLs that execute reports.

10.4.1.1 Simple Report Execution

The HTTP interface can execute and export reports within the JasperReports Server web application.

The following example calls a report without any parameters and exports to the default format (HTML):

The URL is:

```
```

This is the simplest possible report execution URL. The following section explains more advanced options.

10.4.1.2 Passing ReportUnit Execution Parameters

The following example executes the same report as shown in the previous section, but also passes 4012 as an input control parameter and exports to PDF instead of HTML:

```
```

Note the URL parameters:

- `&customerID=4012` indicates that the value 4012 should be passed to the input control called `customerID`. The report returns data about customer 4012.
&output=pdf indicates that the output should be generated in PDF format.

If the report parameter supports multiple values, you can specify them using the ampersand (&); for example:

```
```

This section describes more such parameters.

The report execution parameters can either be reserved parameters that the server uses to determine general attributes of the report execution, or they can be arbitrary parameters that correspond to the report’s input controls/parameters. The parameters are specified as standard HTTP GET parameters (that is, they are in the form name=value and are separated by ampersands (&)).

The following general parameters are recognized by JasperReports Server:

- **reportUnit** specifies the URI of the report unit resource in the repository.
- **output** (optional) specifies the output format. Values for this parameter are keys for the report exporters configured in the server. By default, the server recognizes the following output types: pdf for PDF, xls for Excel (Paginated), xlsNoPag for Excel, xlsx for XLSX (Paginated), xlsxNoPag for XLSX, rtf for RTF, csv for CSV and swf for the Flash report viewer. When this parameter is not specified, the default format is HTML displayed in the report viewer.
- **reportLocale** specifies the locale in which the report should be executed. A locale is passed as code consisting of a lower-case two letter ISO-639 language code, followed by optional upper-case two letter ISO-3166 country code and a locale variant, separated by underscore (the format is identical to the standard Java locale programmatic names).
- **userlocale** also specifies a locale, but in this case, it specifies the locale of the user. It can be added to the startup URI, as in this example:


- **j_username** and **j_password** pass the credentials to authenticate a user with the server. The user name should correspond to a valid user, and password should be the user password (in clear text).

If you use a commercial edition and host more than one organization, the organization ID or alias must be passed along with the user ID as part of the **j_username** parameter. The format is j_username=userID|orgID.

If such credential parameters are not present, and no authenticated server session exists, and the server is not configured to use automatic authentication mechanisms (such as single sign-on), the server prompts the user for a user name and a password; after logging in, she is redirected to the report execution page. These authentication parameters let the user skip the login page and directly access the report execution page.

Note that these two parameters are not specific to report execution URLs; they can be used for any URLs that point to a JasperReports Server web page.

- **pageIndex** (optional) specifies the initial page that should be displayed when launching the target report. The page index is 1-based; if a negative page index or a page index greater than the number of pages in the report is used, the report opens at the first page. This parameter is only effective when HTML is used as output.
- **anchor** (optional) specifies the name of an anchor from the target report at which the report should open. If an anchor with the specified name is not found in the report, the first page of the report is shown. The parameter is only effective when pageIndex is not specified and when HTML is used as output.

In addition to these standard parameters, report execution URLs can contain parameters that provide values for the report input controls/parameters. The URL parameter names must match the name of the corresponding report input control. The values used for such URL parameters depend on the type of input control:

- For simple, single value input controls, the value is a URL parameter value:
  - If the type of the input control is text, the URL parameter value is directly used as input control value.
  - If the type of the input control is numeric, the URL parameter value is the numerical value formatted according to standard rules, using a period (.) as the decimal separator.
  - If the type of the input control is date or date/time, the URL parameter value is the date/time value formatted according to the `yyyyMMddHHmmss` format (for example, `20090621054500` for June 2, 2009, 05:45 AM). This value is interpreted as being in the server's default time zone.
  - For boolean (check box) input controls, the URL parameter value is either `true` or `false`. 

---

130
• For input controls that refer to static list of values, the URL parameter value is the key/value of the list entry. For example, to select first value in a list called ListInput, use the parameter &ListInput=1.

• For input controls that rely on a query, the URL parameter value corresponds to the query key/value column. For example, to set a query-based control to the value l_meade, use the parameter &QueryInput=l_meade.

• For multi-value input controls, multiple occurrences of the same URL parameter can be use. For example, parameter=value1&parameter=value2&parameter=value3.

You can use a special marker URL parameter for multi-value input controls to specify that an empty list should be used as input control value. In this case, the name of the marker URL parameter is the name of the input control, prefixed by an underscore; it doesn't require any value. This is useful when a multi-value input control has a non-empty list as its default value, and the user wants to override the default value with an empty list.

For example, consider a multi-value input control named MultiInput. By default, this parameter is list of two values. To override this list of values with another set of two value, you could use the parameter &MultiInput=item1&MultiInput=item2, where item1 and item2 are the overriding list values. To override the default with an empty list, use the parameter &_MultiInput.

If the report parameter values included in a report execution URL are not valid (for example, if a required parameter is missing or a parameter value is not valid), the user is prompted with the input controls so he can correct the values.

### 10.4.2 Linking to Content

The HTTP interface can return generated content saved to the repository in PDF, HTML, Excel, or RTF format.

The following example links to a PDF file stored in the repository:

```
```

### 10.4.3 Viewing Resources in the Repository

The following example displays all resources saved in the /reports/test folder in the repository:

```
http://<host>:<port>/<context>/flow.html?_flowId=searchFlow&folderUri=/reports/test
```

The repository search mechanism was upgraded in 4.0 and the syntax for selecting a folder in the repository was updated in 4.7. HTTP interfaces developed prior to 4.7 should be updated to use the `searchFlow&folderUri` syntax to access a folder in the upgraded repository. HTTP interfaces developed in versions 4.0 - 4.5.1 may have trouble accessing a folder in the repository.

The following example displays all resources of type `olapview` (analysis view) saved in all folders in the repository:

```
http://<host>:<port>/<context>/flow.html?_flowId=olapViewListFlow
```
CHAPTER 11 CUSTOMIZING THE USER INTERFACE

JasperReports Server is highly customizable because it is built on the Spring Framework and uses web standards such as Cascading Style Sheets (CSS) and JavaServer Pages (JSP). When the server is embedded in a web application or portal, its user interface (UI) can be customized to extend functionality and better reflect the parent application.

As with any large web application, the logic to generate the JasperReports Server UI is complex and relies on several mechanisms. They are listed here from simplest to most complex.

- Themes – The themes mechanism exposes the CSS of the UI through the repository. This makes it easy for administrators to change the appearance of the UI, such as images, colors, font size, spacing, and even the general layout. The theme mechanism is described in detail in the JasperReports Server Administrator Guide. Refer to that document first.

- SiteMesh – The SiteMesh decorator mechanism creates the header and footer for every page of the server. Decorators provide a quick way to edit the overall appearance of the web app, such as branding and copyright.

- Java Server Pages (JSP) and JavaScript – These are the templates and logic, respectively, that generate the pages of JasperReports Server. Edit these files to change the content of individual pages or the way a page is generated. This chapter assumes you are familiar with JSP and JavaScript syntax.

- Action Model – This mechanism provides a simple way to edit any menu in JasperReports Server. The simple XML syntax lets you remove default menu items, restrict their visibility based on roles, and add new menu items if you have implemented an action.

- Spring MVC (Model, View, and Controller) and Spring Web Flow are frameworks for creating states and transitions that represent a business process in a web application. By creating custom flows, you can add your own sequence of pages that integrate with the server.

Themes can be modified in a running server and changes can be seen immediately by all users. For all other types of customization, you need to edit the files that are deployed in the web app. If you are modifying files in the web application, you then need to redeploy the web app in the app server. In some cases, you need to modify source code, in which case you must re-compile the source code and redeploy the web app in the app server.

This chapter includes the following sections:

- Changing the UI With Themes
- Working With Web App Files
- Customizing the Branding with SiteMesh
- Customizing JSP and JavaScript for the Login Page
- Setting the Home Page
- Customizing the Report Rendering Page
- Customizing Menus
- Working With Source Code Files
- Adding a Custom JSP Page in a Spring Web Flow
11.1 Changing the UI With Themes

The themes mechanism uses CSS to render the UI and exposes the CSS for easy modification. The CSS files are stored in the repository and can be downloaded, uploaded, and made active through the UI while the server is running. In fact, the server must be running and you must be logged in as an administrator to modify the themes.

You still need an external editor to modify the contents of the CSS files. For more information about CSS, see http://www.w3.org/Style/CSS/. This chapter focuses on what CSS needs to change, not the procedures for making changes.

This section walks through several simple changes to the web UI. These modifications take effect when you make your new theme files active. You don’t need to recompile any JasperReports Server source code, or even to restart the server, as is the case in later sections. However, changing the theme only affects the look and feel of the interface, it does not fundamentally alter the functionality of the server.

For more extensive changes, you need to change the JSP files that control the logic of the server and determine what users see, not just how they see it. Those customizations are covered in the other sections of this chapter.

11.1.1 Working with Themes

In commercial editions of JasperReports Server, the hierarchy of organizations, and even the single default organization can inherit themes from the root, or system, theme. Depending on your needs, you may want to implement your theme at the root level or at an organization level. This section focuses on the CSS and image files to modify in a theme, but you may still deploy that theme anywhere you wish.

You can create theme folders directly in the repository, or you can create them offline and upload them as a ZIP archive file. The procedures in this section work with either of these methods; use the method that works best for your customizations.

Finally, several customizations can be combined into one theme. Some CSS files may contain values that you override in another file. And through inheritance, the themes defined in one organization can be expressed in all child organizations. You must plan your theme deployment carefully and test it with end-users to ensure it works the way you intend.

For more information about how themes work, see the JasperReports Server Administrator Guide (or the JasperReports Server Community Project User Guide). Familiarize yourself with themes and the themes mechanism in order to create the theme that implements all the customizations you want on the target organization or organizations.

11.1.2 Changing the Logo

One very simple way to customize JasperReports Server is to replace the Jaspersoft logo with your own. Your logo should be approximately the same size as the Jaspersoft logo: 115 pixels wide by 20 pixels high.

There are two ways to change the logo in CSS:

- If your logo is roughly the same size or has the same dimensions as the Jaspersoft logo, replace the logo file.
- If your logo cannot be resized or has different dimensions, change the CSS to load your own logo file.
The Jaspersoft logo is white on a transparent border and is displayed on the blue background of the default theme. Make sure your logo is visible on this background. You can also change the background color to match your logo as well, as explained in section 11.1.4, “Changing Colors and Fonts,” on page 136.

In addition to the logo, there are other customizations you can do to change the branding of the server. See section 11.3.4, “Editing decorators.jsp for Rebranding,” on page 145.

11.1.2.1 Replacing the Jaspersoft Logo File

One way to replace the Jaspersoft logo is to create a logo file with the same file name as the Jaspersoft logo that is provided with the server. When you create a theme with this file in the same path as the logo file, it is displayed instead. This is the easiest customization.

To replace the Jaspersoft logo file with your own:
1. Create a new theme or modify an existing one.
2. If necessary, add a folder named images to the theme.
3. Convert your logo or image to the PNG format and save it with the filename logo.png.
4. Copy the new logo.png to the images folder.
5. Upload and activate the new theme to the chosen location, then click your browser’s Refresh button.

Your logo appears in the top-left corner of every page:

11.1.2.2 Modifying the CSS File

Another way to replace the logo is to use your own logo file and modify the CSS files in the theme so that they reference it. This creates a new filename and path. Use this procedure if your logo cannot be resized to fit in the same space, or if the dimensions of your logo have a different ratio. The Jaspersoft logo is 20 pixels high by 115 pixels wide.

To modify the CSS file to use your own logo file:
1. Create a new theme or modify an existing one.
   In this theme, you can place your image file in any folder structure you want.
   In this example, the logo is a file called MyCompanyLogo.png in a folder called MyImages.
2. If necessary, copy the overrides_custom.css file from the default theme to the main folder of your theme.
3. Edit the overrides_custom.css file and add the following rules. Adjust all pixel values based on the size of your image:

```css
#logo { /* new logo image name and size (example is twice the original logo) */
    background: url("MyImages/MyCompanyLogo.png") 0 0;
    height: 40px;
    width: 230px;
}

.banner { /* increases height of banner to accommodate bigger logo */
    height: 65 px
}

#frame { /* moves the main frame a bit down to accommodate bigger logo */
    top: 66px;
}
```

4. Upload and activate the new theme with your image and CSS file, then click your browser’s Refresh button.

### 11.1.3 Hiding UI Elements

CSS provides a convenient rule to hide any element of the UI. If you set `display:none;` as an override, the corresponding element is not rendered in the browser. For example, you can use this parameter to remove the logo from the UI.

Setting the parameter `display:none;` is a convenient way to hide any element through the CSS. It can be used alone or in conjunction with the other CSS parameters that you might want to keep in the rule.

The hidden element still exists in the HTML transmitted to browsers, so do not use this parameter to hide sensitive information. For example, if you hide a menu item, a user with the FireBug plug-in to Firefox can remove the `display:none;` attribute to reveal the menu and use it. For a more secure way to remove menu items, see section 11.7.2, “Restricting Access by Role,” on page 155.

**To remove the logo:**

1. Create a new theme or modify an existing one.
2. If necessary, copy the overrides_custom.css file from the default theme to the main folder of your theme.
3. Edit the overrides_custom.css file and add the following CSS rules:

```css
#logo {
    display:none;
}
```

4. Upload and activate the new theme with your image and CSS file, then click your browser’s Refresh button.

### 11.1.4 Changing Colors and Fonts

Changing colors, fonts, size, and spacing throughout the UI is very simple with the themes mechanism. However, creating a complete theme that modifies all aspects of the user interface involves changing many CSS rules and re-creating many images of buttons and window decorations.
To provide an example of theme customizations, the sample data installed with JasperReports Server includes an alternate theme called pods_summer. This theme makes many changes to the default appearance, mostly a new color scheme. You can activate this theme to see its effect, and you can download its files to see how it works.

Like most small-scale customizations, the pods_summer theme uses a single overrides_custom.css file and several image files. The image files have the same names as those in the default theme, so when the theme is activated, they automatically replace the default images.

Just as an example of the CSS involved in modifying a theme, some of the customizations that appear in Figure 11-2 are:

- New logo as described in section 11.1.2.1, “Replacing the Jaspersoft Logo File,” on page 135.
- Horizontal gradient image for the banner, along with a different color:

```css
.banner
  background: url("images/banner_bkgd.png")
  border-bottom: 1px solid #559502;
  border-top: 1px solid #B5D261;
  height: 26px;
  position: relative;
}
```

- New color for main menu text, a darker green:

```css
button.action.primary.up,
.menu.primaryNav .up, .menu.primaryNav .wrap,
.tabSet.vertical.buttons .button,
.tabSet.horizontal.buttons .selected > .button > .wrap {
  color:#559502;
}
```

- A new image file for the green button bar used for the main menu

Sprites are image files that contain multiple images. The CSS rules that reference them give a vertical and horizontal offset for reading an individual image from the file. For some buttons and bars, the sprite contains a long image to accommodate any width, and an end cap to be placed at the desired width. For icon sprites, the images often reflect the various icon states, such as enabled, disabled, mouse-over, and pressed.

When customizing the theme images, having multiple images in one file is helpful because it allows you to work with many related images together in an image editor, instead of dealing with numerous files. For example, you can easily change the color hue for all buttons in a sprite file at the same time.

### 11.1.5 Changing the Spacing in the UI

One advantage of customizing CSS in themes is that you can drastically change the appearance of the UI with very few overrides. CSS controls the spacing and layout of contents on the page, and by changing a few rules, you can rearrange the default layout in many ways.

In the following example, you will remove the Jaspersoft logo entirely, move the main navigation further left, and remove the margins and borders on the home page content area.

1. Create a new theme or modify an existing one.
2. If necessary, copy the overrides_custom.css file from the default theme to the main folder of your theme.
3. Edit the overrides_custom.css file and add the following CSS rules:

```css
#logo {
    display:none;
}

.menu.primaryNav{
    margin-left: 0px;
    position: relative;
}

.column.decorated{
    border: medium none;
    bottom: 0;
    margin: 0;
    min-width: 150px;
    overflow: visible;
    top: 0;
}
```

4. Upload and activate the new theme with your image and CSS file, then click your browser’s Refresh button. The result is a page that has no blue border, thus giving more screen area to the content:

![Figure 11-3 Theme With Modified Spacing to Remove Borders and Margins](image)

There are many CSS attributes that affect spacing, including margins, borders, and edge and corner images. In additions, the various div elements that make up the UI interact with each other, making it hard to set the spacing correctly in some cases. Be sure to look at your overrides on all JasperReports Server pages to verify that the appearance is consistent and correct throughout the UI.

11.1.6 Using Themes to Remove Branding

If you embed JasperReports server in your application, you may want to remove all branding and menus. The following example shows how to remove the banner and footer entirely using themes.

![Warning icon] Removing the menus restricts your ability to navigate the JasperReports server interface. If you need to revert to the default theme, change your theme for the session by adding &theme=default to the end of the current URL. You can also log in as an administrator, select Manage Server, then select Repository to navigate to the repository to locate and change themes.

1. Create a new theme in JasperReports Server. This example assumes you named the theme embed.
2. On your computer, create the following CSS file and save it as overrides_custom.css.

```css
/*
overrides_custom.css
Basic theme for embedding
*/
body {
  background-color: white;
  background: none;
}
#banner {
  background: none;
  display: none;
}
#frame {
  top: 0;
}
#frameFooter {
  display: none !important;
}
```

3. Log into JasperReports Server as an administrator.
4. Select View > Repository and navigate to the location where you created your theme.
5. Right-click on the embed theme in the repository and select Add Resource > File > CSS. A dialog asks you to select the file to upload.
6. Select the overrides_custom.css file you created and enter overrides_custom.css for the Name and Resource ID.
7. Click Submit.
8. Right-click the embed theme and select Set as Active Theme. The result is a theme that has no footers or menus.
11.1.7 Replacing the Default Theme

In general, Jaspersoft recommends creating new themes with CSS and image files that override those of the default theme. However, there may be some cases where the default theme provided with the server must be replaced.

The `<js-webapp>/themes` folder contains a copy of the default theme and other sample themes. These files are provided as examples for copying and creating new themes. Even though these theme files appear in the source code and in the deployed web application, they are never used to render the UI.

It is possible to configure the server to load the theme from files, but this disables the dynamic theme mechanism and has other effects. Jaspersoft does not recommend such a configuration.

Like all themes, the default theme is stored in the repository, in the server’s private database. In order for the theme mechanism’s propagation and inheritance to work, the theme files must exist in the repository before the server is started. There are two ways to achieve this:

- Using the import utility to import your theme as the default root theme while the server is stopped (the repository database must be running). In commercial editions that have the organizations architecture, when the server restarts, it propagates your new default theme to all other theme folders.
- During the installation process, there are scripts or manual commands that create the repository database and populate it with the initial contents by performing an import before the server starts. Those initial contents include the default root theme. If you are proficient with buildomatic commands, and database initialization, you can locate the files used to populate the repository and insert your own default theme.

In both cases, you must create a valid repository catalog containing your custom theme in the `/Themes/default` folder of the catalog. Your catalog must contain the valid XML description for each of the files, for example by exporting a copy of your theme and renaming contents of the exported catalog. The details of changing the default theme through either of these methods is beyond the scope of this document.

Creating a default theme is difficult and prone to error:

- Your version of the default theme must be a complete theme that contains all files named in `<js-webapp>/WEB-INF/decorators/decoratorCommonImports.jsp`.
- Your default theme must provide rules for rendering all the elements used by the UI, otherwise pages may not render properly.
- Your default theme cannot use the `overrides_custom.css` file, because themes that override your default theme may include this file. By convention, this file is reserved for non-default themes to override the default theme.
- During an upgrade of the server, your default theme may be overwritten or the new version may not be backwardly compatible with your theme. See section 11.2.4, “Upgrading With UI Customizations,” on page 142.

11.2 Working With Web App Files

This section gives an overview of how components of the user interface are created from the source code. The entire process from designing the UI in source files to displaying the UI in the server is very complex, with several interacting mechanisms. JasperReports Server uses the Spring Framework based on compiled Java beans, but the layout of the UI is also controlled by Java Server Pages (JSP files), the SiteMesh framework that decorates pages, and the CSS files seen in the previous section. Some of these mechanisms use additional XML files for configuration.

There are essentially two kinds of files that are involved in creating the UI:

- Compiled Java files that define the underlying behavior of the Server, for example, what happens when you click a button to run a report. These are Java beans that are used in the Spring framework, where they are also called Spring beans.

  In order to change the behavior of a Java file, you must recompile it, rebuild the server, and redeploy it in an application server. Therefore, to change the UI controlled by Java files, you must have the source code distribution and a testing environment to build and deploy the server. For more information, see section 11.8, “Working With Source Code Files,” on page 167.

- Interpreted files such as JSP, XML, and CSS that the server processes in order to generate the UI. The advantage of interpreted files is that you can modify them in a running instance and have them take effect immediately (as with CSS), or after restarting the server (as with JSP). Fortunately, much of the UI can be customized with interpreted files.
11.2.1 File Locations

Interpreted files are located in the JasperReports Server web application, known as \(<js-webapp>\). Depending on your deployment and your needs, there are several ways to work with the interpreted files, which in turn determine the definition of \(<js-webapp>\) that you use.

<table>
<thead>
<tr>
<th>File Location</th>
<th>(&lt;js-webapp&gt;) Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed server</td>
<td>Once you have installed your server, either through a platform installer or any other deployment, the files are deployed in a running application server. The location depends on the application server where you installed JasperReports Server. If you used the bundled Apache Tomcat application server, the files are located in: (&lt;js-webapp&gt; = &lt;js-install&gt;/apache-tomcat/webapps/jasperserver[-pro])</td>
</tr>
<tr>
<td></td>
<td>For other application servers, see Unzipping WAR Files below. After modifying the UI files (except CSS), reload the web app to see the changes. This is the easiest way to customize files, because you can see your changes almost immediately. However, your changes are limited to this one instance of the server.</td>
</tr>
<tr>
<td>WAR file distribution</td>
<td>When you download the WAR (web archive) file distribution, you can customize your deployment of JasperReports Server and possibly install it on several machines. The WAR file distribution also includes the UI files in the following location: (&lt;js-webapp&gt; = &lt;js-install&gt;/jasperserver[-pro].war)</td>
</tr>
<tr>
<td></td>
<td>To modify files with the WAR file, see Unzipping WAR Files below. After modifying the WAR file distribution, you need to deploy it to your application server, as described in the JasperReports Server Installation Guide. But every time you redeploy your modified WAR file, your UI changes are included.</td>
</tr>
<tr>
<td>Source code</td>
<td>The JasperReports Server source code also contains the original versions of the interpreted files. If you maintain other customizations in the source code, you can modify the UI files as well. The files in the source code are located in: (&lt;js-webapp&gt; = &lt;js-src&gt;/jasperserver/jasperserver-war/src/main/webapp)</td>
</tr>
<tr>
<td></td>
<td>When building the source, these files are copied into the WAR file that you must then deploy into a running application server. See the JasperReports Server Source Build Guide for more information. The advantage of working with the source code is that you can always generate the server with your customized UI files.</td>
</tr>
</tbody>
</table>

When working with the WAR file distribution or source code, you usually modify files in an installed server for testing. But after testing, you copy the changes into your WAR file or source code.

11.2.2 JavaScript and JSP Folders

Inside the JasperReports Server web application, the various JavaScript and JSP files are organized as follows:

- **JavaScript files** are all in the \(<js-webapp>/scripts\) folder. File names contain module and subcomponent names, for example \(<js-webapp>/scripts/adhoc.chart.js\).
- **JSP files** are split up under the \(<js-webapp>/WEB-INF/jsp\) folder:
  - The \(<js-webapp>/WEB-INF/jsp/templates\) folder contains UI components such as panels, lists, menu, and dialogs.
  - The \(<js-webapp>/WEB-INF/jsp/modules\) folder contains flow-specific pages:
    - The main layout and subpanel JSP files are directly in modules.
    - Each feature has subfolders for its various JSPs.

11.2.3 Unzipping WAR Files

When modifying UI files in application servers other than Apache Tomcat or in the WAR file distribution, the web application is kept as a single WAR (web archive) file. To modify files inside the WAR file, you must extract, modify and replace the files. The following example shows one way to do this from the Windows command line (the commands are similar in Linux).
In this example, `<path/filename>` refers to the relative path and name of the file to modify within the WAR file:

```
cd <js-webapp>
"%JAVA_HOME%\bin\jar" xf jasperserver[-pro].war <path/filename>

<edit> <path/filename>
"%JAVA_HOME%\bin\jar" uf jasperserver[-pro].war <path/filename>
delete <path/filename>
```

After modifying any files in the running application or reloading the web application, you may need to perform the following steps, depending on your application server:

1. Clear the application server's work folder. In the case of Apache Tomcat, you would delete all files and folders in the `<tomcat>/work` folder.
2. Click Refresh on your browser.
3. In some cases, you may need to restart the application server.

### 11.2.4 Upgrading With UI Customizations

One consideration when customizing the user interface is how those customizations can be maintained during upgrades to JasperReports Server. As explained in section 11.2.1, “File Locations,” on page 141, where and how you make changes affects how easy it is to maintain them.

- Changes to the CSS files and images of a theme are stored in the repository, which is preserved through updates. However, the CSS in the new version may refer to different IDs and classes, or to image files with different names. Also, the overrides in an old theme may not have the desired appearance when applied to a new theme.
- Because the server is distributed as a WAR file, changes to files in an installed version or an existing WAR file are likely to be overwritten during an upgrade. Sometimes, you can save a copy of the modified files and redo the changes in the new installation or WAR file. In this case, you must be careful to copy only your modifications from the saved file into the new server files. In other cases, the existing modifications no longer apply to the files or mechanisms in the new server.
- Keeping your changes in a copy of the source code lets you take advantage of source control to update and merge your changes into the code for the new server. However, in the case of major releases UI mechanisms sometimes change, and the files with your modifications may no longer exist or be relevant in the new code.

In general, new releases of the server attempt to provide backward compatibility of the mechanisms described in this chapter, especially minor (“dot”) releases. However, in order to improve the UI and provide new features, Jaspersoft cannot guarantee that all customizations still apply, or even that they will use the same mechanism, especially in major releases.

### 11.3 Customizing the Branding with SiteMesh

While themes allow you to modify CSS files and images, there are some parts of the UI that are controlled by other mechanisms. In particular, JasperReports Server uses the SiteMesh framework to lay out and decorate nearly every page. The decoration is the HTML for the headers and footers that are nearly identical on every page.

The SiteMesh framework is controlled by the following files:

- `<js-webapp>/WEB-INF/web.xml`
- `<js-webapp>/WEB-INF/sitemesh.xml`
- `<js-webapp>/WEB-INF/decorators.xml`
- `<js-webapp>/WEB-INF/decorators/main.jsp`
- `<js-webapp>/WEB-INF/decorators/decorators.jsp`

Essentially, the XML files specify how UI pages should be generated, and the JSP files generate the pages. The following sections describe these files and how to customize the JSPs to change the overall branding that appears in the UI.
11.3.1 web.xml

The `<js-webapp>/WEB-INF/web.xml` configuration file contains the configuration information that enables SiteMesh. You can see that SiteMesh’s `PageFilter` class is applied to all targeted URLs (that is, `<url-pattern>/*</url-pattern>`):

```
<filter>
  <filter-name>sitemesh</filter-name>
  <filter-class>com.opensymphony.module.sitemesh.filter.PageFilter</filter-class>
</filter>
...

<filter-mapping>
  <filter-name>sitemesh</filter-name>
  <url-pattern>/*</url-pattern>
  <dispatcher>FORWARD</dispatcher>
</filter-mapping>
```

11.3.2 sitemesh.xml and decorators.xml

The SiteMesh page filter assumes that the `<js-webapp>/WEB-INF/sitemesh.xml` file specifies further configurations. You can see that the main decorator’s definition points to `decorators.xml`. In addition, you see the SiteMesh mapping that handles the default locale (U. S. English):

```
<property name="decorators-file" value="/WEB-INF/decorators.xml"/>

<!-- Mapper for localization -->
<mapper class="com.opensymphony.module.sitemesh.mapper.LanguageDecoratorMapper">
  <param name="match.en" value="en"/>
  ...
</mapper>
```

Next, look at the `<js-webapp>/WEB-INF/decorators.xml` file. First, it defines URL patterns that SiteMesh should skip. Then, it defines the main decorator JSP page that is used by JasperReports Server:

```
<excludes>
  <pattern>*adhoc/crosstab*</pattern>
  <pattern>*adhoc/table*</pattern>
  ...
</excludes>

<decorator name="main" page="main.jsp">
  <pattern>/*</pattern>
</decorator>
```

For more detailed information about Sitemesh and decorators, see [http://www.opensymphony.com/sitemesh/decorators.html](http://www.opensymphony.com/sitemesh/decorators.html).

11.3.3 main.jsp and decorator.jsp

In `<js-webapp>/WEB-INF/decorators/`, the `main.jsp` includes the `decorator.jsp` file, and together they set the appearance and layout of the JasperReports Server web interface. **Figure 11-5** shows the display elements as they appear in JasperReports Server.
In particular, decorator.jsp specifies all the display elements that appear as the header and footer of every JasperReports Server page. Inside the header and footer and main frame is the `<decorator:body/>` tag that specifies where to add the HTML content generated for the target page.

In the following listing of decorator.jsp, you can see the structure of every JasperReports Server HTML page, with the main frame, the banner, the body content, and the footer:

```html
<html>
  <head>
    <title>Jaspersoft: <decorator:title /></title>
    ...
    <decorator:head />
  </head>

  <body id="<decorator:getProperty property='body.id'/>" class="<decorator:getProperty property='body.class'/>">
    <div id="banner" class="banner">
      ...
      <div id="logo" class="sectionLeft"></div>
      ...
      <div class="sectionLeft" style="position:relative;z-index:1;">
        <div id="mainNavigation" class="menu horizontal primaryNav">
          ...
          <ul id="metaLinks" class="sectionRight">
            ...
          </ul>
        </div>
      </div>
    </div>

    <div id="frame">
      <div class="content">
        <decorator:body />
      </div>
    </div>
  </body>
</html>
```
For example, if the user clicks **View > Reports**, the WEB-INF/jsp/modules/ListReports.jsp is executed. The ListReports.jsp generates the HTML content. Before this content is emitted, the SiteMesh page filter inserts the content into the location specified by `<decorator:body/>`. Then, the whole HTML content is sent to the user’s browser.

### 11.3.4 Editing decorators.jsp for Rebranding

Now that you know how decorators.jsp defines the main page of the server UI, you can customize the file. If you use JasperReports server as part of your suite of business applications, you may not want the Jaspersoft branding on the page. Editing the decorators.jsp file in the deployed webapp lets you remove the branding. The following elements make up the Jaspersoft branding:

- The company logo: to change or remove the logo, see section 11.1.2, “Changing the Logo,” on page 134.
- The browser icon (favicon).
- The page title appearing in the browser.
- The About link and copyright footer on every page.

#### To replace the browser icon (favicon):

1. Create a 16 by 16 pixel icon file named favicon.ico.
2. Copy the icon to the following location:

   Instance: `<js-install>/apache-tomcat/webapps/jasperserver[-pro]
   Source Code: `<js-src>/jasperserver/jasperserver-war/src/main/webapp
3. Restart the server.

#### To edit the page title:

1. Edit the file `<js-webapp>/WEB-INF/decorators/decorator.jsp`.
2. Change the title text, for example:

   ```html
   <html>
   <head>
   <title>My Company: <decorator:title /></title>
   ...
   <decorator:head />
   </head>
   ...
   ```

3. After saving your changes to the JSP file, restart your application server or reload the JasperReports Server web app.

#### To remove the footer text:

1. Edit the file `<js-webapp>/WEB-INF/decorators/decorator.jsp`. 
2. Change the footer text, for example to comment out the about and copyright lines:

   ```html
   ... 
   <div id="footer" class="footer">
    <!-- <a id="about" href="#"><spring:message code="decorator.aboutLink"/></a>
    <p id="copyright"><spring:message code="decorators.main.copyright"/></p> -->
    </div>
   ...
   ```

3. After saving your changes to the JSP file, restart your application server or reload the JasperReports Server web app.

### 11.4 Customizing JSP and JavaScript for the Login Page

If you want to replace the Jaspersoft branding, the login page requires extensive changes. Rebranding with a new theme and with the SiteMesh decorators are necessary but not sufficient. To completely customize the login page, you also need to edit the following files that define the content on the page:

- Favicon and page title can be changed through the SiteMesh decorators, as described in section 11.3.4, “Editing decorators.jsp for Rebranding,” on page 145.
- There are several specific CSS rules for the login page that you may customize in a theme.
- The content of the login page is located in a JSP file that you can edit to remove sections of the login page.
- The URL for a button you need to keep is located in a JavaScript page.
- All strings on the login page are stored in properties files. Most of these don’t need to change, but several do mention Jaspersoft.

The following example shows how the CSS, JSP, JavaScript, and properties files all need to be modified together to make a uniform change such as removing the branding from the login page.

**To change the branding on the login page:**

1. Create a new theme or modify an existing one.
2. If necessary, copy the overrides_custom.css file from the default theme to the main folder of your theme.
3. Edit the overrides_custom.css file and add the following CSS rules:

   ```css
   #loginPage #copy {
    background:#fff;
    top:0;
    left:268px;
    bottom:0;
    right:0;
    position:absolute;
    /* overrides to .info selector of old login page */
    overflow-y:auto;
    overflow-x:hidden;
    margin:0;
    border:1px solid #666;
    border-radius: 0;
    -moz-border-radius: 0;
    -webkit-border-radius: 0;
   }
   ```
Customizing the User Interface

This example swaps the login form and information panel left and right, respectively. You could also change the size and vertical position of the panels.

4. If you want to change the image on the login page, create an images folder if necessary, and save your image in the JPG format with the following name. Your image should be the same size, approximately 700 pixels wide and 240 pixels high, otherwise you may need to adjust the spacing on the login page through the theme as well:

   Community Project: images/login_welcome_ce_bkgd.jpg
   Commercial Editions: images/login_welcome_bkgd.jpg

   The picture below shows the standard image replaced by an image of a fictional MyCompany logo.

5. Upload and activate the new theme with your image and CSS file, then click your browser’s Refresh button.

   In commercial editions with the organizations architecture, you must upload and activate the theme at the root level. The theme at the root level applies to the login page for all users, regardless of the users’ organization. You must login as system admin (superuser) to set the theme at the root level.

6. To change or remove the links under the image, edit the file <js-webapp>/WEB-INF/jsp/modules/login/rotating/login_rotating_pro_0.jsp or login_rotating_community_0.jsp.

7. Edit the file <js-webapp>/WEB-INF/bundles/jasperserver_messages.properties.

8. Change the following string to customize your login page:

   #Welcome Login Page
   LOGIN_WELCOME_OS=Welcome to MyCompany

9. If you support multiple locales, modify the same message keys in the other language bundles:
   jasperserver_messages_de.properties
   jasperserver_messages_es.properties
   jasperserver_messages_fr.properties
   jasperserver_messages_ja.properties
   jasperserver_messages_zh_CN.properties

10. Restart the app server or reload the JasperReports Server web app as shown in the following section.
11. When combining these customizations with those in section 11.3, “Customizing the Branding with SiteMesh,” on page 142, the login page has a new appearance that removes all Jaspersoft branding, as shown in the following figure:

![Custom Layout and Rebranding of Login Page](image)

**Figure 11-6 Custom Layout and Rebranding of Login Page**

### 11.4.1 Reloading the JasperReports Server Web App

When you customize interpreted files such as the JSP, JavaScript, and properties files, you need to reload them in the JasperReports Server web application to take effect. The standard installation of the server only includes shortcut actions for starting and stopping the bundled application server and database server. If you have other web applications that you don’t want to stop, or if you are doing a lot of customization and testing, it is simpler and quicker to simply reload the web app without restarting the application server.

Each different application server has its own management console that lets you view and control the web apps that are deployed. This example shows how to manage the JasperReports Server web app in the bundled Apache Tomcat.

1. If you have not configured any users on your Apache Tomcat server, you must first add a user and give him the manager role. To do this:
   a. Edit the file `<js-install>/apache-tomcat/conf/tomcat-users.xml`.
   b. Create a user if necessary and give it the manager role. You can give the user any name and password you prefer.
   ```xml
   <tomcat-users>
     <user username="tomcat" password="tomcat" roles="manager"/>
   </tomcat-users>
   ```
   c. Restart your Apache Tomcat server for this change to take effect.

2. Once you have created a manager user, open the Apache Tomcat Manager page in a browser: http://<host>:<port>/manager/html/, where `<host>` and `<port>` are where you installed the server. For a default installation, use http://localhost:8080/manager/html/.

3. When prompted, log in with your manager user credentials.

4. On the Apache Tomcat management interface, scroll down to find the jasperserver[-pro] application, and click **Reload**.

5. After you confirm you want to reload the web app, wait until the page reloads, then open the JasperReports Server login page to see your changes. If the manager doesn’t reload, there was likely an error in the files, and you must then stop and restart the app server.
11.5 Setting the Home Page

The home page is the first page a user sees when logging in to JasperReports server. You can direct the home page to a specified flow based on user role. The following example shows how to set the home page for a non-administrative user to the library page:

1. Open the file `<js-webapp>/WEB-INF/jasperserver-servlet-pro.xml` (commercial editions) or `jasperserver-servlet.xml` (community edition) for editing.

2. Locate the home page bean:
   - `proHomePageByRole` (commercial editions)
   - `HomePageByRole` (community edition)

3. Locate the line under this bean for `ROLE_USER` and modify it to direct to the library page:

   ```xml
   <bean id="proHomePageByRole" class="java.util.ArrayList">
     <constructor-arg>
       <list>
         <value>ROLE_ADMINISTRATOR|redirect:/flow.html?_flowId=homeFlow</value>
         <value>ROLE_USER|redirect:/flow.html?_flowId=searchFlow&mode=library</value>
       </list>
     </constructor-arg>
   </bean>
   
   For a user with multiple roles, the `proHomePageByRole` bean redirects the user to the page specified by the first matching role on the list. For example, for an administrator with ROLE_USER and ROLE_ADMINISTRATOR roles, the ROLE_ADMINISTRATOR redirect is applied because it appears first in the bean. When adding your own roles to this bean, make sure to insert them in the order which has the effect you desire.

4. Save the modified file and reload the web app in the app server to see the changes (see 11.4.1, “Reloading the JasperReports Server Web App,” on page 148).

5. When the web app has reloaded, log into JasperReports Server as joeuser. The library page is displayed.

This method does not work with viewReportFlow or dashboardRuntimeFlow.

11.6 Customizing the Report Rendering Page

The report viewer is the module of the JasperReports Server UI that displays JasperReports. It is a central part of the UI that users interact with frequently. In addition to displaying the report contents, the report viewer offers the following functionality:

- Display input controls so that users may set report options, also called parameters.
- Let the user navigate through the pages of the report.
- Allow the user to export the report in various formats.

Each of these is customizable; this allows you to control many details of the report viewing experience for your users. The input controls can be set either globally or on an individual report basis; the report viewer can be set globally. You can also add new export formats; see section 11.10, “Adding Custom Export Channels,” on page 173.

11.6.1 Customizing the Input Controls Form

The input controls are displayed in a form that gives the label of each form and the field or widget for the user to enter a value. The input fields and widgets, such as drop-down menus, radio buttons, and check boxes are determined by the input controls themselves, but their layout can be customized with a JSP file. For general information about input controls, refer to the JasperReports Server Administrator Guide.
JasperReports Server can display the input controls form in a pop-up window (the default), in a separate page, in a separate column, or at the top of the report page. Each kind of layout is determined by a JSP file that renders the input control page.

<table>
<thead>
<tr>
<th>Layout Type</th>
<th>Files To Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pop-up window</td>
<td><code>&lt;js-webapp&gt;/WEB-INF/jsp/modules/inputControls/DefaultParametersForm.jsp</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;js-webapp&gt;/WEB-INF/jsp/templates/inputControls.jsp</code></td>
</tr>
<tr>
<td>Separate page</td>
<td></td>
</tr>
<tr>
<td>In page (left-hand panel)</td>
<td></td>
</tr>
</tbody>
</table>

You can customize these files in one of two ways:

- If you directly modify one or both of the files listed above and save them in the same location in your web application, your changes apply to all reports. The procedure is similar to section 11.4, “Customizing JSP and JavaScript for the Login Page,” on page 146. After making your changes and redeploying the web app, every user would see your new input controls form. For example, to change the background color of all your input controls, you would modify these files.

- In the case of the file DefaultParametersForm.jsp, you can create a JSP file with a different name and use it in individual reports, without affecting the default appearance of input controls for other reports.

Input controls were redesigned in 4.7. Custom input controls developed prior to 4.7 may require upgrading in order to work with the new input control design.

To edit input controls, you create one or more containers and then write the default input controls into the container. For example, to customize the background color for your input controls, you would create a container similar to the following:

```jsp
<%@ taglib prefix="t" uri="http://tiles.apache.org/tags-tiles" %>

<jsp:include page="InputControlTemplates.jsp" />

<div id="myContainer" style=background:#c96;"></div>
```

Once you have defined the containers that you want, you need to request the input control information, and automatically add the input controls to your container, based on their type and the order in which they are declared. The following non-working fragment shows how you would do this.

```javascript
<script type="text/javascript">
var myContainer = jQuery('#myContainer');
(function (jQuery, _, controlsViewModel) {
    controlsViewModel.draw = function (jsonStructure) {

        var drawControl = function (container, jsonControl) {
            if (jsonControl.visible) {
                var control = this.findControl({id:jsonControl.id});
                container.append(control.getElem());
            }
        };
        _.each(jsonStructure, _.bind(drawControl, this, myContainer))
    }
}(jQuery, _, controlsViewModel))
```

150
The following are key components of this file:

- `var drawControl = function(..) {...}` defines a function which draws each input control using the default template set.
- `_.each(leftPanelControls, _.bind(drawControl, this, myContainer));` iterates through a subset of input controls and calls the `drawControl` function to render each input control into the specified container.
- `JRS.Controls.getController().getViewModel()` reads the input control information from the server and populates the javascript object.

The following figure shows an example of custom input controls for a report with color customization for the background.

![Figure 11-7 Default and Custom Input Control Pages](image)

JSP files rely on other JSP file to reuse parts of the user interface. In the file that you modify, you can either reference the default JSP helper files, or make copies of them to modify and reference instead.

Once you have created the file you want, save the file in your server instance. For example, you could create a `<js-webapp>/WEB-INF/jsp/custom` directory, and save your customizations there, for example as `CustomShippingParametersForm.jsp`.

To use custom JSP input controls in a report, you need to add the JSP file to the report as a resource. For example, suppose the JSP for the input controls above was saved as `<js-webapp>/WEB-INF/jsp/custom/CustomShippingParametersForm.jsp` in your server instance. To attach this file to your shipping report, first locate the report in your repository and right-click to edit the
JasperReport resource. Then go to the Controls and Resources page and set the **Optional JSP location** to the path of your file relative to `<js-webapp>/WEB-INF/jsp/`. In this example, you would enter custom/CustomShippingParametersForm.jsp.

For information about editing JasperReports in the repository, refer to the *JasperReports Server User Guide*.

### 11.6.2 Customizing the Report Viewer

The report viewer creates the page with the controls for paging through a report and exporting its contents in other formats. The main JSP files of the report viewer are:

- `<js-webapp>/WEB-INF/jsp/modules/viewReport/DefaultJasperViewer.jsp`

To change the report viewer, modify and save the default files without changing their names. The procedure would be similar to section 11.4, “Customizing JSP and JavaScript for the Login Page,” on page 146. After redeploying the web app, your changes to the report view appear in every report for every user.

The following figure shows the default layout of the report viewer in 5.0:

![Figure 11-9 Default Appearance of the Report Viewer](image)
The following figure shows a possible customization. For example, if only administrators are authorized to update data snapshots, you may want to use Spring Security tags to hide the refresh button after the timestamp from users.

![Possible Customization of the Report Viewer](image)

Figure 11-10 Possible Customization of the Report Viewer

Other customizations could include limiting the number of export options and/or replacing the export menu with icons.

## 11.7 Customizing Menus

A very common customization is the removal, addition, or restriction of access to the main menu of JasperReports Server. Section 11.1.3, “Hiding UI Elements,” on page 136 showed a limited way of removing access to the main menu items by simply hiding the menu elements with CSS in a theme. Customizing the menu structure is more robust, more secure, and lets you fine tune the functionality available to users. In particular, you can restrict access to menus based on roles, so that users see different menu choices depending on the roles they belong to.

The mechanism that implements the main menu is called the actionModel, and it is defined in a set of actionModel-* .xml files in the `<js-webapp>`/WEB-INF/ folder. The action model is a way to represent menus, sub-menus, and menu items in XML, giving each item an action when selected, as well as optional role-based restriction. The actionModel is also used to define context menus on folders and resources listed on repository browse and search pages.

The actionModel represents the structure of the menus through the structure of the XML. When pages are processed, the actionModel mechanism converts the XML into the JavaScript that generates menus.

### 11.7.1 Removing a Menu Item

In this example, suppose that neither users nor administrators have been trained to work with Domains, and to prevent users from accidentally creating Domain resources, system administrators decide to remove any reference to Domains in the user interface.

Removing Domains from the menu hides Domains but does not disable them. Users can still access Domains by entering the URI for the Domain webflow. See 11.8, “Working With Source Code Files,” on page 167 for information on how to restrict a webflow.

To remove the Domain menu items:

1. Edit the file `<js-webapp>`/WEB-INF/actionModel-navigation.xml. This file defines the main menu visible by default on all pages of the server. In the XML that defines the actionModel, there are many condition tests that determine when each menu and menu item should be displayed.
2. Find the section at the end for the **Create** menu and insert comments to remove the last menu item, as shown in the code sample above.

3. Edit the file `<js-webapp>/WEB-INF/actionModel-search.xml`. This file defines the context menu items visible when right-clicking on folders and resources in repository listings.

---

"Mutton" is a term that means menu-button, and designates a button that creates a drop-down menu.
4. Find the section at the top of the file that creates the Add Resources sub-menu. Then add comments to remove the lines that define the **Add Resources > Domain** menu item, as shown in the code sample above.

5. Save the modified files and reload the web app in the app server to see the changes (see 11.4.1, “Reloading the JasperReports Server Web App,” on page 148).

6. When the web app has reloaded, log into JasperReports Server as jasperadmin. Click on the Create menu and right-click on a folder in the repository. In both cases, the menu item for Domain is no longer available.

When you remove a menu item, it is removed for all users, even administrators. Often it is preferable to prevent only non-administrators from viewing a menu item, as shown in the next section.

### 11.7.2 Restricting Access by Role

You can use role-based customizations to control access to many user interface components, including menus, Java Server Pages, and web flows. This example shows how to control access to existing UI components; the same techniques work with custom components you create.

In this example scenario, suppose end users haven’t had training in creating reports with the Ad Hoc Editor, and you wish to hide it from users, but make it accessible to administrators. To hide access to the Ad Hoc Editor, you need to customize the UI in three ways:

- Customize the **Create** menu to restrict access to Ad Hoc creation to administrators
- Customize the JSP content on the home page to hide the **Create Ad Hoc View** button from non-administrative users.
- Customize the Ad Hoc web flow to restrict access to administrators.

The following sections show how to perform each of these actions.
11.7.2.1 Restricting a Menu Item by Role

1. Edit the file `<js-webapp>/WEB-INF/actionModel-navigation.xml`. The actionModel for **Create > Ad Hoc View** is near the end of the file.

2. Following the pattern of conditions for other administrator-only functionality, insert the `condition` tag for checking role authentication around the `option` tag to display the Ad Hoc menu item, as shown in the code sample above.

3. If you want to hide an entire menu, follow the pattern of the Manage menu, which is hidden from non-administrators. In this case, add the `test` and `testArgs` attributes to the `context` tag that displays the menu, as shown in the following sample:

11.7.2.2 Restricting a Section of a JSP File by Role

Creating an Ad Hoc view is available through the large buttons on the home page of every user. The home page buttons are generated in Java Server Pages, outside of the actionModel for menus. You can use Spring Security’s authorization tags to set up access control on JSP pages. The next steps show how to hide the **Create Ad Hoc View** button on the home page.
1. Open the file `<js-webapp>/WEB-INF/jsp/modules/home/homeForNonDemo.jsp` that displays the home-page buttons for editing.

```html
...<%@ taglib prefix="t" uri="http://tiles.apache.org/tags-tiles" %>
<%@ taglib uri="http://www.springframework.org/security/tags" prefix="authz"%>
<%@ taglib prefix="c" uri="http://java.sun.com/jstl/core_rt" %>
<%@ taglib uri="/spring" prefix="spring"%>
...
<div class="row">
  <a id="viewReports" class="button action jumbo up"><span class="wrap"><spring:message code="home.view" javaScriptEscape="true"/></span><span class="icon"></span></a>
  <% if (LicenseManager.isAdHocFeatureSupported()) {
    %>
    <authz:authorize ifAllGranted="ROLE_ADMINISTRATOR">
      <a id="createReports" class="button action jumbo up"><span class="wrap"><spring:message code="home.create" javaScriptEscape="true"/></span><span class="icon"></span></a>
    </authz:authorize>
  <%} %>
...<%>
</div>
...```

2. Make sure that the line to import the Spring `authz` tag is near the beginning of the file. This line is necessary in any JSP file that implements access control:

```html
<%@ taglib uri="http://www.springframework.org/security/tags" prefix="authz"%>
```

3. Locate the `createReports` link in this file. Following the pattern of conditions for other administrator-only functionality, insert the `authz:authorize` tag for checking role authentication before displaying the button, as shown in the code sample above.

See the Spring Security Reference Documentation for more information.

11.7.2.3 Controlling Access to Web Flows

JasperReports Server uses Spring Web Flow to define and control its UI flow. A Spring flow is a sequence of related pages for which you define states and transitions in relation to your own business logic. In addition to controlling which items users see on the menus, you can control the functionality they can access by setting permissions on web flows.

Be very careful when setting access to existing web flows. UI components that depend on a web flow may not work properly if access to the web flow has been modified.

In this example, suppose you want to ensure users cannot access the Ad Hoc Editor through its URI. To do this, restrict the Ad Hoc web flow to administrative users:

1. Navigate to the Ad Hoc Editor by clicking the **Create Ad Hoc View** button on the home page. You see the URI for the flow in the navigation bar:

   `http://localhost:8080/jasperserver-pro/flow.html?_flowId=adhocFlow`

   This tells you that the URI for the Ad Hoc Editor flow is `adhocFlow`.

2. Open the file `<js-webapp>/WEB-INF/applicationContext-security.xml` for editing.
3. Locate the `flowVoter` bean. This bean sets the permissions for flows.

```xml
<bean id="flowVoter"
     class="com.jaspersoft.jasperserver.api.security.FlowRoleAccessVoter">
  <property name="flowAccessAttribute" value="FLOW_ACCESS"/>
  <property name="flowDefinitionSource">
    <value>
      repoAdminFlow=ROLE_ADMINISTRATOR
      ...
      searchFlow=ROLE_USER,ROLE_ADMINISTRATOR
      *=ROLE_USER,ROLE_ADMINISTRATOR
    </value>
  </property>
</bean>
```

This bean contains a number of flows set to ROLE_ADMINISTRATOR. Note that `adhocFlow` does not appear explicitly. However, there is an entry `*=ROLE_USER,ROLE_ADMINISTRATOR`. This setting determines access for all flows that are not specifically mentioned.

4. Set access for the Ad Hoc flow by adding an entry to restrict access to ROLE_ADMINISTRATOR as shown in the code sample above.

### 11.7.2.4 Loading Your Changes
1. Save the modified files and reload the web app in the app server to see the changes (see 11.4.1, “Reloading the JasperReports Server Web App,” on page 148).
2. When the web app has reloaded, log into JasperReports Server as `joeuser`. You can see that the button for creating a report is removed, and there is no `Create > Create Ad Hoc Report` menu item. Log out and log back in as `jasperadmin`. Both the button and the menu item are visible to administrators.

### 11.7.3 Adding an Item to the Main Menu

Adding menu items involves three files:

- The `actionModel` file for the menu item.
- The properties file that labels the menu item.
- An action file that handles events for the menu item.

This example adds a special menu item so that MyCompany employees can easily find their accounts reports.

1. Edit the file `<js-webapp>/WEB-INF/actionModel-navigation.xml`. Locate the `actionModel` for the `View` menu near the beginning of the file.

```xml
<!--context for view option on primary menu-->
<context name="main_view_mutton" test="!ibanUserRole">
  <selectAction labelKey="menu.repository">
    <option labelKey="menu.search" action="primaryNavModule.navigationOption" actionArgs="search"/>
    ...
  </selectAction>
  <option labelKey="NAV_028_ACCOUNTS" action="primaryNavModule.navigationOption" actionArgs="accounts"/>
</context>
```

Both the button and the menu item are visible to administrators.
Customizing the User Interface

2. Add a **separator** tag and an **option** tag for the menu item. The option tag has attributes to specify the label key and the name of the action to perform.

3. Open one of these files. The name of the properties file depends on your edition of JasperReports Server:

   **Commercial Editions:** `<js-webapp>/WEB-INF/bundles/pro_nav_messages.properties`
   **Community Project:** `<js-webapp>/WEB-INF/bundles/jasperserver_messages.properties`

   The names of the keys are slightly different depending on the file. The following example is based on the contents of the commercial edition `pro_nav_messages.properties`.

   ```properties
   NAV_001_HOME=Home
   NAV_002_VIEW=View
   NAV_003_MANAGE=Manage
   NAV_004_LOGOUT=Log Out
   NAV_005_CREATE=Create
   ...
   NAV_027_SEARCH=Search Results
   NAV_028_ACCOUNTS=MyCompany Accounts
   ...
   ```

4. Add the line for the **NAV_028_ACCOUNTS** property with an appropriate value, in this case **MyCompany Accounts**.

5. If you support multiple locales, add the same message key to the other language bundles.


   ```javascript
   var primaryNavModule = {
     NAVIGATION_MENU_CLASS : "menu vertical dropDown",
     ACTION_MODEL_TAG : "navigationActionModel",
     CONTEXT_POSTFIX : "_mutton",
     NAVIGATION_MUTTON_DOM_ID : "navigation_mutton",
     NAVIGATION_MENU_PARENT_DOM_ID : "navigationOptions",
     JSON : null,
     /**
      * Navigation paths used in the navigation menu
      */
     navigationPaths : {
       library : {url : "flow.html", params : "_flowId=searchFlow"},
       home : {url : "home.html"},
       logOut : {url : "exituser.html"},
       search : {url : "flow.html", params : "_flowId=searchFlow&mode=search"},
       report : {url : "flow.html", params : "_flowId=searchFlow&mode=search&
                  filterId=resourceTypeFilter&filterOption=resourceTypeFilter-reports&
                  searchText=""},
       accounts : {url : "flow.html", params : "_flowId=searchFlow&mode=search&
                  filterId=resourceTypeFilter&filterOption=resourceTypeFilter-reports&
                  searchText=account"},
       ...
   }
   ```

7. Add a URL and parameters to load the desired page in response to selecting the new accounts menu item. In the case of this example, the action is to perform a search for all reports with the word **account** in their name or description.

8. Save the modified files and reload the web app in the app server to see the changes (see 11.4.1, “Reloading the JasperReports Server Web App,” on page 148).
9. When the web app has reloaded, log into JasperReports Server as joeuser. You can see the View > MyCompany Accounts menu item was created and selecting it performs a customized search. The following figure shows both the menu item and the search results on the same page.

**Figure 11-11 Custom Menu Items and Corresponding Action**

### 11.7.4 Adding a New Main Menu

The following example shows two useful variants when adding custom menu items:

- You can add your own menus to the main menu bar.
- Menu items, added to either existing or custom menus, can link outside of the server.

This example creates a new menu named Accounts. It contains the internal search item created in the previous example and an external search with Google.

1. Edit the file `<js-webapp>/WEB-INF/actionModel-navigation.xml`. Add the menu definition with two menu items to the end of the file.

```xml
...<!--MyCompany custom menu-->
<context name="main_custom_mutton" test="!banUserRole">
  <selectAction labelKey="NAV_801_ACCOUNTS">
    <option labelKey="NAV_802_SEARCH_IN" action="primaryNavModule.navigationOption" actionArgs="accounts"/>
    <option labelKey="NAV_803_SEARCH_OUT" action="externalSearchHandler" actionArgs="MyCompany+account"/>
  </selectAction>
</context>
</actions>
```

The two menu items have a label and an action defined, but no conditions. All users can access these menu items. The internal search item is the same as the MyCompany Accounts example above. The external search item needs to have its own action that you’ll define in another file.

2. Open the properties file for your edition of JasperReports Server:

   Commercial Editions: `<js-webapp>/WEB-INF/bundles/pro_nav_messages.properties`
   Community Project: `<js-webapp>/WEB-INF/bundles/jasperserver_messages.properties`

3. Add three simple labels, one for each key defined in the `actionModel` file.

   ```properties
   NAV_801_ACCOUNTS=Accounts
   NAV_802_SEARCH_IN=Accounts Reports
   NAV_803_SEARCH_OUT=Google MyCompany Accounts
   ```
4. If you support multiple locales, add the same message key to the other language bundles.
5. Edit the file <js-webapp>/scripts/actionModel.primaryNavigation.js. Add the accounts navigation path if you didn’t do so in the previous procedure:

```javascript

...  
navigationPaths : {  
...  
    accounts : {url : "flow.html", params : "_flowId=searchFlow&mode=search&filterId=resourceTypeFilter&filterOption=resourceTypeFilter-reports&searchText=account"},  
...  
```

The accounts navigation path used in the previous example is the same as the one used in this example. It performs a search of reports in the repository containing the word account in their name or description.

6. In the same <js-webapp>/scripts/actionModel.primaryNavigation.js file, add the external search handler function to the end of the file, outside of all other definitions:

```javascript

var externalSearchHandler = function(qstring) {
    window.location.href = "http://google.com/search?q=" + qstring;
};
```

7. Save the modified files and reload the web app in the app server to see the changes (see 11.4.1, “Reloading the JasperReports Server Web App,” on page 148).

8. When the web app has reloaded, log into JasperReports Server as joeuser. You can see the new Accounts menu with Accounts > Google MyCompany accounts opening a Google search. The following figure shows both the new menu and the external search results.

![Figure 11-12 Creating a Custom Menu and an External Link](image)

The menu shown is the one seen by joeuser. The actionModel automatically creates and places the new menu and its menu items. For jasperadmin who also sees the Manage menu, the Accounts menu would be closer to the metalinks; a second menu might overlap them. When creating custom menus whose visibility is based on roles, be sure to test different users to see the different UI layouts.

You may need to adjust other parts of the UI, such as the placement of the metalinks or search field. In this case you could use the Themes mechanism as described in section 11.1.5, “Changing the Spacing in the UI,” on page 137 to avoid overlap with the search field.
11.7.5 Changing Other Menus

The context menus available on folder and resources when browsing or searching the repository can also be customized. They use the same action model mechanism that you can customize as shown in the preceding sections. Context menus are defined in the file `<js-webapp>/WEB-INF/actionModel-search.xml`.

Menus for the Dashboard Designer are defined in the file `<js-webapp>/WEB-INF/actionModel-dashboard.xml`.

You can customize the menus in the Ad Hoc Editor in the following files:
- `<js-webapp>/WEB-INF/actionModel-adhocChart.xml`
- `<js-webapp>/WEB-INF/actionModel-adhocCrosstab.xml`
- `<js-webapp>/WEB-INF/actionModel-adhocOlapCrosstab.xml`
- `<js-webapp>/WEB-INF/actionModel-adhocTable.xml`

11.7.6 Action Model Reference

The action model is a complex mechanism for generating menus dynamically. In particular, menus in Ad Hoc must be generated programmatically based on the contents of the reports, for example the context menu on a column. The following high-level steps explain how menus are generated:

When generating menus, the Ad Hoc Editor follows these steps:

1. Whenever a page with menus is to be displayed for the first time, the server looks up the corresponding action model XML definition and use JDOM (Java-based Document Object Model for XML) to build a Document that gets cached.
2. Subsequent viewings reference the cached Document.
3. After the page is modified (usually triggered by an Ajax Request) the server generates a client side action model in the form of a JSON expression. Based on the current page state, the client model is a filtered version of the full action model in which internationalized names and generated options are resolved, and so forth.
4. Every time a menu is requested on the client, the server looks up the context in the JSON model, and for each action, clones the appropriate HTML template for the menu and tweaks its attributes accordingly.

Some pages have mostly static menus that don’t change based on page contents. Other pages, such as the Ad Hoc Editor, have dynamic menus that are updated in this way in response to changes the user makes on a page.

The following sections document the XML elements used the action model definition files. In particular, you can define various conditions at several levels so that menus only appear to certain users or based on the current state of the page.

11.7.6.1 Context

Each context represents a distinct menu type and refers to the part of the design page that launches that menu. Examples are `reportLevel`, `columnLevel`, `fieldLevel`. They are directly equivalent to the menu levels defined in the popup-style JSP files used in previous releases.

11.7.6.2 Condition

A condition element invokes the specified server side test as a method on the view model. The enclosed actions are only included in the client action model if the test returns true.

If the test has a leading exclamation point (!), the condition tests for false:

- `test` – The name of the java method to be invoked on the view model.
- `testArgs` – Array of parameters to be passed to the above test, expressed as a comma-separated string.
### 11.7.6.3 Actions

Each defined action produces a row or rows in the generated menu. The following tables describe the several action types.

<table>
<thead>
<tr>
<th><strong>simpleAction</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A standalone menu action that, when clicked, fires the specified JavaScript method.</strong></td>
</tr>
</tbody>
</table>

#### Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>id</strong></td>
<td>The ID of the menu row DOM object.</td>
</tr>
<tr>
<td><strong>disabled</strong></td>
<td>If set to true, disable this row initially (shows a grey block instead).</td>
</tr>
<tr>
<td><strong>labelKey</strong></td>
<td>The text the menu should display. If it corresponds to an localization bundle key it is translated, otherwise it is displayed as is.</td>
</tr>
<tr>
<td><strong>labelCondition</strong></td>
<td>Sometimes the label value is contingent on the current state. The label condition references a Java method on the view model and should return a boolean. A labelCondition defines two labelOption sub elements (see below).</td>
</tr>
<tr>
<td><strong>clientTest</strong></td>
<td>Only generate a row for this action if it passes the specified JavaScript method. If the clientTest has a leading exclamation point (!), tests for false.</td>
</tr>
<tr>
<td><strong>clientTestArgs</strong></td>
<td>An array of parameters pass to the above test, expressed as a comma delimited string.</td>
</tr>
<tr>
<td><strong>action</strong></td>
<td>The JavaScript method to be fired when the action is taken.</td>
</tr>
<tr>
<td><strong>actionArgs</strong></td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant.</td>
</tr>
<tr>
<td><strong>leaveMenuOpen</strong></td>
<td>If true the menu stays displayed after action.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>separator</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Not strictly an action. Outputs a separator bar. The style of the bar automatically adjusts to the current nesting level.</strong></td>
</tr>
</tbody>
</table>

#### Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>attributes</strong></td>
<td>Only generate a row for this action if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td><strong>clientTest</strong></td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant.</td>
</tr>
<tr>
<td><strong>disabled</strong></td>
<td>Disable this row initially (shows a grey block instead).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>selectAction</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A drop down (roll down) parent. Selectors can now be nested up to three levels deep. The menu automatically renders the roll-downs in a nested fashion.</strong></td>
</tr>
</tbody>
</table>

#### Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>attributes</strong></td>
<td>If set to true, disable this row initially (shows a grey block instead).</td>
</tr>
<tr>
<td><strong>opened</strong></td>
<td>If set to true, selector is opened initially.</td>
</tr>
<tr>
<td><strong>labelKey</strong></td>
<td>The text for the menu to display. If it corresponds to an localization bundle key it is translated, otherwise it is displayed as is.</td>
</tr>
<tr>
<td><strong>labelCondition</strong></td>
<td>Sometimes the label value is contingent on the current state. The label condition references a java method on the view model and should return a boolean. A labelCondition defines two labelOption sub elements (see below).</td>
</tr>
</tbody>
</table>
### 11.7.6.4 Options

Some actions can have child elements, as described in the following tables.

#### option

Child of selectAction. Defines a static menu option. Use this when you can't define options programmatically.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>The ID of the menu row DOM object.</td>
</tr>
<tr>
<td>disabled</td>
<td>If set to true, disable this row initially (shows a grey block instead).</td>
</tr>
<tr>
<td>button</td>
<td>If set to true the option displayed as a button (as in formula builder).</td>
</tr>
<tr>
<td>labelKey</td>
<td>The text for the menu to display. If it corresponds to a localization bundle key it is translated, otherwise it is displayed as is.</td>
</tr>
<tr>
<td>labelCondition</td>
<td>Sometimes the label value is contingent on the current state. The label condition references a java method on the view model and should return a boolean. A labelCondition defines two labelOption sub elements (see below).</td>
</tr>
<tr>
<td>clientTest</td>
<td>Only generate a row for this action if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td>clientTestArgs</td>
<td>An array of parameters to be passed to the above test, expressed as a comma delimited string.</td>
</tr>
<tr>
<td>allowsInputTest</td>
<td>Show an input box in this option if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td>allowsInputTestArgs</td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant.</td>
</tr>
<tr>
<td>action</td>
<td>The JavaScript method to be fired when the action is taken.</td>
</tr>
<tr>
<td>actionArgs</td>
<td>An array of parameters to be passed to the above test, expressed as a comma delimited string.</td>
</tr>
<tr>
<td>isSelectedTest</td>
<td>Indicate a check mark next to this option if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td>isSelectedTestArgs</td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant.</td>
</tr>
</tbody>
</table>

#### generatedOptions

Child of selectAction. Defines a set of dynamically-defined options.

<table>
<thead>
<tr>
<th>Reserved Variables (in addition to standard reserved variables)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${optionId}</td>
<td>Programatically assigned ID. If function returns a Map this is the key part of each key-value pair, if it returns a Collection it is the toString value of each element.</td>
</tr>
<tr>
<td>${optionValue}</td>
<td>Programatically assigned display value. If function returns a Map this is the value part of each key-value pair, if it returns a Collection it is the toString value of each element.</td>
</tr>
<tr>
<td>$R{&lt;String&gt;}</td>
<td>When used in a label expression attempts to internationalize the enclosed String and if it fails it returns the literal value.</td>
</tr>
</tbody>
</table>
## Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>id</strong></td>
<td>The ID of the menu row DOM object.</td>
</tr>
<tr>
<td><strong>function</strong></td>
<td>The name of the java method to invoke on the view model that is used to generate the options. The function can return either a Map or a Collection. The type of object returned affects how the ${optionValue} and ${optionId} reserved variables are interpreted (see above).</td>
</tr>
<tr>
<td><strong>functionArgs</strong></td>
<td>An array of parameters to pass to the above test, expressed as a string delimited by the @@ string constant.</td>
</tr>
<tr>
<td><strong>labelKey</strong></td>
<td>The text for the menu to display. If it corresponds to an localization bundle key it is translated, otherwise it is displayed as is.</td>
</tr>
<tr>
<td><strong>labelCondition</strong></td>
<td>Sometimes the label value is contingent on the current state. The label condition references a java method on the view model and should return a boolean. A labelCondition defines two labelOption sub elements (see below).</td>
</tr>
<tr>
<td><strong>labelExpression</strong></td>
<td>Allows a custom label to be defined and allows full use of all reserved variables. (e.g. labelExpression=&quot;${optionValue}&quot;)  $R{ADH_252_DATA_ROWS}&quot;).</td>
</tr>
<tr>
<td><strong>clientTest</strong></td>
<td>Only generate a row for this action if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td><strong>clientTestArgs</strong></td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant. If no actionArgs are specified, the ${optionId} variable is automatically assigned as an argument.</td>
</tr>
<tr>
<td><strong>allowsInputTest</strong></td>
<td>Show an input box in this option if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td><strong>allowsInputTestArgs</strong></td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant. If no actionArgs are specified, the ${optionId} variable is automatically assigned as an argument.</td>
</tr>
<tr>
<td><strong>action</strong></td>
<td>The JavaScript method to be fired when the action is taken.</td>
</tr>
<tr>
<td><strong>actionArgs</strong></td>
<td>An array of parameters to be passed to the above test, expressed as a comma delimited string. If no actionArgs are specified, the ${optionId} variable is automatically be assigned as an argument.</td>
</tr>
<tr>
<td><strong>leaveMenuOpen</strong></td>
<td>If true the menu stays displayed after action (for all generated options).</td>
</tr>
<tr>
<td><strong>isSelectedTest</strong></td>
<td>Indicate a check mark next to this option if it passes the specified JavaScript method.</td>
</tr>
<tr>
<td><strong>isSelectedTestArgs</strong></td>
<td>An array of parameters to be passed to the above test, expressed as a string delimited by the @@ string constant. If no actionArgs are specified, the ${optionId} variable is automatically assigned as an argument.</td>
</tr>
</tbody>
</table>

### Default Settings (DOM attributes set automatically on each generated Option)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>id</strong></td>
<td>If not specified as an a attribute defaults to the ${optionId} variable.</td>
</tr>
<tr>
<td><strong>clientTestArgs</strong></td>
<td>If not specified as an a attribute defaults to the ${optionId} variable.</td>
</tr>
<tr>
<td><strong>actionArgs</strong></td>
<td>If not specified as an a attribute defaults to the ${optionId} variable.</td>
</tr>
<tr>
<td><strong>isSelectedArgs</strong></td>
<td>If not specified as an a attribute defaults to the ${optionId} variable.</td>
</tr>
</tbody>
</table>
### 11.7.6.5 Special Expressions

The following special expressions are converted to built-in variable values when used as arguments for client functions:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>${selected}</td>
<td>The JavaScript array of selected objects on the client.</td>
</tr>
<tr>
<td>${event}</td>
<td>The JavaScript event object.</td>
</tr>
<tr>
<td>${label}</td>
<td>The generated label for this menu.</td>
</tr>
</tbody>
</table>

### 11.7.6.6 Menu DHTML API

This is a set of JavaScript functions defined on actionModel.js to dynamically manipulate a menu’s look and feel after it has already been displayed. You can use them to change the Ad Hoc Editor menus in run-time. Most of them take the `menuRow` or the `menuRow`’s identifier as arguments. Some have additional arguments as well; for more information about the additional arguments, refer to the code itself.
Customizing the User Interface

11.8 Working With Source Code Files

The rest of the customizations in this chapter require writing Java classes to perform some part of the new functionality. Even if you don’t modify the source code of JasperReports Server, you must compile your code with the server in order to deploy your custom features. When you redeploy the web application the existing files that are running in the application server are replaced with those you just compiled. As a result, you must make all of your changes in the source code.

Customizations that involve changes to Java source code have the following requirements:
- You must download the source code distribution and set up an environment where you can build it.
- All files being changed must be edited in the source code, even the interpreted files. This section gives the path to all files in `<js-src>`, which represents the root of the source code. Pay close attention to the path names, because many are similar.
- In order to see the changes, you must then build the source code and redeploy the web application.

To obtain the source code distribution, see the following links. To build and deploy the source code, follow the instructions in the JasperReports Server Source Build Guide within each distribution:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hideInputForOption</td>
<td>Hide the input box on the option.</td>
</tr>
<tr>
<td>showInputForOption</td>
<td>Show the input box on the option.</td>
</tr>
<tr>
<td>setRowColor</td>
<td>Set the <code>backgroundColor</code> to the specified color.</td>
</tr>
<tr>
<td>resetRowColor</td>
<td>Restore original background color.</td>
</tr>
<tr>
<td>getLabel</td>
<td>Return the current label for this row.</td>
</tr>
<tr>
<td>setLabel</td>
<td>Set the label for this row.</td>
</tr>
<tr>
<td>disableRow</td>
<td>Grey out the row.</td>
</tr>
<tr>
<td>enableRow</td>
<td>Restore the row to active state.</td>
</tr>
</tbody>
</table>

Commercial Editions: [http://support.jaspersoft.com](http://support.jaspersoft.com) then navigate to Downloads and Source Code
Community Project: [http://community.jaspersoft.com/project/jasperreports-server/releases](http://community.jaspersoft.com/project/jasperreports-server/releases) (requires Subversion)

In most case, after the first time you have successfully built and deployed the source code, you do not need to edit the properties files or JVM settings when you rebuild after adding new customizations. You also do not need to create or load the databases.

The following procedure gives an example of the steps for building and re-deploying the web app after making changes to the source code. This example uses the commercial source code distribution and assumes you are using Apache Tomcat in a Windows environment.

**To rebuild the source code:**
1. Make sure that all your file changes are saved in the `<js-src>` tree.
2. Stop the application server.
3. Select the Start Menu > Accessories, right-click Command Prompt, and select Run as Administrator.
   
   If you do not run Command Prompt as administrator, the build can fail during the deployment phase due to permissions problems when adding and deleting files.

4. Go to the buildomatic directory in the source distribution:
   ```
   cd <js-src>/jasperserver/buildomatic
   ```
5. Enter the following commands, checking for the BUILD SUCCESSFUL message upon completion of each one:
   ```
   js-ant build-ce
   ```
11.9 Adding a Custom JSP Page in a Spring Web Flow

The flexibility of JasperReports Server lets you create your own JSP pages that integrate into the UI. In order for the SiteMesh decorator to process a custom JSP page, you must integrate it into the Spring Web Flow framework. A flow is a sequence of related pages for which you define states and transitions in relation to your own business logic. This example shows how to add a single page, but you could integrate a series of pages and the navigation between them.

To further integrate with the server, your pages should use the CSS building blocks provided in themes to replicate the menu and column layout of the server. You can then apply the default theme of the UI or design your own style in a custom theme.

Spring Web Flow relies on the Spring MVC (Model, View, and Controller) module to implement the web interface, where the controller is a Java class. As a result, adding business logic to a web flow involves creating Java methods to implement the logic. In general, the server UI contains most of the functionality in action class code that can be associated with one or more JSP pages. The JSP files have minimal functionality because JSP code logic can become very cluttered and hard to follow. The action classes are pure Java and thus easier to organize. In this example, the Java method simply returns `success` whenever it is invoked.

For more information, refer to the Spring documentation for flows and MVC.

This example requires you to work with the JasperReports Server source code, as explained in section 11.8, “Working With Source Code Files,” on page 167.

This example is divided into several parts:
1. Adding a custom JSP file integrated into the server as a web flow.
2. Creating an action and adding it to the web flow.
3. Adding the web flow to a menu.

**Example of adding a custom JSP file integrated into the server as a web flow:**

1. Create a subdirectory named sampleFlow for the JSP files in your flow module in `<js-src>/jasperserver-pro/jasperserver-war/src/main/webapp/WEB-INF/jsp/`. For example:
   ```bash
cd <js-src>/jasperserver-pro/jasperserver-war/src/main/webapp/WEB-INF/jsp/
mkdir sampleFlow
   
2. Create the following JSP file and save it as sampleView.jsp in `<js-src>/jasperserver-pro/jasperserver-war/src/main/webapp/WEB-INF/jsp/sampleFlow`:
   ```html
<html>
<head><title>Sample Page</title>
</head>
<body class="oneColumn primary column">
<h1 class="textAccent">Hello World!</h1>
</body>
</html>
   ```

Design the layout of your custom content based on the UI components in the server. The UI components are defined in the CSS files in the `<js-src>/jasperserver-war/src/main/webapp/themes/default/` directory. You can see a gallery of samples by logging in as jasperadmin and selecting View > UI Samples.

This example uses a one-column layout and the textAccent font.

6. Restart Tomcat.
3. Create the following XML file with a flow container element and an empty view-state element. In a later step, you will add an action state:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<flow xmlns="http://www.springframework.org/schema/webflow" xmlns:ns0="http://www.w3.org/2001/XMLSchema-instance"
      ns0:schemaLocation="http://www.springframework.org/schema/webflow http://www.springframework.org/schema/webflow/spring-webflow-2.0.xsd"
      start-state="sampleView">
    <view-state id="sampleView" view="modules/sampleFlow/sampleView"/>
    <end-state id="done"/>
</flow>
```


**Example of setting flow permissions**

5. Set permissions for your flow. To do this:
   a. Edit the file `<js-src>/jasperserver/common/shared-config/applicationContext-security.xml`.
   b. Locate the `flowVoter` bean. This bean sets the permissions for flows.
   c. Add a line for your flow and set the permissions to `ROLE_ADMINISTRATOR`.

```xml
<bean id="flowVoter"
      class="com.jaspersoft.jasperserver.api.security.FlowRoleAccessVoter">
  <property name="flowAccessAttribute" value="FLOW_ACCESS"/>
  <property name="flowDefinitionSource">
    <value>
      repoAdminFlow=ROLE_ADMINISTRATOR
      ...
      docSampleFlow=ROLE_ADMINISTRATOR
      <!--objectPermissionToUserFlow=ROLE_ADMINISTRATOR-->
      searchFlow=ROLE_USER,ROLE_ADMINISTRATOR
      *=ROLE_USER,ROLE_ADMINISTRATOR
    </value>
  </property>
</bean>
```

The final entry in the `flowVoter` bean, `*=ROLE_USER,ROLE_ADMINISTRATOR`, sets the default permissions for all flows not specified directly. If you do not create an entry for your flow, these permissions apply.

**Example of creating an action and adding it to the flow**

6. Create a java class that defines the controller in the Spring MVC framework. In this example, this file always returns `success` when it is invoked.
   a. Go to the `<js-src>/jasperserver/jasperserver-war-jar/src/main/java/com/jaspersoft/ji/war/` directory. This is where the JasperReports Server source looks for java files used by the Spring web flow framework.
b. Create a subdirectory for your flow package, `<js-src>/jasperserver/jasperserver-war-jar/src/main/java/com/jaspersoft/ji/war/sampleFlow/`


```java
package com.jaspersoft.ji.war.sampleFlow;

import org.springframework.webflow.action.MultiAction;
import org.springframework.webflow.execution.Event;
import org.springframework.webflow.execution.RequestContext;

public class SampleAction extends MultiAction {

    public Event start(RequestContext context) throws Exception{
        // implement some logic
        return success();
    }
}
```

7. Create a bean for the `SampleAction` class that you created. To this, create the following file and save it as `<js-src>/jasperserver/jasperserver-war/src/main/webapp/WEB-INF/flows/docSampleBeans.xml`:

```xml
<beans xmlns="http://www.springframework.org/schema/beans"
      xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
      xmlns:util="http://www.springframework.org/schema/util"
    <bean id="sampleAction" class="com.jaspersoft.ji.war.sampleFlow.SampleAction"/>
</beans>
```

8. Modify `docSampleFlow.xml` to start with an action state that calls the `SampleAction` class you created:
   a. Change the start-state to `start`.
   b. Create an action state `start` that calls `sampleAction` and transitions to the view-state `sampleView` on success. Insert this state before `sampleView`.
   c. At the end of the flow, import `docSampleBeans.xml` as a resource.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<flow xmlns="http://www.springframework.org/schema/webflow"
      xmlns:ns0="http://www.w3.org/2001/XMLSchema-instance"
      ns0:schemaLocation="http://www.springframework.org/schema/webflow
                          http://www.springframework.org/schema/webflow/spring-webflow-2.0.xsd"
      start-state="start"/>
```
9. Add error handling as shown in the code sample above:
   a. Add a view-state errorPage to your flow. In this example, you add it immediately after sampleView.
   b. Add a global-transitions state that handles Java exceptions by displaying errorPage.
10. (Optional) If you wish, you can rebuild the source code and view your page:
   - Rebuild the source code and redeploy the web application according to the instructions in the Building JasperReports Server section in the JasperReports Server Source Build Guide within your distribution. Section 11.8, "Working With Source Code Files," on page 167 gives an overview of this process.
   - Log in to your JasperReports Server.
   - Navigate to the page you created using this URL:
     http://<hostname>:<port>/jasperserver-pro/flow.html?_flowId=docSampleFlow
     Example:
     http://localhost:8080/jasperserver-pro/flow.html?_flowId=docSampleFlow

Example of creating a menu item to call your flow

Now you can add a menu item to call the flow you created. The process is similar to the one described in section 11.7.3, “Adding an Item to the Main Menu,” on page 158, but because you are modifying the source, the file locations are different in this example.

Because the commercial source code includes the community source, most modifications to the menu are made in the community source files.

12. Add an option tag for the menu item, as shown in the following code sample. The option tag has attributes to specify the label key and the name of the action to perform.

```xml
<context name="main_view_mutton" test="!banUserRole">
  <selectAction labelKey="menu.repository">
    ...
    <condition test="checkAuthenticationRoles" testArgs="ROLE_ADMINISTRATOR">
      <option labelKey="menu.samples" clientTest="!isIPad"
        action="primaryNavModule.navigationOption" actionArgs="samples"/>
    </condition>
    <separator/>
    <condition test="checkAuthenticationRoles" testArgs="ROLE_ADMINISTRATOR">
      <option labelKey="NAV_028_DOC_SAMPLE" action="primaryNavModule.navigationOption"
        actionArgs="docSample"/>
    </condition>
  </selectAction>
</context>
```

13. Add a condition tag for the menu item, as shown in the code sample above.

The condition tag prevents the menu item from being displayed to users without the specified permissions. However to ensure that the flow cannot be accessed via URL, set flow permissions as shown in step 5.

14. Add the label key to the file <js-src>/jasperserver-pro/jasperserver-war/src/main/webapp/WEB-INF/bundles/pro_nav_messages.properties, as shown in the following code sample:

```properties
NAV_001_HOME=Home
...
NAV_027_SEARCH=Search Results
NAV_028_DOC_SAMPLE=Hello World
...
NAV_031_USERS=Users
...
```

15. Edit the file <js-src>/jasperserver/jasperserver-war/src/main/webapp/scripts/actionModel.primaryNavigation.js, and locate the navigationPaths section. Add a line that specifies the accounts flow to begin when the menu item is selected. If you are adding your line at the end of the section, make sure to add a comma to the previous line.

```javascript
var primaryNavModule = {
  ...
  navigationPaths : {
    ...
    logSettings : {url : "log_settings.html"},
    docSample : {url : "flow.html", params : "_flowId=docSampleFlow"}
  },
...
```

**Compile code and view changes**

16. Rebuild the source code and redeploy the web application according to the instructions in the *JasperReports Server Source Build Guide* within your distribution. Section 11.8, “Working With Source Code Files,” on page 167 gives an overview of this process.
17. Log in as an administrator. If your changes were successful, this example displays the **View > MyCompany Accounts** menu item to users, and selecting it displays the custom page defined in the sampleView.jsp file:

![Custom JSP in a Custom Flow](image)

*Figure 11-13 Custom JSP in a Custom Flow*

The page uses the single column layout and the orange text is the `textAccent` class in CSS.

### 11.10 Adding Custom Export Channels

When users run reports in JasperReports Server, they can export the results in several formats, such as PDF and ODT. If your users need to export to other file formats, you can create a custom export channel. You must implement a custom Java class that generates the required file format then integrate the new class into the server. As a result, this customization must be made in the source code of JasperReports Server.

In the following example, a custom export channel is added to the server’s pluggable, flexible export channel list. The example adds the export channel in three places: the report viewer, the scheduler, and web services.

This section assumes the following:

- You are familiar with the underlying technologies, such as Java, Spring, JSPs, and web services.
- You have downloaded and tested the source code distribution, as described in section 11.8, “Working With Source Code Files,” on page 167. Paths and filenames in this section are based on the `<js-src>` location.
- You have implemented an exporter class that can be integrated with JasperReports Server. The section further assumes that your exporter class creates files with a `.<MyFormat>` file extension and format.
- That, where the instructions read `<MyFormat>`, you have used the correct name for your export format. For example, if you are creating an exporter that generates .DBF files, where the instructions describe the `Report<MyFormat>Exporter` class, your class is called `ReportDBFExporter`.

#### 11.10.1 About Export Parameters

Export parameters define how JasperReports Server generates your output format. For example, consider the paginated Excel exporter. Its export parameters determine how a report is converted to the XLS file format. The parameter settings have such information as whether each page of the report should be represented as a separate sheet in the Excel spreadsheet (IS_ONE_PAGE_PER_SHEET).

Export parameters have default values that can be set at the report- or application-level. Many of the parameters are optional; others are valid only for certain export channels. When you create an export channel, you can define such parameters to control how your reports are exported in the new format. If you don’t need to specify such settings when reports are run, you might not need to define any parameters.
11.10.2 Adding the Exporter to the Report Viewer

The most prominent place that the export channel should be available is the page that appears when the report is run. Figure 11-9, “Default Appearance of the Report Viewer,” on page 152 shows the drop-down list of export channels in the default report viewer. Adding a new exporter to the report viewer involves:

- Implementing a new exporter action class that extends AbstractReportExporter.
- Implementing a new export parameters bean class that extends AbstractExportParameters.
- Creating a new export configuration bean of type ExporterConfigurationBean.
- Adding a resource bundle property for the label in the menu.

To add the exporter to the default report viewer:

   For guidance about creating such a class, look at the ReportCsvExporter class, which is similar. It is found in the com.jaspersoft.jasperserver.war.action package.

2. Create a new export parameters Java bean class, which should implement Serializable and extend the com.jaspersoft.jasperserver.api.engine.jasperreports.common.AbstractExportParameters class. It should implement the public void setPropertyValues(Object object) method, which is required to perform dynamic data binding and validation. Give the class a unique name, such as <MyFormat>ExportParametersBean, and ensure that it contains only user-customizable export parameters (that is, it should not contain the JRExporterParameter.JASPER_PRINT or JRExporterParameter.OUTPUT_FILE_NAME parameters, which are already set). For an example, see the XlsExportParametersBean class in the com.jaspersoft.jasperserver.api.engine.jasperreports.common package.

3. Now that you have everything you need to view the new export format, and you must configure it for Spring.
   There are two ways to set export parameter values:
   - Application-level settings. These settings set the defaults for all reports in the repository, including all export parameter values. They apply in the absence of report-level settings. This is the server’s default behavior.
   - Report-level settings. These settings allow an individual report to have different values from the default. Every report in the repository can have user-defined export parameter values.

   To enable report-level settings, edit the file <js-src>/jasperserver/common/shared-config/applicationContext.xml. Locate the configurationBean bean, and set the reportLevelConfigurable property to true. This enables the report-level settings mode; otherwise, parameter values are inherited from the application-level settings. If a report includes exporter hint properties, they override the application-level values.

   The configurable list of exporters is controlled by the configuredExporters property in the reportExporter bean. The list of exporters is defined by the exporterConfigMap at the end of the file. Its keys are important because it is the key name that is sent to the server when a user clicks an export button. Key names are also part of some state names in the associated web flow, so you must be careful to use correctly-implemented names when adding a new object in the exporterConfigMap map.
   As a rule, all key names should correspond with the extension name of the file generated by the given exporter (for example, the key for Excel exporter is xls, and the key for PDF exporter is pdf). While using file extensions as key names is not mandatory, Jaspersoft strongly recommends it, as in the case of <MyFormat>.
   Add a new entry in the exporterConfigMap element:
   `<entry key="<MyFormat>" value-ref="<MyFormat>ExporterConfiguration"/>
   5. The values in the exporterConfigMap object are com.jaspersoft.jasperserver.war.action.ExporterConfigurationBean objects, which defines a custom type that stores configuration information about any given exporter.
   Create a bean named <MyFormat>ExporterConfiguration with the following properties. For guidance, refer to the similar objects in the viewReportBeans.xml file.
   - iconSrc – A context-relative path to the icon for the tool bar button; usually icons are stored in the /images location. Any new exporter should have a related icon image saved in that directory. The icon should be 18 pixels by 18 pixels.
Customizing the User Interface

- descriptionKey – A key in the jasperserver_messages.properties resource bundle file that should be displayed as the tooltip when the mouse is held over exporter’s icon; you’ll add this key to the jasperserver_messages.properties file in step 7.
- exportParameters – A com.jaspersoft.jasperserver.api.engine.jasperreports.common.ExportParameters XML bean, which wraps a specific export parameters class that contains export parameter default values. In the case of this example, use the <MyFormat>ExportParametersBean class you created in step 2. Name it <MyFormat>ExportParameters.
- currentExporter – An AbstractReportExporter type object that contains specific export business logic; for example, the Report<MyFormat>Exporter class you created.


7. In the file <js-src>/jasperserver/jasperserver-war/src/main/webapp/WEB-INF/bundles/jasperserver_messages.properties, add a new key for your exporter’s name and tooltip:

   jasper.report.view.hint.export.<MyFormat>=<MyFormat Tooltip Description>

   If your server instance supports multiple languages, be sure to add the correct entries in the properties file for each supported language.

8. Finally, edit the file <js-src>/jasperserver/common/shared-config/applicationContext.xml to add the additional export parameters. Create a bean with the name <MyFormat>ExportParameters and configure it. For guidance, refer to the similar ExportParameters beans in the file. You must also edit the applicationContext-report-scheduling.xml file found in the same location; this file defines the parameters used when reports are scheduled. For more information about configuring the exporter for scheduled reports, refer to the following section.

9. The new output format is now configured. Compile the source code and redeploy the web application, as described in section 11.8, “Working With Source Code Files,” on page 167.

   Your new exporter appears in the list of exporters when you run a report. When selected, the report is exported in the new file format.

11.10.3 Adding the Export Format to the Scheduler

When users schedule reports, they specify the file format to generate when the report runs. The report scheduling mechanism is more complicated than the mechanism that displays reports directly to users, so the process of adding an export format to the scheduler is also more complicated.

Adding a new export format to the scheduler requires these steps:

- Implement the Output interface.
- Define a key for your exporter.
- Implement a new export parameters bean class.
- Register the new export format in Spring configuration files.

To add the exporter to the report scheduler:

1. Create a class that implements the com.jaspersoft.jasperserver.api.engine.scheduling.quartz.Output interface and name it <MyFormat>ReportOutput. You must implement the getOutput() method, which generates the output to the new myformat format and returns a com.jaspersoft.jasperserver.api.engine.scheduling.quartz.ReportOutput object. If your format required custom default values for the export parameters at the application level, this class should contain also a com.jaspersoft.jasperserver.api.engine.jasperreports.common.ExportParameters property, named exportParams. For guidance, refer to the com.jaspersoft.jasperserver.api.engine.scheduling.quartz.XlsReportOutput class.

Figure 11-14 Default Export Formats on the Scheduler Output Page

Adding a new export format to the scheduler requires these steps:

- Implement the Output interface.
- Define a key for your exporter.
- Implement a new export parameters bean class.
- Register the new export format in Spring configuration files.

To add the exporter to the report scheduler:

1. Create a class that implements the com.jaspersoft.jasperserver.api.engine.scheduling.quartz.Output interface and name it <MyFormat>ReportOutput. You must implement the getOutput() method, which generates the output to the new myformat format and returns a com.jaspersoft.jasperserver.api.engine.scheduling.quartz.ReportOutput object. If your format required custom default values for the export parameters at the application level, this class should contain also a com.jaspersoft.jasperserver.api.engine.jasperreports.common.ExportParameters property, named exportParams. For guidance, refer to the com.jaspersoft.jasperserver.api.engine.scheduling.quartz.XlsReportOutput class.

Figure 11-14 Default Export Formats on the Scheduler Output Page

Adding a new export format to the scheduler requires these steps:

- Implement the Output interface.
- Define a key for your exporter.
- Implement a new export parameters bean class.
- Register the new export format in Spring configuration files.

To add the exporter to the report scheduler:

1. Create a class that implements the com.jaspersoft.jasperserver.api.engine.scheduling.quartz.Output interface and name it <MyFormat>ReportOutput. You must implement the getOutput() method, which generates the output to the new myformat format and returns a com.jaspersoft.jasperserver.api.engine.scheduling.quartz.ReportOutput object. If your format required custom default values for the export parameters at the application level, this class should contain also a com.jaspersoft.jasperserver.api.engine.jasperreports.common.ExportParameters property, named exportParams. For guidance, refer to the com.jaspersoft.jasperserver.api.engine.scheduling.quartz.XlsReportOutput class.
2. Associate a new key with your `<MyFormat>`ReportOutput business class and name this key `<MyFormat>`. In order to preserve backward compatibility, the keys and integer numbers must correspond. Edit the file `<js-src>/jasperserver-war/src/main/webapp/WEB-INF/bundles/jasperserver_config.properties` to add a new row:

```
report.scheduling.output.format.{number}=<MyFormat>
```

Replace the `{number}` placeholder with the next greater integer number to continue the series defined in the properties file.

3. Edit the file `<js-src>/jasperserver/common/shared-config/applicationContext-reportscheduling.xml` to make the following changes:

   a. Associate a new key with your `<MyFormat>`ReportOutput business class and name this key `<MyFormat>`. In order to preserve backward compatibility, the keys and integer numbers must correspond.

      Add a new entry in the outputKeyMapping bean similar to the following:

      ```xml
      <entry key="{number}" value="<MyFormat>"/>
      ```

      Replace the `{number}` placeholder with the next consecutive integer key number to continue the series. For example, if you were adding a DBF exporter and the last key number in the map is 10, the line might be similar to:

      ```xml
      <entry key="11" value="DBF"/>
      ```

   b. Create a new `<MyFormat>`ExportParameters bean and specify a parent listed in the applicationContext.xml file. If necessary, the new bean should contain scheduling-specific values for export parameters. If no values are set, the default values are read from the parent bean. For guidance, refer to the `<MyFormat>`ExportParameters bean.

   c. Add the new `<MyFormat>`ExportParameters bean in the `jobExportParametersMap` map object. Follow the pattern used by the existing map entries.

   d. Create a new `<MyFormat>`Output bean object of type `com.jaspersoft.jasperserver.api.engine.scheduling.quartz.<MyFormat>ReportOutput`, which wraps the `<MyFormat>ReportOutput` object you created in step 1. If the exportParams property is present, the `<MyFormat>`Output bean should contain a property named exportParams, as well. For guidance, refer to the htmlOutput and xlsOutput objects.

   e. Add the new `<MyFormat>`Output bean in the `outputFormatMap` map object. Follow the pattern set by the existing map entries.

4. Edit the file `<js-src>/jasperserver-war/src/main/webapp/WEB-INF/flows/reportJobBeans.xml` to add the new output format in the `allOutputFormats` list:

   ```xml
   <bean class="com.jaspersoft.jasperserver.war.dto.ByteEnum">
   <property name="code">
   <value type="java.lang.Byte">{number}</value>
   </property>
   <property name="labelMessage">
   <value>report.output.<MyFormat>.label</value>
   </property>
   </bean>
   ```

   The `{number}` and `<MyFormat>` values are the same as you used previously in step 2.

5. If you didn’t add the label in step 7 in section 11.10.2, “Adding the Exporter to the Report Viewer,” on page 175, add it now. In the `jasperserver_messages.properties` file (found in WEB-INF/bundles), add the new `report.output.<MyFormat>.label` key introduced in the `reportJobBeans.xml`. For example:

   ```
   report.output.<MyFormat>.label=<MyFormat>
   ```

   If your server instance supports multiple languages, be sure to add the correct entries in the properties file for each supported language.

6. The new scheduler output format is now configured. Compile the source code and redeploy the web application, as described in section 11.8, “Working With Source Code Files,” on page 167.

   Your new export channel is added to the scheduler’s Output page, and when selected a scheduled report generates the output in your new format.
CHAPTER 12 DESIGNING A CLUSTER

To provide scalability and high availability of your business intelligence infrastructure, you can deploy a cluster of JasperReports Server instances behind a load balancer. You can implement a cluster with either JasperReports Server Community Project or commercial editions, as long as all instances are the same edition, the same version, and all are configured identically.

JasperReports Server supports cluster deployments by using thread-safe access to its private repository database. As a result, any number of JasperReports Server instances can share the same repository and thus present the same environment to users. Of course, your repository database must be properly sized to handle the number of server instances, and it must have its own mechanism for providing scalability and high availability.

With a properly designed cluster, you can support many more users and organizations, avoid unintended downtime, and plan for future growth. The load balancer makes sure that user load is spread evenly, and when needed, you can add new instances of JasperReports Server to the cluster.

One important detail of any cluster is how sessions are managed in case of a failure. JasperReports Server supports only “sticky” sessions, also called “pinned” sessions, that cannot be transferred between nodes. User sessions in progress on the node that fails are lost, but all work saved in the repository can be immediately resumed on any other node.

This chapter introduces a sample architecture for JasperReports Server cluster environments and explains its components. It also discusses design considerations and deployment constraints, such as session management. This document is not intended as a tutorial, nor as a detailed deployment plan, but should only be used as a high level overview.

This chapter contains the following sections:

- Sample Cluster Architecture
- Jaspersoft OLAP in a Cluster
- Session Management and Failover
- Cluster Design Process
- Performance Requirements
- Availability Requirements
- Scalability Requirements
- Sizing a Cluster

12.1 Sample Cluster Architecture

A cluster refers to a group of servers, along with any associated computers, dedicated hardware, and other server software that perform the same task as a single server. Each server instance runs on its own node, a real or virtual computer with the
necessary software. When properly configured, the cluster architecture is transparent to users. All users access the same URL and see the same data, but each session is handled by a different node.

A cluster typically provides load balancing among nodes and some form of failover, both of which lead to higher availability and scalability. A cluster design must also take into account all of the resources that the JasperReports Server instances must access and scale them appropriately.

In general, a cluster may incorporate computers of different hardware and software configurations. For simplicity, Jaspersoft recommends deploying JasperReports Server as a cluster of identical nodes, with one instance on each node and each instance configured the same.

The following diagram shows the architecture of a sample JasperReports Server cluster:

![Architecture of a Sample JasperReports Server Cluster](image)

The major components of the sample JasperReports Server cluster architecture are:

- JasperReports Server clients:
  - Browser users – Administrators and end users who log into the JasperReports Server web interface.
  - Web services clients – Applications that access JasperReports Server through the web services API.
  - Load balancer – Specialized hardware or software that redirects client requests to instances in the cluster.
  - JasperReports Server instances – Identically configured instances running on separate computers, real or virtual.

- Shared resources:
  - Repository database – Defines users, roles, organization, folders, and resources for the cluster. The repository is a single logical database that should also be configured for high availability and failover.
  - Data sources – Contain the data that JasperReports Server queries when creating or running a report. Data sources should be able to handle the load of simultaneous queries expected from the cluster.
  - Email services – Send email notifications and output of scheduled reports. Email services are optional, but almost always implemented.
  - External authentication – Provides alternative login policies such as corporate directories or single sign-on. External authentication is optional and more complicated to configure, but it is often desired in an enterprise deployment.

The requirements and considerations for each of these components are given in the following sections. For simplicity, the sample architecture assumes that all components of the cluster are in the same geographic location. Distributed clusters to serve distributed users are possible, but require extra network and performance considerations that are beyond the scope of this chapter.
12.1.1 JasperReports Server Clients

JasperReports Server supports two types of clients that are fundamentally different:

- **Browser users** – Through the web interface, users interact with all the features of JasperReports Server, such as viewing and scheduling reports. Working with Ad Hoc reports and Dashboards, in product editions that provide these features, is an interactive process for the user, with multiple requests to access data, display it, and modify its appearance. Users with the proper permissions can upload JasperReports and use the wizards to define the required resources.

- **Web services clients** – Web services are a web-based API that applications call to access the features of JasperReports Server. For example, the JasperReports Server plug-in for iReport relies on web services to access the repository for reading and writing reports and their associated resources.

A web services client provides credentials in every request, and the server performs an action or provides information in a reply to the client. Web services calls are stateless operations, meaning that the server does not store any information about the operation after it is completed. Complex structures such as a report resource are fully defined in the client before being sent in the web services call, as opposed to the interactive nature of the browser user. For more information, see the *JasperReports Server Web Services Guide*.

User sessions in a cluster are further explained in section 12.3, “Session Management and Failover,” on page 182.

A significant task in the design of your cluster is to characterize client usage, such as total number of potential clients, fraction of browser users and web services clients, peak client load, average request size, and typical client bandwidth. This information will help you optimize the size and number of servers in your cluster to meet your service availability goals. For more information, see section 12.8, “Sizing a Cluster,” on page 185.

12.1.2 Load Balancer

A load balancer is a hardware device or software application that uses any number of techniques to spread traffic between the nodes of the cluster, usually so that all servers have an equal load. The load balancer provides a single address that all clients can access, and it behaves like an internet router, maintaining each client’s connection with the chosen server in the cluster.

The load balancer is the gateway to the cluster because it directs client traffic and thus optimizes the performance of your servers. At a minimum, the load balancer can determine that a server is not operating and direct traffic to the remaining functioning servers. Some load balancers offer capabilities such as analyzing client requests and server load to optimize server response times for clients. The JasperReports Server itself does not communicate with load balancers, but some load balancers may communicate with the application server to determine availability and load.

Because of the requirement for sticky sessions in a JasperReports Server cluster, the load balancer must be configured so that browser users are always connected to the same server during a continuous session. Beyond that requirement, JasperReports Server can work with any HTTP load balancer, both hardware or software-based. The load balancer module in the Apache HTTP server is a common software solution.

If you have high concurrent user loads and rigorous availability requirements, you may need a load balancer with more advanced features for balancing client traffic. Also, the load balancer capabilities and configuration sometimes limit the maximum number of servers in your cluster, an important consideration for scalability. Thus, your cluster requirements ultimately determine your choice of load balancer.

12.1.3 JasperReports Server Instances

The JasperReports Server instances deployed in a cluster are normal servers with no special configuration for the cluster. As with all server instances, they run in a Java servlet container that is usually implemented as an application server. While the load balancer may interact with the application server, JasperReports Server is not aware of the cluster environment in which it is deployed.

For performance and stability reasons, server instances are usually deployed on dedicated computers. The hardware can be a physical computer or a cloud-based virtual computer, as long as the operating system is supported by JasperReports Server. Jaspersoft recommends that the only other software installed be the required Java Virtual Machine (JVM) and the application server. This design allows you to allocate as much memory as possible to the JVM and to JasperReports Server.

This document considers only the case of deploying a single JasperReports Server as the only application in a single application server on each computer. Therefore, in this document, a node refers to the real or virtual computer hosting a JVM, an application server, and a single instance of JasperReports Server.
Jaspersoft recommends that you use a lightweight application server such as Apache Tomcat or Glassfish. For example, Tomcat is a well-tested application server with JasperReports Server. A typical configuration for handling most reporting uses 64-bit Java with 2 gigabytes of memory allocated to the Java heap. See the JasperReports Server Installation Guide for guidelines and instructions to install JasperReports Server in your choice of application server and to configure your JVM.

Some application servers can be configured to communicate within a cluster, for example to deploy applications across all instances automatically. This advanced configuration is beyond the scope of this document, and can be undesirable in some cases. For example Apache Tomcat can perform session replication when instances are configured to communicate with each other in the cluster. But JasperReports Server does not support session replication, as explained in section 12.3, “Session Management and Failover,” on page 182.

In this document, each application server in the cluster is running independently and unaware of the other instances.

Finally, every instance must have an identical configuration, at least for certain key settings. While it is possible for each instance to be configured differently, this is not recommended. For example, when instances are deployed on differing hardware with different configurations, the load balancer’s algorithm may not be effective. This is why we recommend that every server in the cluster be deployed on the same hardware and software, and have exactly the same configuration.

To deploy identical JasperReports Server instances, install a single instance from the WAR file distribution and configure it completely. Then copy the deployed WAR file to each of the other computers in the cluster. When using JNDI data sources provided by the application server, you must make sure they are pre-configured and identical on every application server. Often, the entire application server with JasperReports Server deployed within it can be copied as well. This is sometimes called “cloning” the server. Upgrades can be handled in the same way. Having identical JasperReports Server instances in your cluster greatly simplifies its installation and maintenance.

Another way to deploy identical instances to each node is to implement the configured WAR file on a shared file system and to access it from each application server with a symbolic link. You must make sure that working directories such as javaiotemp are not shared, and the shared file system should have its own redundancy and failover plan. Shared WAR files are an advanced configuration, and further details are beyond the scope of this document.

12.1.4 Shared Repository Database

The keystone of the JasperReports Server cluster is the shared repository database. All JasperReports Server instances must be configured to access the same repository, thus ensuring that they display the same folders, the same reports, and the same resources. Because the repository also stores users, roles, organizations, and security definitions, every server in the cluster behaves identically regardless of which instance actually processes the client connection.

For example, when a user logs in, the user account, organization, and roles are retrieved from the shared repository. When the user browses folders, all resources are the same as seen from any instance in the cluster, and all access permissions apply. If the user runs a report based on a Domain Topic, the report, the Domain Topic, the Domain, and any security files are all retrieved from the repository.

All repository operations are thread-safe, meaning that all JasperReports Server instances can perform operations simultaneously, while internal locks in the software prevent operations that would conflict. If a user edits and saves a report, another user running the report sees either the old report or the new one based on exactly when the request was made. As with many large systems serving numerous clients, users must coordinate their work to avoid overwriting each others’ changes. For the same reason, administrators should make changes to shared resources during off-hours to prevent conflicts with active user sessions.

Because the repository database is such a critical element of the JasperReports Server cluster, you should implement it on an equally scalable and available system, based on the predicted peak and average loads of your JasperReports Servers. For example, the repository could be a cluster itself, with its own load balancer, or any other architecture that is compatible with a database product supported by JasperReports Server. In addition, the repository database must implement data protection measures you require, such as on-site and off-site backups.

Regardless of the architecture of the repository database, it is critical that it act as a single logical repository which is identified with a single IP address that all JasperReports Server instances can access.
12.1.5 Job Schedulers

The JasperReports Server scheduler is a module that exists in every server instance to run reports scheduled to run at a later time, either once or repeatedly. Schedules, also known as jobs, are stored in the repository to be triggered by the scheduler whenever necessary. For simplicity, schedulers are not shown in Figure 12-1 on page 178.

To prevent every instance from triggering the same job at the same time, the scheduler uses a software locking mechanism when accessing jobs in the repository. This allows the scheduler to be deployed on every instance in a cluster environment but ensure that any job is triggered only once. Jobs can be created by client sessions on any instance, then be run by the scheduler on any instance, and the client sees no difference. Job output will then be emailed as necessary, and if saved in the repository, accessible from any instance.

The scheduler is based on the Quartz scheduler, an open source library. The JasperReports Server includes settings for the scheduler in the file <WAR-file>/WEB-INF/js.quartz.properties. The default configuration of the scheduler includes the following settings that allow it to work in both stand-alone servers and clusters:

- `org.quartz.scheduler.instanceId = AUTO`
- `org.quartz.jobStore.isClustered = true`

Be sure to synchronize the clocks on every node, so that the scheduler doesn’t always run jobs on the node with the earliest time. For further details, see the online documentation for the Quartz scheduler.

There are advantages to running jobs on all the server instances. If several long jobs are scheduled at the same time, a single server must process them sequentially, and some won’t start at exactly the designated time. Multiple servers in a cluster can process those jobs in parallel, and they will start on time, at least for a number of jobs up to the number of instances.

12.1.6 Other Shared Resources

As with the repository database, the server instances in the cluster usually share any other resource that they need to access, including:

- **Data sources** – These are defined in the shared repository, therefore all servers in the cluster access the same data sources. Queries, reports, and Domains are all stored in the repository as well, so that a report has access to exactly the same data, regardless of which instance the user session or job is running on.

  Data sources can be defined as either JDBC connections directly to a database or JDBC connections from the application server to the database that are exposed through JNDI. Jaspersoft recommends using JNDI data sources because the application server often has better connection pooling and management than JasperReports Server.

  However, JNDI data sources require two definitions, one in the repository and one in the application server. You must make sure that the JNDI definitions are identical on every application server in the cluster. Otherwise, the JNDI data source defined in the shared repository won’t work for every instance of JasperReports Server. For more information, see section 12.1.3, “JasperReports Server Instances,” on page 179.

- **Email services** – These are defined in each server instance’s configuration files for sending the output of finished jobs. When servers are configured identically, every instance uses the same email services.

- **External authentication** – An optional server configuration that allows JasperReports Server to access an external user database to verify login credentials. As described in the JasperReports Server External Authentication Cookbook, external authentication requires extensive configuration and sometimes customization. When implementing external authentication in a cluster, all instances must be configured identically to avoid security holes.

Resources that are defined in the repository are shared by all nodes and should be able to handle connections from multiple servers. For resources that are configured in server files, each instance could define a dedicated resource in its own configuration file. For example, each server instance could have its own email server to handle the notifications it sends. However, the dedicated resource then becomes a point of failure that disables the corresponding server instance if the resource fails. In either case, shared resources are often clusters themselves, to provide the same reliability and scalability as the JasperReports Server cluster.

Having a single address and set of credentials for resources, either of a single server or a load-balanced cluster, also means that all JasperReports Server instances have identical configurations and are thus easier to deploy and maintain.
12.2 Jaspersoft OLAP in a Cluster

Jaspersoft OLAP (On Line Analytical Processing) is a module of JasperReports Server that uses different data schemas, queries, and views to perform interactive data analysis such as slicing, drill-down, and drill-through. As with JRXML and JasperReports, all of the analysis schemas, MDX queries, and analysis views are stored in the repository and accessible from any node of the cluster. Therefore, the basic configuration of Jaspersoft OLAP will run without modification in a cluster.

However, Jaspersoft OLAP is composed of two parts: an XML/A client that displays data and an XML/A provider or server that retrieves and processes the data. As described in the Jaspersoft OLAP User Guide, these two parts can run on separate instances of JasperReports server. In a cluster, how you define the XML/A connection will result in different behavior:

- In the default case, the definition of the XML/A provider is points to the localhost, so the same node that receives the user request will perform both the analysis and display it.
- You can change the definition of the provider so that it points to the URL of the load balancer for the cluster. In this case, the node that receives the user request will ask another node to retrieve the data for it, and the results will be sent back to the first node for display.

Because of the extra communication and connections, whether this configuration increases performance depends on your overall cluster load. If you have lots of analysis users at the same time, the load will be uniformly high, and there will be no benefit to calling the XML/A provider on a node that is equally busy. In fact, the extra overhead may impact performance, in particular if the connection loops back to the same node.

On the other hand, if your nodes are occasionally idle or if your load balancer detects real-time load on each node, this configuration will spread the analysis load and optimize performance for all users.

- You can set the connection to the URL of a particular XML/A provider. This could be a dedicated instance of JasperReports Server running Jaspersoft OLAP that is not connected to the cluster. You would need to size this instance to handle your expected analysis load and possibly implement two nodes as a cluster for availability. The advantage of having a dedicated XML/A provider instance is that it would centralize the cache for XML/A connections, thereby increasing cache hits.

Factors such as the size of your data and the ratio of JasperReports load to OLAP load can help you determine how to configure your XML/A connections in a cluster. If you don’t perform much analysis, use the default configuration with localhost for your connections. If you have many analysis requests to the same data, a dedicated instance of Jaspersoft OLAP could provide a central cache and increase performance. Remember that connection behavior is determined by the XML/A connection defined in the repository, not by the nodes.

For simplicity, Jaspersoft recommends that every XML/A connection be configured the same way, so that XML/A connections are uniform across the cluster. However, if you have advanced analysis needs, you might benefit from having different behaviors for different XML/A connections. How to determine and configure optimal Jaspersoft OLAP performance in a cluster is beyond the scope of this document.

12.3 Session Management and Failover

Failover is the ability of the cluster to minimize the impact of a failure and continue serving clients with the remaining servers. A failure is assumed to be any unplanned incident that causes a server instance, either the software or hardware, to become and remain unavailable. In order to implement failover, you need to understand how JasperReports Server manages client sessions. This allows you to configure the cluster for optimal performance and set user expectations.

A client session is an in-memory object that represents the user to the server at run-time. After a user logs in or a web services client sends a request with credentials, the session contains the user profile such as organization and role membership for use in enforcing permissions. For browser users, the session also stores information about the state of the web interface, for example the last folder viewed in the repository, the last search term, or the data entered in a wizard. In commercial editions with the Ad Hoc Editor and Dashboard Designer, the user session also stores the on-screen state of the report or dashboard that the browser user creates interactively.

There are two types of session management in cluster design, each of which determines a different failover scenario:

- Replicated or persistent sessions – The instantaneous state of every client session is continually stored on every node or in a shared location. Upon failure, the load balancer automatically redirects client connections to a remaining node. Because
every node has access to a copy of the client session, the user can continue work from the previous state, often without even being aware of the failure or the change.

JasperReports Server does not support replicated or persistent sessions.

Unlike small, fast e-commerce sessions, JasperReports Server has larger and more complex sessions that would degrade performance when replicating or persisting. The reason for this is that the JasperPrint object for an exported report is stored in the user session. The JasperPrint object can be large (many megabytes) and would take a long time to serialize and store persistently, thereby slowing down every user action.

- Sticky or pinned sessions – Client sessions are created and managed privately by each server instance and cannot be transferred to another node. When a failure shuts down an instance, all of its client sessions are lost. When users reconnect, the load balancer directs them to a remaining node that creates its own, new session for them. As mentioned throughout this chapter, JasperReports Server implements only sticky sessions.

In the case of sticky sessions, the chance of a user experiencing a failure is the same as if working on a non-clustered server. However, the impact on users is mitigated by the fact that they can log in again on a remaining node of the cluster. Even though the risk of failure occurring is low, cluster designers should understand the impact on users.

### 12.3.1 Impact on Browser Users

A server failure would mainly affect long sessions where the user has unsaved work, such as in the Ad Hoc Editor and Dashboard Designer. The consequence of a failure is that users may need to re-create a report, but no critical functionality or data would be lost. If the user was only browsing the repository at the time of failure, there is no work in progress to be lost and the only consequence is the need to log in again. If the user was viewing a report, he will need to run it again after logging in. The advantage of having a cluster is that users can resume work immediately on the remaining instances.

The standard precaution against lost work is for users to save their work at regular intervals or significant milestones. Both the Ad Hoc Editor and the Dashboard Designer let users save their current view as a report or dashboard that can be opened to the same state. Work that is explicitly saved by the user is stored in the shared repository and available upon login to a new node. This includes any resources that are created, moved, or saved, as well as any Save or Save As operation that completes before a failure.

### 12.3.2 Impact on Web Services Clients

Web services calls can also be impacted by failure, but because they are much quicker operations that involve a request and immediate response, this is much less likely. In addition, there is no other information stored in the client session because web services calls are stateless. In the web services model, the calling application has the responsibility to remember the state of the interaction between it and the server.

Still, applications that call JasperReports Server web services should implement a reasonable timeout and verify the return value to determine if the server instance has a failure. In the case of a timeout or an error, the application should call the same operation again, which the load balancer should automatically route to a remaining server instance.

### 12.4 Cluster Design Process

The rest of this chapter looks how you would design a JasperReports Server cluster to fit your needs. It assumes that your cluster will follow the traditional pattern with a load balancer and some number of identical nodes, as shown in the sample architecture. Other architectures, such as dedicated OLAP nodes or a geographically distributed cluster, are possible but beyond the scope of this chapter.

As with any software project, careful design and planning will help you meet your goals. A simplified process for designing a cluster might include the following steps:

1. Gather cluster requirements in the following areas:
   - Performance – Usually defined as average response time for a given load.
   - High availability – Usually measured as percentage up-time.
   - Scalability – The ease of adding nodes to improve performance and availability over time.
2. Estimate the size of your cluster to meet your requirements within your limitations such as time and budget. Sizing determines the architecture of your cluster:
   - Load-balancing hardware.
   - Size and number of cluster nodes.
   - Shared resources, especially databases.
   - JasperReports Server configuration.

3. Deploy your cluster:
   - Hardware purchases and installation.
   - Network configuration.
   - Software configuration, including JasperReports Server configuration.
   - Testing of all components individually and in the cluster architecture
   - Rollout to end-users.
   - Administration, maintenance, and scaling procedures.

Deployment and implementation are beyond the scope of this chapter. The following sections give more details about gathering cluster requirements and sizing.

12.5 Performance Requirements

There are two sides to performance: performance requirements and load estimates. The goal is to anticipate the number of users and their activities, so that you can design a cluster that responds their needs with minimal delay.

Performance requirements ensure that the cluster is responsive to user requests. Such requirements are usually defined in terms of the system response relative to an amount of traffic in a given period, like “5 second response for all pages regardless of system load” or “maximum 10 second response time for up to 20 simultaneous users”. There are often different requirements for expected average load versus maximum load.

The requirements should be based on realistic estimates of the number of users and how they will interact with the features of JasperReports Server. First, you should determine what volume of users will be browser clients (real people) and web services clients (applications making API calls) and the ratio between them. See section 12.3, “Session Management and Failover,” on page 182 for information about these two types of clients and how their client sessions differ.

Then, you must estimate what kinds of operations your users perform, for example:
- How many users will just run reports and save the output?
- How many users will create reports or explore data interactively?
- How large are your typical reports, in terms of data retrieved and processing required, and how often do they run?
- What times of day will have the highest user load?
- Will users or web services clients access the repository extensively?

In addition to user sessions, the server instances must also process scheduled jobs, so you should estimate their volume and nature. For example, what volume of jobs are critical to run at exact times, what volume of jobs must run during business hours when user load will be high? Can you educate users to run jobs outside of business hours?

Long jobs contribute to server load and may slow down user sessions. If the scheduled job load is very high at the same time as the user load, it may be desirable to configure a dedicated server instance to run jobs. This advanced cluster architecture is beyond the scope of this document. For more information about running scheduled jobs, see section 12.1.5, “Job Schedulers,” on page 181.

Client connectivity is also an issue, because the slowest link in the network creates a bottleneck. There is a difference in system performance and scalability between users who work remotely over DSL and those who work in the office on your corporate T1 network.
12.6 Availability Requirements

High availability is the ability of the cluster to effectively avoid downtime. In general, failover prevents total system unresponsiveness that would happen if a single server failed, but a properly designed cluster must also address the failure of other cluster components.

High availability is usually defined in terms of uptime, like 99.999%, 24/7/365 (always), or business hours during business days. To design for high availability, all system components must be made redundant or recoverable enough so that no single component can fail and bring the entire environment to a stop in a way that violates the high availability requirements.

Identifying the failure modes of a cluster is good practice for any deployment. For every component in the cluster, analyze what happens to users and overall availability when that component fails. Section 12.3, “Session Management and Failover,” on page 182 explains what happens to users on a server instance that fails, but you should also consider the overall performance degradation of the cluster and the impact of failures in other cluster components.

A further aspect of high availability is sizing the cluster so that should one server (hardware or software) become unavailable, the rest can still respond to anticipated user demand. If you have strict availability and performance requirements, you may need to plan for additional nodes. As you design your JasperReports Server cluster, you should take all these issues into account in order to properly express your availability requirements.

Another aspect of high availability is the ability of certain clusters to keep operating during planned maintenance and upgrades, called rolling upgrades. JasperReports Server does not support rolling upgrades, because different versions can require different schemas in the shared repository. So your availability planning must include the time to stop the entire cluster and perform upgrades as necessary.

12.7 Scalability Requirements

Scalability refers to the ability of the environment to meet the needs of an increasing number of users and external services in a way that is predictable in terms of performance.

The main scalability consideration is whether the cluster architecture is dynamic and additional servers can be added to increase the number of users (simultaneous or not). Additionally, you should consider whether other components of the cluster can be added to the design later. It may be simple to expand the size of the shared repository because database servers are usually made to scale, but it may be more complex to change load balancers or implement redundant load balancers.

There is often a relationship between scalability and high availability. If the system works under normal circumstances but stops functioning under load, this may violate your availability requirements. You should also consider whether availability requirements will change along with increased user load. For example, as the cluster-based BI solution is rolled out to more and more users, high-availability of the cluster becomes more critical. In this case, you may need to add redundant load-balancers or other component upgrades to increase availability in the future. Your initial cluster design should recognize this need allow for this expansion.

Once you have defined your scalability requirements in detail, use this information when sizing your cluster.

12.8 Sizing a Cluster

Sizing a cluster is the process of determining the number and architecture of components to meet your performance, availability, and scalability requirements. During this phase, you also need to perform load tests to determine the best configuration for your needs.

For a traditional cluster, your design should specify the following:

- Load-balancing hardware, software, and policies.
- Size and number of cluster nodes, with characteristics such as processors and memory.
- JasperReports Server configuration optimizing for the user load and cluster environment.
- Shared resources, especially databases for the repository and data sources.
- Network service levels or upgrades.
• Policies and procedures for scaling and maintaining performance.

The following sections look at the trade-offs of various designs for each component.

12.8.1 Load Balancer

Determine whether you need a dedicated hardware load-balancer or whether a basic software load-balancer will meet your requirements. You should also specify the load-balancing techniques you will use, such round-robin, load-based, or some other configuration. If the load balancer communicates with the nodes to optimize traffic, specify how this happens.

Much of the load balancer requirement is based on the size and complexity of your cluster. A small cluster of two to three nodes can use a software load-balancer with a simple algorithm. But if you have many nodes or a few powerful nodes with high traffic, you need a dedicated load-balancer for the cluster.

If you have very strict performance requirements and need to closely monitor the load across the cluster, you may need a load-based balancer that communicates with the nodes. The trade-offs for these advanced load-balancing techniques are more maintenance and a more complex configuration on each node.

And finally, if the cluster is intended to scale over time, the load balancer must be able to handle more incoming traffic and more cluster nodes.

12.8.2 Cluster Nodes

The size and number of nodes is the determinant of your cluster design. Based on your expected load, you need to specify enough processing power to meet your performance and availability requirements. This includes hardware specifications such as processors and memory, or their equivalent for virtual servers.

One of the design decisions you must make for hardware is whether to have few instances on powerful hardware or many instances on cheaper hardware. If high availability is a key requirement, having more instances decreases the risk and impact of any one failure. Other issues such as maintenance and cost must also be factored into this decision.

Hardware availability can be another issue. Does your budget include the new servers, either real or virtual, to handle the loads you expect? Or can you reuse existing hardware. Remember that having mis-matched hardware is possible in the cluster, but it complicates the server configuration and may lead to sub-optimal load-balancing.

Because the node architecture is the key to cluster, running tests with various options can help you choose the right hardware. By performing load tests, you can determine how many users can run on a single node and scale the number of nodes accordingly. You can also run tests with various numbers of processors and memory to determine what configuration is optimal for your expected user load. If you plan on using virtual servers, performing load tests can help uncover any issues with connectivity and stability.

12.8.3 Software Configuration

Once you have the server hardware to handle your user load, you need to determine the optimal software configuration for your nodes. This includes:

• JVM settings to optimize processor and memory usage.
• Application server settings, mostly to provide connection pooling.
• JasperReports Server settings.

Server settings can help optimize performance based on the types and number of reports that you expect users to run:

• Data policies in Ad Hoc can help speed up Domain-based reports
• Cache settings in Ad Hoc can boost performance when there are many users accessing the same data.
• Query limits (for Ad Hoc reports and for JasperReports) can help prevent slow responses when users request huge data sets during peak usage times.
• Custom virtualization settings can help servers deal with large reports (greater than 300 pages).

For JVM setting to optimize performance, see the JasperReports Server Installation Guide. For details about query limits, data policies, and cache settings, see the chapter on configuration in the JasperReports Server Administrator Guide.

Also turning off features such as auditing and logging can improve performance in highly-loaded machines.
12.8.4 Databases

JasperReports Server relies heavily on database access, and cluster deployments add extra load to these shared resources:

- The shared repository is a critical part of the cluster with very high loads compared to a traditional single-server deployment. With multiple simultaneous connections from multiple nodes, you must ensure that the repository database doesn’t become a bottleneck. Therefore, the architecture, size, and speed of the database that hosts the shared repository must be carefully evaluated and specified in the cluster design.

- A JasperReports Server cluster enables and encourages a large population of users to process more and more data—this is a good thing. But the cluster may stress your reporting databases to their limits if they aren’t considered and given adequate hardware and software. This is another case where knowing what data your users access the most can help you optimize database configuration such as indexing.

- If you implement external authentication or single sign-on, make sure those resources can handle the load that the cluster is expected to generate.

12.8.5 Network

Finally, your cluster architecture may need to take into consideration the availability and quality of your network. How remote are your users and what kind of connection do they have to the cluster?

There are two main concerns about your network:

- Network availability and capacity affects the availability and scalability of the cluster to the users. If you have strict availability requirements, you may need redundant network connections from different providers. For scalability, your network needs to handle the load of the planned maximum number of users, or have plans to scale the network along with the number of users. Be aware that this creates external dependencies on meeting your performance requirements.

- Network bandwidth can affect server load by slowing down individual connections. JasperReports Server can generate multiple large documents simultaneously that are sent to the web browser or web services clients. Network capacity (megabytes per second) is critical to being able to deliver these generated documents in a reasonable time frame. The slower the network, the more load on the servers generating the report documents, as they will take longer to deliver the same content, and potentially lead to more simultaneous report requests.

12.8.6 Policies and Procedures

Given the complexity of a cluster design, it’s a good idea to document your design process and your final architecture. Ongoing maintenance is simpler if you have a record of decisions and document procedures for configuration.

And finally, to meet scalability requirements, you may need monitor your cluster performance and define some metric for adding nodes. For example, you might specify one node per 100 concurrent users, or add a node when peak load reaches 90% on every node.

Sizing a cluster is usually the last phase of cluster design, before you start implementing your chosen components, creating a cluster prototype, and going into production. When all components are sized appropriately for the many requirements and usage conditions, testing and rollout of your cluster will proceed more smoothly.

In conclusion, a cluster of JasperReports Server instances can help you meet the high availability and scalability requirements of your BI solution. This chapter is only meant as a guideline to help you in your design and planning phases. If you want technical assistance, Jaspersoft Professional Services can help in all phases of designing and rolling out a successful cluster.
**GLOSSARY**

**Ad Hoc Editor**
The interactive data explorer in JasperReports Server Professional and Enterprise editions. Starting from a predefined collection of fields, the Ad Hoc Editor lets you drag and drop fields, dimensions, and measures to explore data and create tables, charts, and crosstabs. These Ad Hoc views can be saved as reports.

**Ad Hoc Report**
In previous versions of JasperReports Server, a report created through the Ad Hoc Editor. Such reports could be added to dashboards and be scheduled, but when edited in iReport, lost their grouping and sorting. In the current version, the Ad Hoc Editor is used to explore views which in turn can be saved as reports. Such reports can be edited in iReport and Jaspersoft Studio without loss, and can be scheduled and added to dashboards.

**Ad Hoc View**
A view of data that is based on a Domain, Topic, or OLAP client connection. An Ad Hoc view can be a table, chart, or crosstab and is the entry point to analysis operations such as slice and dice, drill down, and drill through. Compare OLAP View. You can save an Ad Hoc view as a report in order to edit it in the interactive viewer, schedule it, or add it to a dashboard.

**Analysis View**
See OLAP View.

**Audit Archiving**
To prevent audit logs from growing too large to be easily accessed, the installer configures JasperReports Server to move current audit logs to an archive after a certain number of days, and to delete logs in the archive after a certain age. The archive is another table in the JasperReports Server’s repository database.

**Audit Domains**
A Domain that accesses audit data in the repository and lets administrators create Ad Hoc reports of server activity. There is one Domain for current audit logs and one for archived logs.

**Audit Logging**
When auditing is enabled, audit logging is the active recording of who used JasperReports Server to do what when. The system installer can configure what activities to log, the amount of detail gathered, and when to archive the data. Audit logs are stored in the same private database that JasperReports Server uses to store the repository, but the data is only accessible through the audit Domains.

**Auditing**
A feature of JasperReports Server Enterprise edition that records all server activity and allows administrators to view the data.
Calculated Field

In a Domain, a field whose value is calculated from a user-written formula that may include any number of fields, operators, and constants. A calculated field is defined in the Domain Designer, and it becomes one of the items to which the Domain’s security file and locale bundles can apply.

CRM

Customer Relationship Management. The practice of managing every facet of a company’s interactions with its clientele. CRM applications help businesses track and support their customers.

CrossJoin

An MDX function that combines two or more dimensions into a single axis (column or row).

Cube

The basis of most OLAP applications, a cube is a data structure that contains three or more dimensions that categorize the cube’s quantitative data. When you navigate the data displayed in an OLAP view, you are exploring a cube.

Custom Field

In the Ad Hoc Editor, a field that is created through menu items as a simple function of one or two available fields, including other custom fields. When a custom field becomes too complex or needs to be used in many reports, it is best to define it as a calculated field in a Domain.

Dashboard

A collection of reports, input controls, graphics, labels, and web content displayed in a single, integrated view. Dashboards often present a high level view of your data, but input controls can parameterize the data to display. For example, you can narrow down the data to a specific date range. Embedded web content, such as other web-based applications or maps, make dashboards more interactive and functional.

Derived Table

In a Domain, a derived table is defined by an additional query whose result becomes another set of items available in the Domain. For example, with a JDBC data source, you can write an SQL query that includes complex functions for selecting data. You can use the items in a derived table for other operations on the Domain, such as joining tables, defining a calculated field, or filtering. The items in a derived table can also be referenced in the Domain’s security file and locale bundles.

Data Policy

In JasperReports Server, a setting that determines how the server processes and caches data used by Ad Hoc reports. Select your data policies by clicking Manage > Ad Hoc Settings.

Data Source

Defines the connection properties that JasperReports Server needs to access data. The server transmits queries to data sources and obtains datasets in return for use in filling reports and previewing Ad Hoc reports. JasperReports Server supports JDBC, JNDI, and Bean data sources; custom data sources can be defined as well.

Dataset

A collection of data arranged in columns and rows. Datasets are equivalent to relational results sets and the JRDataSource type in the JasperReports Library.

Datatype

In JasperReports Server, a datatype is used to characterize a value entered through an input control. A datatype must be of type text, number, date, or date-time. It can include constraints on the value of the input, for example maximum and minimum values. As such, a datatype in JasperReports Server is more structured than a datatype in most programming languages.

Denormalize

A process for creating table joins that speeds up data retrieval at the cost of having duplicate row values between some columns.
**Dice**
An OLAP operation to select columns.

**Dimension**
A categorization of the data in a cube. For example, a cube that stores data about sales figures might include dimensions such as time, product, region, and customer’s industry.

**Domain**
A virtual view of a data source that presents the data in business terms, allows for localization, and provides data-level security. A Domain is not a view of the database in relational terms, but it implements the same functionality within JasperReports Server. The design of a Domain specifies tables in the database, join clauses, calculated fields, display names, and default properties, all of which define items and sets of items for creating Ad Hoc reports.

**Domain Topic**
A Topic that is created from a Domain by the Data Chooser. A Domain Topic is based on the data source and items in a Domain, but it allows further filtering, user input, and selection of items. Unlike a JRXML-based Topic, a Domain Topic can be edited in JasperReports Server by users with the appropriate permissions.

**Drill**
To click on an element of an OLAP view to change the data that is displayed:
- Drill down. An OLAP operation that exposes more detailed information down the hierarchy levels by delving deeper into the hierarchy and updating the contents of the navigation table.
- Drill through. An OLAP operation that displays detailed transactional data for a given aggregate measure. Click a fact to open a new table beneath the main navigation table; the new table displays the low-level data that constitutes the data that was clicked.
- Drill up. An OLAP operation for returning the parent hierarchy level to view to summary information.

**Eclipse**
An open source Integrated Development Environment (IDE) for Java and other programming languages, such as C/C++.

**ETL**
Extract, Transform, Load. A process that retrieves data from transactional systems, and filters and aggregates the data to create a multidimensional database. Generally, ETL prepares the database that your reports will access. The Jaspersoft ETL product lets you define and schedule ETL processes.

**Fact**
The specific value or aggregate value of a measure for a particular member of a dimension. Facts are typically numeric.

**Field**
A field is equivalent to a column in the relational database model. Fields originate in the structure of the data source, but you may define calculated fields in a Domain or custom fields in the Ad Hoc Editor. Any type of field, along with its display name and default formatting properties, is called an item and may be used in the Ad Hoc Editor.

**Frame**
A dashboard element that displays reports or custom URLs. Frames can be mapped to input controls if their content can accept parameters.

**Group**
In a report, a group is a set of data rows that have an identical value in a designated field.
- In a table, the value appears in a header and footer around the rows of the group, while the other fields appear as columns.
- In a chart, the field chosen to define the group becomes the independent variable on the X axis, while the other fields of each group are used to compute the dependent value on the Y axis.

**Hierarchy Level**
In an OLAP cube, a member of a dimension containing a group of members.
Input Control
A button, check box, drop-down list, text field, or calendar icon that allows users to enter a value when running a report or viewing a dashboard that accepts input parameters. For JRXML reports, input controls and their associated datatypes must be defined as repository objects and explicitly associated with the report. For Domain-based reports that prompt for filter values, the input controls are defined internally. When either type of report is used in a dashboard, its input controls are available to be added as special content.

iReport Designer
An open source tool for graphically designing reports that leverage all features of the JasperReports Library. The Jaspersoft iReport Designer lets you drag and drop fields, charts, and sub-reports onto a canvas, and also define parameters or expressions for each object to create pixel-perfect reports. You can generate the JRXML of the report directly in iReport, or upload it to JasperReports Server. iReport is implemented in NetBeans.

Item
When designing a Domain or creating a Topic based on a Domain, an item is the representation of a database field or a calculated field along with its display name and formatting properties defined in the Domain. Items can be grouped in sets and are available for use in the creation of Ad Hoc reports.

JasperReport
A combination of a report template and data that produces a complex document for viewing, printing, or archiving information. In the server, a JasperReport references other resources in the repository:

- The report template (in the form of a JRXML file)
- Information about the data source that supplies data for the report
- Any additional resources, such as images, fonts, and resource bundles referenced by the report template.

The collection of all the resources that are referenced in a JasperReport is sometimes called a report unit. End users usually see and interact with a JasperReport as a single resource in the repository, but report creators must define all of the components in the report unit.

JasperReports Library
An embeddable, open source, Java API for generating a report, filling it with current data, drawing charts and tables, and exporting to any standard format (HTML, PDF, Excel, CSV, and others). JasperReports processes reports defined in JRXML, an open XML format that allows the report to contain expressions and logic to control report output based on run-time data.

JasperReports Server
A commercial open source, server-based application that calls the JasperReports library to generate and share reports securely. JasperReports Server authenticates users and lets them upload, run, view, schedule, and send reports from a web browser. Commercial versions provide metadata layers, interactive report and dashboard creation, and enterprise features such as organizations and auditing.

Jaspersoft ETL
A graphical tool for designing and implementing your data extraction, transforming, and loading (ETL) tasks. It provides hundreds of data source connectors to extract data from many relational and non-relational systems. Then, it schedules and performs data aggregation and integration into data marts or data warehouses that you use for reporting.

Jaspersoft OLAP
A relational OLAP server integrated into JasperReports Server that performs data analysis with MDX queries. The product includes query builders and visualization clients that help users explore and make sense of multidimensional data. Jaspersoft OLAP also supports XML/A connections to remote servers.

Jaspersoft Studio
An open source tool for graphically designing reports that leverage all features of the JasperReports Library. Jaspersoft Studio lets you drag and drop fields, charts, and sub-reports onto a canvas, and also define parameters or expressions for each object to create pixel-perfect reports. You can generate the JRXML of the report directly in JasperSoft Studio, or upload it to JasperReports Server. Jaspersoft Studio is implemented in Eclipse.
**JavaBean**
A reusable Java component that can be dropped into an application container to provide standard functionality.

**JDBC**
Java Database Connectivity. A standard interface that Java applications use to access databases.

**JNDI**
Java Naming and Directory Interface. A standard interface that Java applications use to access naming and directory services.

**Join Tree**
In Domains, a collection of joined tables from the actual data source. A join is the relational operation that associates the rows of one table with the rows of another table based on a common value in given field of each table. Only the fields in a same join tree or calculated from the fields in a same join tree may appear together in a report.

**JPivot**

**JRXML**
An XML file format for saving and sharing reports created for the JasperReports Library and the applications that use it, such as iReport Designer and JasperReports Server. JRXML is an open format that uses the XML standard to define precisely all the structure and configuration of a report.

**MDX**
Multidimensional Expression Language. A language for querying multidimensional objects, such as OLAP (On Line Analytical Processing) cubes, and returning cube data for analytical processing. An MDX query is the query that determines the data displayed in an OLAP view.

**Measure**
Depending on the context:

- In a report, a formula that calculates the values displayed in a table’s columns, a crosstab’s data values, or a chart’s dependent variable (such as the slices in a pie).
- In an OLAP view, a formula that calculates the facts that constitute the quantitative data in a cube.

**Mondrian**
A Java-based, open source multidimensional database application.

**Mondrian Connection**
An OLAP client connection that consists of an OLAP schema and a data source. OLAP client connections populate OLAP views.

**Mondrian Schema Editor**
An open source Eclipse plug-in for creating Mondrian OLAP schemas.

**Mondrian XML/A Source**
A server-side XML/A source definition of a remote client-side XML/A connection used to populate an OLAP view using the XML/A standard.

**MySQL**
An open source relational database management system. For information, visit [http://www.mysql.com/](http://www.mysql.com/).

**Navigation Table**
The main table in an OLAP view that displays measures and dimensions as columns and rows.
ODBO Connect
Jaspersoft ODBO Connect enables Microsoft Excel 2003 and 2007 Pivot Tables to work with Jaspersoft OLAP and other OLAP servers that support the XML/A protocol. After setting up the Jaspersoft ODBO data source, business analysts can use Excel Pivot Tables as a front-end for OLAP analysis.

OLAP
On Line Analytical Processing. Provides multidimensional views of data that help users analyze current and past performance and model future scenarios.

OLAP Client Connection
A definition for retrieving data to populate an OLAP view. An OLAP client connection is either a direct Java connection (Mondrian connection) or an XML-based API connection (XML/A connection).

OLAP Schema
A metadata definition of a multidimensional database. In Jaspersoft OLAP, schemas are stored in the repository as XML file resources.

OLAP View
Also called an analysis view. A view of multidimensional data that is based on an OLAP client connection and an MDX query. Unlike Ad Hoc views, you can directly edit an OLAP view’s MDX query to change the data and the way they are displayed. An OLAP view is the entry point for advanced analysis users who want to write their own queries. Compare Ad Hoc View.

Organization
A set of users that share folders and resources in the repository. An organization has its own user accounts, roles, and root folder in the repository to securely isolate it from other organizations that may be hosted on the same instance of JasperReports Server.

Organization Admin
Also called the organization administrator. A user in an organization with the privileges to manage the organization’s user accounts and roles, repository permissions, and repository content. An organization admin can also create suborganizations and manage all of their accounts, roles, and repository objects. The default organization admin in each organization is the jasperadmin account.

Outlier
A fact that seems incongruous when compared to other member’s facts. For example, a very low sales figure or a very high number of helpdesk tickets. Such outliers may indicate a problem (or an important achievement) in your business. The analysis features of Jaspersoft OLAP excel at revealing outliers.

Parameter
Named values that are passed to the engine at report-filling time to control the data returned or the appearance and formatting of the report. A report parameter is defined by its name and type. In JasperReports Server, parameters can be mapped to input controls that users can interact with.

Pivot
To rotate a crosstab such that its row groups become column groups and its column groups become rows. In the Ad Hoc Editor, pivot a crosstab by clicking .

Pivot Table
A table with two physical dimensions (for example, X and Y axis) for organizing information containing more than two logical dimensions (for example, PRODUCT, CUSTOMER, TIME, and LOCATION), such that each physical dimension is capable of representing one or more logical dimensions, where the values described by the dimensions are aggregated using a function such as SUM. Pivot tables are used in Jaspersoft OLAP.
Properties
Settings associated with an object. The settings determine certain features of the object, such as its color and label. Properties are normally editable. In Java, properties can be set in files listing objects and their settings.

Report
In casual usage, report may refer to:
- The main JRXML in a JasperReport.
- The file generated when a JasperReport is scheduled. Such files are also called content resources or output files.
- The file generated when a JasperReport is run and then exported.
- In previous JasperReports Server versions, a report created in the Ad Hoc Editor. See Ad Hoc Report.

Repository
The tree structure of folders that contain all saved reports, dashboards, OLAP views, and resources. Users access the repository through the JasperReports Server web interface or through iReport. Applications can access the repository through the web service API. Administrators use the import and export utilities to back up the repository contents.

Resource
In JasperReports Server, anything residing in the repository, such as an image, file, font, data source, Topic, Domain, report element, saved report, report output, dashboard, or OLAP view. Resources also include the folders in the repository. Administrators set user and role-based access permissions on repository resources to establish a security policy.

Role
A security feature of JasperReports Server. Administrators create named roles, assign them to user accounts, and then set access permissions to repository objects based on those roles. Certain roles also determine what functionality and menu options are displayed to users in the JasperReports Server interface.

Schema
A logical model that determines how data is stored. For example, the schema in a relational database is a description of the relationships between tables, views, and indexes. In Jaspersoft OLAP, an OLAP schema is the logical model of the data that appears in an OLAP view; they are uploaded to the repository as resources. For Domains, schemas are represented in XML design files.

Schema Workbench
A graphical tool for easily designing OLAP schemas, data security schemas, and MDX queries. The resulting cube and query definitions can then be used in Jaspersoft OLAP to perform simple but powerful analysis of large quantities of multi-dimensional data stored in standard RDBMS systems.

Set
In Domains and Domain Topics, a named collection of items grouped together for ease of use in the Ad Hoc Editor. A set can be based on the fields in a table or entirely defined by the Domain creator, but all items in a set must originate in the same join tree. The order of items in a set is preserved.

Slice
An OLAP operation for filtering data rows.

SQL
Structured Query Language. A standard language used to access and manipulate data and schemas in a relational database.

System Admin
Also called the system administrator. A user who has unlimited access to manage all organizations, users, roles, repository permissions, and repository objects across the entire JasperReports Server instance. The system admin can create root-level organizations and manage all server settings. The default system admin is the superuser account.
Topic
A JRXML file created externally and uploaded to JasperReports Server as a basis for Ad Hoc reports. Topics are created by business analysts to specify a data source and a list of fields with which business users can create reports in the Ad Hoc Editor. Topics are stored in the Ad Hoc Components folder of the repository and displayed when a user launches the Ad Hoc Editor.

Transactional Data
Data that describe measurable aspects of an event, such as a retail transaction, relevant to your business. Transactional data are often stored in relational databases, with one row for each event and a table column or field for each measure.

User
Depending on the context:
- A person who interacts with JasperReports Server through the web interface. There are generally three categories of users: administrators who install and configure JasperReports Server, database experts or business analysts who create data sources and Domains, and business users who create and view reports and dashboards.
- A user account that has an ID and password to enforce authentication. Both people and API calls accessing the server must provide the ID and password of a valid user account. Roles are assigned to user accounts to determine access to objects in the repository.

View
Several meanings pertain to JasperReports Server:
- An Ad Hoc view. See Ad Hoc View.
- An OLAP view. See OLAP View.

Virtual Data Source
A virtual data source allows you to combine data residing in multiple JDBC and/or JNDI data sources into a single data source that can query the combined data. Once you have created a virtual data source, you create Domains that join tables across the data sources to define the relationships between the data sources.

WCF

Web Services
A set of REST (Representational State Transfer) and SOAP (Simple Object Access Protocol) APIs that enable applications to access certain features of JasperReports Server. The features include repository, scheduling, Domain services, and user administration tasks.

XML
eXtensible Markup language. A standard for defining, transferring, and interpreting data for use across any number of XML-enabled applications.

XML/A
XML for Analysis. An XML standard that uses Simple Object Access protocol (SOAP) to access remote data sources. For more information, see http://www.xmla.org/

XML/A Connection
A type of OLAP client connection that consists of Simple Object Access Protocol (SOAP) definitions used to access data on a remote server. OLAP client connections populate OLAP views.
access control
  administering 72
  authentication 67
  authorization 68
  creating profile attributes 51
  data 47–64
  data example 48
  Domains 47–64
  JavaServer Pages 156
  menu items 155
  object permission APIs 120
  passwords 66
  permissions 70, 77
  profile attributes 48, 51
  repository 68
  roles 50, 68
  Spring Security 67
  Spring Web Flow 157, 168, 169
  user and role APIs 119

access grants 47


action model for menus 133

Ad Hoc Editor
  administering 24
  and Ad Hoc launcher 122, 128
  as a designer 13
  charts 17
  creating views 21
  custom fields 23
  Domains and 24
  exploring data 13
  JasperReports Server plug-in for iReport 104
  layout band 15
  summarizing data 19, 21
  summary functions 22
  tables 14
  testing Domain security 52
  tool bar 14
  user interface 14
  Ad Hoc Launcher API 122–128
  Ad Hoc views. See views.
  administering
    authorization 72, 77
    Domain security 47–64
    memory usage 24
    repository 37
    roles 68
    Spring Security 65
    users 69
    views 24
  alerts, creating with API 115
  anomalies 13

APIs
  Ad Hoc Launcher 122–128
  content files 111
  engine service 112
  flushing the analysis cache 121
  folders 108
  Java 106–121
  metadata resources 110
  object permissions 120
  OLAP connection 120
  public API 106–121
  report execution 112
  report scheduling 113–119
  Repository HTTP API 129
  Repository Java API 108
  singletons 106
  types 105
  users and roles 119
  web services 105

application security. See security.
  authentication 65
authorization 68

B
browseDB 125
business case, CZS 48

C
cache, flushing analysis data 121
calculated fields 23
cascading style sheets 133, 136
charts
  creating filters 18
  interface elements 17
colors, customizing 136
column-level security 53, 55, 56
conditional text 27
configuring
  authorization 72, 77
  Domains 48
  iReport 92
custom data sources
  and report data source service API 112
  creating 41
  examples 37, 38
  installing 44
  message catalogs 42, 44
  query executers 38
  Spring configuration 43, 44
customizing
  Ad Hoc launcher queries 126
  Ad Hoc views 21
  custom data sources 112
  custom queries in Ad Hoc launchers 126
  JRXML files 24, 97
  profile attributes 51
  report units 97
  reports, using iReport 97
  roles 68
crosstabs
  creating filters 19
  interface elements 18, 20
data
  access control 47–64
  access control example 48
data formats 22
data sources
  See also custom data sources.
  Domains 95
  in iReport 94
  JasperReports Library and JasperReports Server 37
  repository and 37
datatype, in iReport 101
dates in custom fields 23
dashboard
  input controls 32
  refresh interval 33
  user interface components 32
documentation
  guide to using Ultimate Guide 10
  premium documentation 11
  standard documentation 11
domains
  access control 47–64
  best practices 58
  column-level security 53
  complex 58
  creating 24
  creating profile attributes 51
  data sources 95
  example 48, 49
  example design file 59
  example security file 62
  in Ad Hoc Editor 24
  performance 58
  plug-in for iReport Professional 92, 95
  row-level security 53
  security 50
  tables tab 49
  testing security 52, 56, 57
  Topics based on 58
drill down functionality in iReport 103
drill through, in Ad Hoc Editor 20
E
editing JRXML files in iReport 99
embedding JasperReports server 138
examples
Ad Hoc Launcher 125
browseDB 125
CZS business case 48
Domain design 49, 59
Domain security file 62
Domain tables 49
fields 48
joins 49
report 57
roles 50
users 50
excluding data, in Ad Hoc Editor 19
exploring data 13

F
fields
calculated 23
custom 23
custom date fields 23
summary functions 22
files, in iReport 96
filters
creating in charts 18
creating in crosstabs 19
creating in tables 16
filter expressions 54
in the Ad Hoc Editor 15
scalability and 25
folders
accessing with API 108
in iReport 93
fonts, customizing 136
formulas 23

G
Groovy 54, 58

H
home page 149
HTTP Repository APIs 129
HTTPS only, configuring 83

I
images, in reports 99
importing JDBC connection 97
input controls
customizing 149–152
in dashboards 32
in iReport 101
installing JasperReports Server 12
interfaces. See APIs.
iReport
Ad Hoc views and 104
adding servers 92
configuration 92
data sources 94, 95
datatypes 101
Domain plug-in for iReport Professional 92, 95
drill down functionality 103
files 96
folders 93
input controls 101
JasperReports Server plug-in 91
JRXML files 99
lists 102
queries 102
report units 96
resources 93, 96
running reports 99
server connection 92
item groups 58

J
JasperAnalysis. See Jaspersoft OLAP.
JasperReports Library 9
data sources 37
JasperReports Server
business intelligence platform 9
installation 12
memory usage 24
JasperServer. See JasperReports Server.
Jaspersoft Business Intelligence Suite 9
Jaspersoft OLAP
flushing the analysis cache 121
OLAP connection API 120
prerequisites 9
SuperMart demo 69
Java APIs 106–121
JAVA_HOME 40
JavaScript 133
JavaServer Pages
adding 168
adding in a Spring Web Flow 168–173
controlling access 156
customizing 133, 143
flows and 168
JDBC
connection in iReport 97
JasperReports Server plug-in for iReport 97
JDK 40
joins 49, 58
JRXML files
and Topics 24
creating 24, 97
in iReport 99
in report units 96
JasperReports Server plug-in for iReport 99

K
keep only 19
keystore 82

L
launcher. See Ad Hoc Launcher API 122, 128
layout band 15
list scheduled jobs 117
lists, in iReport 102
locale 130
log4j 52
logging 52
logo, customizing 134

M
memory usage 24
menus
  action model reference 162–166
  adding a menu 160
  adding a menu item 158
  customizing 153–166
  customizing context menus 162
  deleting a menu item 153
  restricting access by role 155
Spring Web Flow and 171
metadata resources 108, 110

O
object permissions APIs 120
OLAP connection API 120
outliers 13

P
parameters See input controls
passwords
  changing 12
  default users and passwords 69
  Spring Security and 66, 67
PKC12 keystore 82
plug-ins
  Domain plug-in for iReport Professional 92, 95
  JasperReports Server plug-in for iReport 91
prerequisites for Jaspersoft OLAP 9
principal expressions 54
profile attributes
  creating 51
  CZS example 48, 54
  Domain security 50, 54
  in user account 51
protection domains 86
public API
  and Spring Framework 106
  overview 106

Q
queries
  custom data sources and 38
  in Ad Hoc launchers 122, 126, 128
  in iReport 102

R
redo, in Ad Hoc Editor 14
reference syntax. See repository.
  referencing resources
    in iReport 99
  in reports 99
report developer 10
report execution API 112
report jobs 113
report units
  creating 97
  in iReport 96
  repository organization and 68
  uploading referenced resources 100
report viewer 27
reports
  and Domains 95
  and iReport 99
  custom export channels 173
  customizing 150
  designing 13
  drill down functionality 103
  example 57
  exporting 173
  images 99
  referencing resources 99
  report execution API 112
  report scheduling API 113–119
  running 99, 150
  scheduling APIs 117
  style templates 99
  subreports 99
  testing 99
repository
  access control 68
  administering 37
  data sources 37
  JasperReports Server plug-in for iReport 104
  Java API 108
  syntax for referencing resources 99
resources
  content files 111
  files 96
  folders 93, 108
  in iReport 93
  internally-referenced resources 101
  iReport 96
  metadata resources 110
  referenced by reports 99
  types 68
REST API 105
roles
  access control 68
  administering 68
  conflicting 68
  creating 68
  default roles 69, 74
  Domain security 50
  example 50
  overview 68
row-level security 53, 54, 56
running reports
   in iReport 99
   testing 99

S
saving
   user profiles 78

scheduling APIs 113–119
   bulk scheduling 117
   calendars 118
   canceling jobs 112
   creating alerts 115
   holidays 118
   pause report job 118
   report jobs 113
   report scheduling service 117
   resume report job 118
   retrieving list of running jobs 112

Secure Sockets Layer. See SSL.

security
   access control 69
   application 81–89
   configuring HTTPS only 83
   cookies 84, 85
   Domains 47–64
   httpOnly 85
   keystore 82
   protection domains 86
   Spring Security 65
   SSL 81
   Tomcat 81
   web application 81–89
Security Manager 86
singletons 106
SiteMesh 133, 140, 142
slice 19
SOAP API 105
Spring Framework 133
Spring MVC 133
Spring Security
   administering 65
   authentication 65, 67
   filter beans 66
   flow files 67
   overview 65
   Spring Framework 106
   user names and passwords 67
   WebFlowUpgrader 67
Spring Web Flow 133
   access control 157, 168, 169
   adding 168–173
   adding a flow 168
   flow files 129
   menus and 171
   WebFlowUpgrader 129

SSL 81, 83
startup URI 130
subreports 99
summary functions 22
SuperMart demo 69, 70
syntax for referencing resources 99
system administrator 10
system developer 10

T
tables
   creating filters 16
   interface elements 14
technical business analyst 10
testing Domain security 56, 57
themes 133, 136
TLS. See SSL.
Tomcat 81
tool bar 14

Topics
   and Ad Hoc launcher 122, 128
   based on JRXML files 24
   Domains and 58
   in Ad Hoc Editor 24
trends 13
troubleshooting 52

U
undo, in Ad Hoc Editor 14
user interface
   Ad Hoc Editor 14
   Ad Hoc launchers 122
   customizing 133, 150
   default configuration 140
   SiteMesh and 140
user types
   database administrator 10
   report developer 10
   system administrator 10
   system developer 10
   technical business analyst 10
users
   access control 69
   access control example 74
   administering 69
   authentication 67
   default users and passwords 69
   example 50
   profile attributes 50
   saving 78
   Spring Security and 67
   Spring Security filters and 66
using the Ad Hoc Editor
   analyzing data 13
   charts 17
   creating views 21
crosstabs 18, 20
designing views and reports 13
drill through 20
excluding data 19
exploring data 13
filtering 15
slice 19
sorting 16
summarizing data 19, 21
tables 14
testing Domain security 52
with Ad Hoc launcher 122, 128

views

Ad Hoc launchers and 122
administering 24
and the Ad Hoc Editor 21
chart views 17
creating 21
crosstabs 18, 20
designing 13
excluding data 19
iReport and 104
overview 21
tables 14

web services APIs 105
WebFlowUpgrader 67